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UVP uniFi VolP Phone
UBIQUITI with Touchscreen
» 5" Full Color, Multi-Touch Display
» Powered by Android
» 1.2 GHz Dual-Core Cortex A9 Processor
» 4GB Storage / 1 6B RAM
» UniFi Phone App Communication Software
» Auto-Provisioning Management Feature

(UBUVP) 146.69

€3 ooma’ HD2 Handset
Cordless Handset

» Color Display

» DECT 6.0 Support

» Picture Caller ID

» Caller ID and Call Waiting

» Voicemail » Intercom » Baby Monitoring
» Signal/HD/Do Not Disturb Indicators

(00HD2HS) 51.95

Jabra’ Speak K10MS speakerphone

» Portable and Compact Design

» Jabra PC Suite Digital Signal Processing
» Omni Directional/Noise Filter Microphone
» Standard (E-STD) Microphone Sensitivity
» LED and Audio Indicators

» Certified by Microsoft

[JA4100CSPM) 89.95

7. Duet Executive Desktop Speaker-
EN phone for VoIP and Telephone

» Compact and Discrete s

» Integrated Mic and Speaker =

» Echo Cancellation and >
Noise Suppression » USB Connection

» 3.omm Speaker Output

» RJ-11 Jack for Phone and Bridging

(PHMT202EXE) 149.99

plantronics (CT14DECT 6.0

Cordless Headset Phone -
» DECT 6.0 for Interference

Panasonic. Home Monitoring
System Digital Handset

» Panasonic Monitoring System Add-On

VOIP

otfrar]ne SPA303 3-Line IP Phone with
CISCO. Dual Switched Ethernet Ports
» 3-Line IP Phone with Display

» Dual Switched Ethernet Ports

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning
» Supports SIP/SPCP with Cisco 500 Series

(CISPA30361) 83.95

sfilQANDSTF?EAN GXP2130
Enterprise IP Telephone
» 2.8” Color LCD Display

» 320 x 240 Pixel Density

» Supports 3 SIP Accounts -«
» RJ9 Headset Jack » EHS Headset Compatibility

» Dual Switched Gigabit Ethernet Ports » PoE Compatible
» Real-Time Web Applications

(GRGXP2130) 70.90

Jabra’® Speak510+ Bluetooth & USB
Speakerphone (Microsoft Lync Compatible)
» Unified Communications Compatible
» Supports up to 8 Trusted Devices

» Bluetooth Class 1 &2 Compatible

» Bluetooth AZDP Support

-

(JAS10BTUSPMS) Call or Log-on

FLXUC500

revo USB Conference Phone

» Built-In Tweeter and Mid-Woofer Speakers
» Integrated Echo Cancellation

» Full Duplex Technology

» For Conference Rooms and Small Offices
» For Meetings and Online Collaboration

» Extended Response For Foreign Languages

(RETOFLXUC500)

Call or Log-on

N
\/X| BlueParrott B350-XT

Noise-Canceling Headset

stfver]ee SPAS04G 4-Line IP Phone with
CISCO. 2-Port Switch PoE & LCD Display
» 4-Line Business Class IP Phone with PoE
» Features 2-Port & LCD Display

» Comprehensive Interoperability

» SIP-Based Feature Set

» Highly Secure Remote Provisioning
» Great Voice Clarity by Wideband Audio

[CISPAB046) 99.95

sl’iIQANDSTF?EAN GXV3275
IP Multimedia Phone for Android

» 7.0" Capacitive Touchscreen Display

» 1024 x 600 Pixel Resolution

» Runs on Android 4.2 Operating System

» Mega Pixel CMOS Camera

» 802.11n Wi-Fi » RJ-9 Headset Jack /
USB/SD / Mini-HDMI > Integrated QoS Functionality

(6RGXV3275)

215.59

plantronics (alisto P620
Bluetooth Wireless Speakerphone

» Bluetooth v2.1 + EDR

» Mini USB Adapter

» Works with Computers and
Smartphanes

» PC Wideband: Up to 6800Hz

» 360° Room Coverage » Compatible with Windows and Mac 0S

(PLP620) 105.95

Polycom Soundstation 2
Expandable Conference Phone

» Patented Polycom Acoustic Clarity

» 3x Cardioid Intelligent Microphanes

» 360 Degrees of Pickup from 10" Away
» Conferences with up to 10 Participants
» Resists Interference From Mabile Phanes

» Backlit Display » Connect to Mobile Phones and PCs

[POSS2ED)

438.73

plantronics (alisto P240
USB Corded Handset

Free Wireless
» Up to 10 Hours of Talk Time
» Hands-Free Convenience
» Up to 300 ft. Range from
Charge Base

[PLCT14RHS) 92.83

plantronics (S540
Wireless Headset with HL10

» Lightweight 0.74 0z Headset

» Hands-Free Operation to 350"

» Sleek Contemporary Design

» Advanced Wideband Audio Tech

» Noise-Canceling Microphone

» 7 Hour Battery » Includes HL10 Handset Lifter

(PLB469311) 229.95

il

L
e
» Receive Alerts and Announcements

» Arm/Disarm Cameras, Smart Plugs
» Use as Cordless Landline Phone

» DECT Technolagy for Strong Signal

» Integrate up to Six Units into System

[PAHNHTOOW) e 29,95

plantronics (S530
Over-the-Ear Wireless Headset
» Wireless Range Up to 350°

» 4 Different Wearing Options

» Premium Wideband Audio Quality

» One-Touch Call Answer/End

» Conference in 3 Additional Headsets

» Headset Weighs Only 0.74 0z

[PLCSB3OHS) ... 7104

» Flexible Boom Microphone
» Cuts 96% of Background
Noise » Bluetooth 4.0
with Multipoint Technology

» NFC One-Tap Pairing
» Wideband Audio and 128-Bit Encryption

(VK203478)....oc Call or Log-on

plantronics (S510
Wireless Headset System

» Lightweight 2.5 oz Headset

» Hands-free Operation to 350 ft

» Sleek Contemporary Design

» One-touch Control

» Advanced Wideband Technology

» Auto-answer Feature » Noise-canceling Mic

[PLCS510) 172.29

» Simple PC Call Management
» LCD Display

» Personal Speakerphane

» Noise-Canceling Microphone
» USB Connection » SoundGuard Technology
» Suitable for PC Telephony Users » Portable

[PLCP240NS) 63.95

plantronics SaviW740
Multi Device Wireless Headset

» Manages PC, Mobile & Desk Phone Calls
» Headset to Mobile Phone Audio Transfer
Hands-free Operation
to 350 ft (100 m)
» Three Customizable
Wearing Styles

(PLW740) 219.99

800-947-3308 - 212-444-6691



SONY PlayStation 4

Gaming Console

The Sony PlayStation 4 Gaming Console ushers in an era of next generation gaming. Providing dynamic
and connected gaming, powerful performance, high definition graphics, deeply integrated social
capabilities, and innovative second-screen features, the PlayStation 4 allows you to game as you see
fit. With immersive game play, access to your favorite digital entertainment apps, and PlayStation
exclusives, the PlayStation 4 centers around you, the gamer. Play when, where, and how you want.

» AMD Radeon Graphics Core Next Engine » 86B of GODRb RAM

» AMD Jaguar Eight-Core Processor » 10/100/1000 Mbps Gigabit Ethernet

GAMING CONSOLES & ACCESSORIES

P mra

» 802.11b/g/n Wi-Fi, Bluetooth 2.1+EDR » Blu-Ray Disc Player » Play as You Download

» DualShack 4 Wireless Controller » Remote Play with PlayStation Vita

» PlayStation Plus Membership Support
Star Wars: Battlefront Bundle (SOPS4SWBFBSV)
Uncharted 4: Limited Edition Bundle (SOPS4CUCB) .......... 399.99

THRUSTMASTER® T300RS Ferrari
Integral Racing Wheel Alcantara Edition

» Replica Wheel of the Ferrari 599XX EVo
» Hand-Stitched Alcantara
Wrapping
» 11080° Force Feedback
» Detachable Racing Wheel
» Fully Adjustable Metal Pedals
» Thrustmaster Quick
Release System
» Robust & Versatile Attachment System
» Compatible with Sony PS3 & PS4 and PC

469.99

(THT300FRWAE)

NYKO TypePad
for PS4

» QWERTY Keyboard

» Bluetooth Connectivity

» Attaches to the DualShack 4 Controller
» Sony PlayStation 4 Compatible

(NYFOKBDSA) 23.95

(®  DualShock 4
Power  Charging Station

» Charges 2 DualShock 4 Controllers
» Sony PlayStation 4 Compatible

(POPSACS) 2496

www.BandH.com

359.99
Destiny: The Taken King Bundle (SOPSADTKBW) .......cc..ccoc.... 409.99

THRUSTMASTER® T300RS
Racing Wheel

» Fully Adjustable Metal Pedals

» Detachable Racing Wheel

» 1080° Force Feedback

» Thrustmaster Quick
Release System

» Robust & Versatile
Attachment System

» Features Official PlayStation 4 Buttons

» Auto Recognition for Sony PlayStation 4

» Also Compatible with PC & Sony PS3

399.00

[THTBOORSRW. .o

NYKO DataBank
for PS4

» Fits a 3.5" Hard Drive

» LED Indicators

» Includes Screwdriver

» Sony PlayStation 4 Compatible

(NYPS4DB) 33.00

NY1KO Power Pak
for PS4 DualShock 4 Controller

» 1000 mAh Rechargeable
Battery

» Rechargeable
via micro-USB
Cable

» Fits the Du-
alShock 4 Controller

» Works with the
Internal Battery

» Sony PlayStation 4 Compatible

(NYPPPS4DSAC) 19.99

COMPUTERS

S ONY DualShock 4

Wireless Controller

» Share Button, PS Button

» Built-in Mono Speaker

» Light Bar, Vibration Support

» Six-Axis Motion Sensor System
» Built-in Rechargeable Battery
» Clickable 2-Point Capacitive Touch Pad O o ‘
» Dual Analog Sticks, D-Pad, Game Buttons

» Micro USB Port, Stereo Headset Jack , ‘
» Bluetooth 2.1+EDR Wireless Connectivity

» Built-in Rechargeable Battery

Available in Camouflage, White, Blue, Red
or Black (5010037) 47.99

THRUSTMASTER"® T80
Racing Wheel

» Officially

Licensed

by PlayStation
» Wheel and Pedal Set
» Rubber Texture Grip
» Two Sequential Gear Shift Paddles
» 11 Action Buttons + D-Pad
» Adjustable Inclination Angle for Pedals
» Brake Pedal Has Progressive Resistance
» Central Clamping System

(THTBORW) 89.99

NYKO PS4

Intercooler

» Power Pass-Through Technology

» Pushes Hot Air Away from Console
» Matches the PlayStation 4

» User-Friendly, Clip-On Installation
» Sony PlayStation 4 Compatible

(NYINPS4B) 21.99

SONY PlayStation 4

Camera

» Broadcast Support

» 30 Depth-Sensing Technology

» Login & Navigate

» Vaice Commands & Face Recognition
» Realistic Gaming Experience

(SOPSAC) 49.77




COMPUTERS

Microsoft Xhox0ne Gaming Console

The Xbox One Gaming Console from Microsoft delivers a next-gen experience in both gaming
and multimedia. With high-res graphics and fast performance, the Xbox One allows you to
game on your own terms. You can snap two windows together on the same screen so you can
watch TV while you play your game. Xbox Live allows you to test your skills against ather
players around the world. Xbox SmartGlass allows you to connect your smartphone or tablet to

your Xbox One for intuitive access and control.

GAMING CONSOLES & ACCESSORIES

2% XBOX ONE

» AMD Radeon Graphics Core Next Engine » Custom 8-Core x86 AMD Processor » 86B of RAM + 32MB of ESRAM » 10/100/1000 Mbps Gigabit Ethernet
» 802.11n Wi-Fi » Blu-ray Optical Drive » Xbox SmartGlass Support » Xbox One Wireless Controller Included » Xbox Live Gold Subscription Support

The LEGO Movie Videogame Bundle (MIXB15006BLM).............c.ccoocoovvc

FIFA 16 Bundle (MIXBITTBF16B)......c.coocerermcoscr 399.95

Microsoft Xhox One Limited Edition Halo 5

Guardians Master Chief Wireless Controller

» Exclusive Halo 5:

Guardians Design
» 3.5mm Stereo Headset Jack
» Impulse Triggers
» Refined Bumpers
» 18 Wireless Range
» Wireless Firmware Updates »Xbox One & Windows Compatible
Green (MIXBTHSMCWLE) ......62.99Guardians Wireless Controller:
Silver (MIXBTH56WLC) 62.99

Microsoft Xbox One Special Edition

Covert Forces Wireless Controller

» Impulse Triggers

» 3.5mm Headphone Jack

» Up to a 30-Foot
Wireless Range

» Infrared LEDs for
Kinect Support

» Microsoft Xbox One Compatible

(MIGAKDOO0) . 63,79

THRUSTMASTER" Ferrari 458 Spider
Racing Wheel for Xbox One

» For Xbox One D
» Officially Licensed n‘-

by Ferrari/Xbox One o N
> Wheel and Pedal Set & § b, <
» Two Red Rubber- T 4

Textured Grips
» Metal Paddle Shifters » Adjustable Sensitivity
» Kinect Detection LED » Central Clamping System
(THSRW) 89.99

Microsoft Kinect Sensor
with Dance Central Spotlight (Xbox One)

)

Dance Central Spotlight Digital Download
» Microsoft Xbox One Compatible

[MIBLO0ODOT) . 199,99

LIMITED EDITION HALO 5: GUARDIANS BUNDLE (MIXB11TBCGB) 499.00

Microsoft Xbox One Wireless Controller
2015 Version

» Built-in Stereo Headset Jack

» Refined Bumpers

» Wireless Firmware
Updates

» 18" Wireless Range

» Xbox One/Windows 7, 8
and 10 Compatible

i 5199

(MILWLCXBOBK)......cccce

THRUSTMASTER"® T\ Racing Wheel
Leather Edition

» Wheel, Base, and Pedal Set

» TM Leather 28 GT Wheel

» TX Racing Wheel Servo Base

» 3-Pedal T3PA Pedal Set

» Force Feedback Base

» Hall Effect AccuRate Technology

» Dual-Belt Mechanism » USB Connector » Central Clamping
System » Compatible with Xbox One and Windows

(THTXRWLEBLK) o k6899

THRUSTNASTER® T3PA-PRO
Add-On Gaming Pedal Set

» Floor-Mounted Position (F1 Style)
» Suspended Position (GT Style)

» AlUl-Metal Pedals

» Fully Adjustable Pedals

» Pedals with Individual Pressure Settings §
» Spring Brake Mod Included

» Supports T-Series Racing Wheels
» Compatible with PC, Xbox One, PS3, PS4
(THT3PAPRO)

149.34

NYKO Intercooler

for Xbox One

» Matches the Xbox Ong
» Allows Access to All Ports
» Pushes Hat Air Away from Console
» USB Powered (Turns on with Console)
» Microsoft Xbox One Compatible

(NYICXBOXONEB) 24.49

Microsoft Xhox Elite

Wireless Controller

» 4 Paddles and
Hair Trigger Locks

» 3 Different Sets of
Thumbsticks

» Faceted and Traditional
D-Pads

» 3.5mm Stereo Headset Jack » Xbox Elite Controller App

» Microsoft Xbox One Compatible » Windows Compatible

(MIEWLCXBIBK) .o 149,00

Microsoft Xbox One Wireless Controller
With Play & Charge Kit

» Built-in Stereo Headset Jack

» Refined Bumpers

» Wireless Firmware Updates

» 18" Wireless Range

» Includes Charging Cable

» Rechargeable Battery
Pack Included

» Xbox One/Windows 7, 8, and 10 Compatible

[MILCPNCXBA) . 06,98

THRUSTMASTER® THSA
Add-On Shifter

» H-Pattern or Sequential Shift-Plates
» Hall Effect AccuRate Technology

» Metal Gear Stick and Construction

» 360° Adjustable Clamping System

» PC/PS3/PSk [ Xbox One Compatible

(THTHBAAOGBSH)

148.99

Razer Atrox Arcade Stick
Gaming Controller for Xbox One
» Premium Quality Sanwa Companents
» 8 x Tournament-Grade

Sanwa Buttons
» 1x Precision 8-Way Joystick
» Internal Storage Compartments
» One-Touch Access to Internals & Storage
» 13" Detachable Screw-Lock USB Cable
» Additional Bat Top Included
(RAAASXBONE)

199.99

Razer Wildcat
Gaming Controller for Xbox One
» Wired Braided-Fiber Micro-USB Cable
» 2 x Shoulder Multi-Function Bumpers
» 2 x Removable Multi-Function Triggers
» & x ABXY Action Buttons

» Iero Slow-Turn Analog Joysticks
» 3.5mm Audio Port

» Optional Trigger Stops for Rapid-Fire
» Quick-Release Cable

(RAWCGCXBT) oo

i 169.99

800-947-3308 - 212-444-6691




3DS XL

Handheld Gaming System

Achieve total immersion with dual large screens and 3D graphics with the black 2015 version of the
3DS XL Handheld Gaming System from Nintendo. The Nintendo 3DS is compatible with all 3DS and
eShop games, as well as most DS and DSi games. Designed for the family, the Nintendo 3DS XL has
a 3D depth slider, a 3D camera, face-tracking 3D capabilities, StreetPass, SpotPass, wireless con-

nectivity, and even access to the Miiverse online community.

» Face-Tracking 30 » Compatible with Most DS Games » Access to the Nintendo eShop
» 488" Top 3D Widescreen LCD Display » 4.18” Bottom LCD Touchscreen » MicroSDHC Media

GAMING CONSOLES & ACCESSORIES [ele]y|LUa) 4]

Card Slot » Built-in amiibo Support » C-Stick, ZL & ZR Buttons » Includes Stylus & 4GB SDHC Card » Wireless Connectivity for Multiplayer

3DS XL Handheld Gaming System (NIREDSVAAA) .................. 199.99

THRUSTMASTER’ T1.16000M
Joystick

» 16 Buttons & 4 Axes (Fully Programmable]
» Fully Ambidextrous Joystick

» 3 Adjustable Components

» 3D Magnetic Sensors

» Multidirectional Hat Switch

» Weighted Base » Wide Hand Rest

» Plug & Play » PC Compatible

» Hall Effect Accurate Technology (HEART)
(THTFS) 45.99

THRUSTMASTER® H0TAS
Warthog Flight Stick and Throttle

» Replica Joystick / Dual Throttles
» Replica Backlit Control Panel w/ 5 LEDs

Red Version (NIREDSRAAA) .199.99

<ANVIDIA. SHIELD

wireless controller (PC & Android)

» Built-in Mic for Voice Commands

» Android Home & Back Buttons

» Dual Analog Joysticks,
Dedicated Buttons

» Touchpad, Volume Control

» Micro-USB 2.0 Port

» 3.5 mm Headphone Jack

» NVIDIA SHIELD Tablet Compatible

(NVSWLCPCA) 59.99

Nunchuk Controller
Wii & Wii U, Black

» Connects to a Wii Remote Plus

» Nintendo Wii & Wii U Compatible

c Gamebang Redstone
3 Minecraft Wearable

» Take Your Warlds with You
» PixelFurnace App Included
» Preloaded with Minecraft Maps
» PC/Mac/Linux Compatible
» Play Minecraft from
Any Computer » Back Up
Worlds to Gameband's Cloud
Large (GAMC0801L) 43.99
Small (6AMC0801S) 43.99

THRUSTMASTER" T150
Force Feedback Racing Wheel

» Force Feedback Haptic Response

» 270-1080° Wheel Rotation

» 13 Actions Buttons & D-Pad

» Two Wheel-Mounted
Paddle Shifters

» Large, Optimized Pedal Set

» Internal Memory & Upgradeable Firmware

» Compatible with PS3, PS4 & Windows PCs

(THT150RS) 199.99

saerRenTZ_ 12-Button

et Direrty N

USB 2 0 Game Controller

» Wired USB » Six Thumb-Button Layout
» 12 Fully Programmable Buttons

» Mation Sensitive
» Built-In Analog Stick
» Ergonomic Grip

» 1 Programmable Action Buttons
» T Hat Buttons and 1 Trim Wheel
» USB Plug-and-Play

» Analog and Digital Modes
» Two Clickable Analog Mini Joysticks
» Two Pairs of L + R Rear Buttons

» Realistic Idle and Afterburner Detent » Ambidextrous Design » Mode, Turbo, and Clear Function Buttons

» 3-D Magnetic Sensor Technology » Supports DirectX 7.0 + » Plug-and-Play

» Realistic Weighted and Metal Design » Windows/Mac Compatible

(THHOTAS) 399.99 (NIRVLAFK3) 17.46 (SAUSBGAMEPAD) 11.45

The trend of action figures interacting with the latest hot
game titles brings Toys-to-Life, utilizing a third-person
camera view and in-game power-up figures. Using the near
field communication NFC) protocol, gamers can determine
the individual figuring’s proximity and save progress data A
within the figure. Available individual figures and game
packs include Disney Infinity and amiibo. Check out the B&H
Interactive Gaming Figures page for the available figures.

B&H carries a wide assortment of console and PC games,
compatible with Sony, Xbox, Nintendo and Windows
based titles for every serious gamer. Games including x XBOXONE
Minecraft, MLB 15, Madden NFL, Guitar Hero, FIFA 16,

NBA 2K16, PGA Tour, Dragonbakk Xenoverse, Need for
Speed, Star Wars Battlefront, Duck Dynasty and many

more. Check out the B&H Gaming page for the latest E
available titles. '

P mra




COMPUTERS IZ7\B)

’
' Authorized Reseller iPad mini &

The iPad mini 4 from Apple is just 6.Tmm thin and weighs less than
1 pound. Its smaller form factor makes it easier to hold in one hand.
This iPad mini 4 comes in a space gray, silver and gold finishes. The
tablet's 7.9" Retina Display features a native resolution of 2048 x 1536
at 326 ppi. The Retina Display’s capacitive touchscreen lets you utilize

g
@ Authorized Reseller iPad Pro
The iPad Pra from Apple now has an expansive Retina display, double the CPU power of the iPad Air 2,
improved Multi-Touch technology and access to over 850,000 apps. With up to 5.6 million pixels, the iPad
Pro makes it easier to work in professional environments including editing 4k video.

» Fingerprint Identity Sensor Built Into
The Home Button

» Apple A9X CPU with 64-Bit Architecture

» 2.bx Faster Than iPad Air

» 802.11a/b/g/nfac Wi-Fi, Bluetooth 4.2

» Touch ID Fingerprint Reader

12.9”

» 2732 x 2048 Native Resolution
» Wi-Fi + Cellular & Wi-Fi Only Models available
» 25668, 125868 & 32Gb Configurations
STARTING AT (WI-FIONLY).....oooo o
STARTING AT (WI-FI+CELLULAR
*Available in space gray, silver and gol

9.7”

» iSight Camera with 8MP photos
» Video Recording with Slo-Mo,
Stabilization & Time Lapse » i0S 8 and iCloud
» Front 1.2-Megapixel FaceTime HD Camera
» Rear b-Megapixel iSight Camera
» Lightning Connector, AirPlay Mirroring

» 2048 x 1536 Native Resolution

» Wi-Fi + Cellular & Wi-Fi Only models available
» 25668, 12586B & 326b configurations
STARTING AT (WI-FI ONLY)
STARTING AT (WI-FI+CELLULAR)..........
*Available in space gray, silver and gold finishes

» 2048 x 1536 Native Resolution
» Touch ID Fingerprint Reader

» 1.3x faster than iPad mini 2

»10S 9 and iCloud

Wi-Fi + Cellular

iCloud, and Spotlight Search.

» 2048 x 1536 Native Resolution

» Tri-Core Apple ABX CPU with M8 Chip

» 0.98 (b and 0.24” Thick

Wi-Fi + 4G LTE
STARTING AT

all the multi-touch gestures of i0S 8.
» 7.9” IPS LCD Multi-Touch Retina Display

» Apple A8 CPU with 64-bit architecture

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.2

STARTING AT ..o .529.00

’
' Authorized Reseller iPadAir2 =

Work and play faster, thinner, and lighter with the

iPad Air 2 from Apple. The LED-backlit 9.7" 2048 x

1536 Retina IPS LCD display’s anti-reflective coating
reduces glare by 56% and uses a single-layer design to
eliminate internal reflectance for richer colors, greater
contrast, and sharper images. The Air 2 features Apple
Touch 1D technology, which uses your fingerprint to
unlock your device as well as make secure purchases in
iTunes, iBooks, and the App Store. The 1.2MP front and
8MP rear camera let you take high-resolution photos
and videos as well as videochat in HD while dual microphones
reduce background noise. The iPad Air 2 runs i0S 8, featuring Siri,

» 9.7 IPS LCD Multi-Touch Retina Display

» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.0

» iSight Camera with 8MP photos

» Video Recording now includes Slo-mo function
» 105 8 and iCloud

» Lightning Connector, AirPlay Mirroring

Wi-Fi Only
STARTING AT oo 399.00

(|

» Touch ID Fingerprint Sensor

» Front 1.2-Megapixel FaceTime HD Camera
» Rear 8-Megapixel 1080p iSight Camera

» Lightning Connector, AirPlay, AirDrap

» Gyro, Accelerator, Ambient Light Sensor

Wi-Fi Only

599.00  STARTING AT 479.00

.’ Authorized Reseller Apple Smart Case

iPad Air 2 £
» Protects All Sides of Your iPad Air 2

» Leather Exterior

» Color-Matched Microfiber Lining

» Folds into Typing or Viewing Stand -
» Open the Cover to Wake, Close to Sleep

APSCIAZBL 74.00

iPad mini

» Protects Back and Touchscreen » Thin, Minimal Design
» Leather Exterior » Soft Microfiber Lining

» Enables Wake/Sleep » Folds into Typing/Viewing Stand

APSCIPMBR 69.00

*Available in space gray, silver and gold finishes

ACCESSORIES

*Available in space gray, silver and gold finishes

Apple Pencil (APPENCIL)
Apple Smart Keyboard (APIPPSKB) ... 169.00
Apple Lightning Digital AV Adapter

» Male Lightning Connector » Female HDMI Port

APMDB26AMA 44.99
Apple Lightning To USB Charge & Sync Cable
3.3 (APLUSBC)........... 14.72 6.5 (APMDB19AMA) ... 29.00

Apple Lightning to USB Camera Adapter
» For iPad with Retina Display or iPad Mini

APMLUCADP 29.00
Apple Lightning to VGA Adapter

» For iPhone, iPad and iPod

» Mirror Device's Display on Bigger Screen

(APMLVADP) 45.99

Apple Lightning to SD Card Camera Reader

» ForiPad Air, iPad 4th Gen & iPad mini

» View Photos From SD Card » Supports JPEG, RAW, H.264, MPEG-4
APMLSDCR 29.00

Apple EarPods with Remote and Mic
» Enhanced Bass Response » Resistant to Sweat and Water Damage
APIPODEP 25.69

Apple Lightning to 30-pin Adapter
» Supports USB Audio
(APL3OP)..os 23.99 8" (APL3OPAD) ........cccoc.. 37.00

Apple Lightning to Micro USB Adapter
» For iPhone/iPod/iPad With Lightning
» Connects to Micro USB Cable » Charge and Sync Device

APMD8Z20AMA 16.95

800-947-3308 - 212-444-6691



<Z NVIDIA. SHIELD Tablet K1

Delivering a balance of power, portability, and performance, the
SHIELD Tablet K1 features a custom-engineered thermal system
harnessing the full power of the Tegra K1's performance.

» 2.2 GHz Cortex A15 Quad-Core CPU  » 2GB of RAM

» §” Multi-Touch Full HD Display » 1920 x 1200 Screen Resolution
» NVIDIA Tegra K1 Kepler GPU > 16GB Storage Capacity » 802.11n Wi-Fi, Bluetooth 4.0 + LE
» Mini-HDMI, Micro-USB 2.0, MicroSDXC > Android 6.0 Marshmallow

(NVSTK1) 199.00
SHIELD 16GB Tablet K1 Kit with 12868 microSDXC Memory Card (NVSTKISDK) ..o 241.95
SHIELD 16GB Tablet K1 Kit with 1SHIELD Wireless Controller, Charger, Tablet K1 Cover

and 12868 microSDXC Memory Card (NVSTK1CK) 359.95

lenowvo. 166BTAB 2 A8

Stay entertained and informed with the midnight blue 16GB TAB 2 A8 8" Wi-Fi Tablet.
This tablet is equipped with an 8" 5-point multi-touch IPS LCD display and features
1280 x 800 native resolution for viewing detailed high-definition images.

» §"IPSLCD Display » HD 1280 x 800 Native Resolution

» 1.3 GHz 32-Bit Quad-Core CPU  » 1GB RAM & 16GB Onboard Storage

» microSDHC Expansion up to 3268 » 802.11b/g/n Wi-Fi + Bluetooth 4.0

» IMP Front Camera + 5MP Rear Camera » Dolby Atmos Sound Pracessing

» Up to 8 Hour Battery Life  » Android 5.0 Lollipop

LETAB2A8

w Galaxy TabA 8.0 (=
Stay informed and entertained with the white Samsung 8.0 4 l

Galaxy Tab A Tablet. It features a microSD slot for additional storage and supports
microSDXC cards up to 1286B. This device also features GPS with GLONASS, which
allows you to use Google's location-based services.

» 8.0" TFT Touchscreen Display » XGA 1024 x 768 Native Resolution

» 1.2 6Hz Quad-Core Processor » 1.56B of RAM & 16GB of Onboard Storage
» MicroSD Expansion Slot  » 802.11a/b/g/n Wi-Fi, Bluetooth 4.1

» IMP Front and 5MP Rear Cameras  » 4200mAh Battery

» Kids Mode and Multi Window > Android Lollipop 5.0

SAGTAB16W 197.99
*Available in White, Titanium and Blue

/iU=" TenPadC7.0

The ZenPad C 7.0 7 Tablet from ASUS features a modern design,

vivid display, and enhanced pracessing power.

» 7" 10-Point Multi-Touch IPS LCD Display » 1024 x 600 Native Resolution

» Intel Atom x3-C3200 Quad-Core Processor

» 16B of RAM & 16GB of Onboard Storage > microSDXC Expansion up to 64GB
» 802.11 b/g/n Wi-Fi + Bluetooth 4.0 » 2MP PixelMaster Rear Camera

» Up to 8 Hours of Battery Life » Android Lollipop 5.0

ASZ170CA1B 92.50

© ematic EGQ367

The EGQ367 Tablet from Ematic allows you to navigate the Internet and
a variety of applications using the Android 5.1 Lollipop operating system.

» 7" Capacitive Multi-Touch Display » 1024 x 600 Native Resolution

» 1.2 6Hz Quad-Core Processor » 16B of RAM & 16GB of Onboard Storage
» microSDHC Expansion up to 32GB

» Integrated 802.11b/g/n Wi-Fi & Bluetooth

» Front 0.3MP & Rear Facing ZMP Cameras

» 56B of Cloud Storage > Android Lollipop 5.1

EMEGQ367BU 59.99
*Available in Blue, Purple, Pink and Black

7-8” TABLETS [e{e] =10y 523

/iSU=" 7580CA ZenPad S

The ASUS 6468 Z580CA ZenPad S 8.0" Wi-Fi Tablet features a vivid display,
enhanced optics, and powerful processing.

» 87 10-Paint Multi-Touch IPS LCD Display » 2K 2048 x 1536 Native Resolution
» Intel Atom 23580 Quad-Core Processor » microSDXC Expansion up to 12868

» Bluetooth 4.0 » 8 MP PixelMaster Rear Camera » ASUS TrueVivid Technology
» Up to 8 Hours of Battery Life  » Android Lollipop 5.0

RAM Storage Wireless SKU PRICE

468 6468 802.11ac ASIPT580CACT 299.00

268 \ 3268 | 8021bjgh | AszPeszeeC | 189.00
@ LG GPadll

Get powerful performance and wireless content sharing with the G Pad II. It's equipped
with a full-sized USB port for data sharing, and a microSD slot for added storage capac-
ity; the microSD slot supports microSDXC cards up to 128GB.

» 1.2 GHz Snapdragon Quad-Core CPU > 1GB of RAM

» 8" IPS Multi-Touch Display » Full-Size USB Port For Data Share
» 1280 x 800 Native Resolution » 16GB of Flash Storage

» microSDXC Media Card Slot  » 802.11 a/b/g/n + Bluetooth 4.0

» Built-In Stylus Pen » Android 5.0 Lollipop

L6T8498 189.00

The 7" Tab A 8GB Tablet from Samsung delivers powerful

performance and wireless content sharing in a sleek, modern design.
» 1.3 GHz Snapdragon 410 CPU

» 1.56B of RAM » 7.0" IPS Multi-Touch Display

» 1280 x 800 Screen Resolution » Adreno 306 GPU

» 8GB of Internal Storage  » Micro-USB 2.0 Port, microSDXC Slot
» 5MP Rear Camera + 2MP Front Camera

» 802.11b/g/n Wi-Fi, Bluetooth 4.0 » Android 5.1.1 Lollipop

Black (SAGTATBLK) ....ccc..ococvvccc 149.00 White (SAGTATWHT) ..o 149.00

@ LG GPad

The LG G Pad 7.0" Wi-Fi Tablet offers powerful performance
and wireless content sharing.

» 7.0" IPS Multi-Touch Display » HD 1280 x 800 Native Resolution
» 1.2 GHz Snapdragon Quad-Core CPU

» 16B of RAM & 8GB of Onboard Storage

» microSDHC Expansion Slot  » Dual-Band Wi-Fi + Bluetooth 4.0
» 1.3 MP Front Camera + 3 MP Rear Camera

» Q-Pair 2.0 Smartphone Sharing Technology

» 4000mAh Battery Capacity » Android Lollipop 5.0

LGV400W 149.00

ENK Epik Learning Tab

The Epik Learning Tab from ClickN KIDS is a tablet designed for kids
and adults. It comes pre-loaded with mobile apps such as Looney Tunes
Phonics, SmartRunners Series, ClickN Spell, and more.

» 7" Multi-Touch Display » HD 1024 x 600 Resolution

» 1.2 GHz Intel Quad-Core CPU

» 16B RAM & 16GB of Onboard Storage

» microSD Expansion Slot up to 326B  » 0.3MP Front Camera & 2.0MP Rear Camera

» 3600mAh Battery Capacity » 56B of Cloud storage with Google Drive  » Android 5.0 Lollipop

CLCKT3BL16 89.00
*Available in Blue, Green, Pink and Red




(oo |LURI- 30N O-10” TABLETS

lenowvo. TB2A10

Stay entertained and informed with the midnight blue TAB 2 A10 Wi-Fi Tablet.
It can store up to 16GB of data, and has a microSD slot for added storage
capacity; the microSD slot supports microSDXC cards up to 64GB.

» 10.17 IPS LCD Display » HD 1920 x 1200 Native Resolution

» 1.5 GHz 64-Bit Quad-Core CPU » 2GB RAM & 16GB Onboard Storage

» microSDXC Expansion up to 64GB » 802.11b/g/n Wi-Fi + Bluetooth 4.0

» 5MP Front Camera + 8MP Rear Camera » Up to 10 Hour Battery Life » Android 4.4 KitKat

LETABZA10 189.00

Microsoft Surface 3

Combines the portability of a tablet with the performance of a laptop. Weighing
just 1.37 pounds and measuring just 0.34" thin, the Surface 3 packs Intel
Atom x7 processing power into @ magnesium casing with a silver finish.

» 1.6GHz Intel Atom x7-28700 Quad-Core CPU

» 10.8” ClearType Full HD Plus Touchscreen » 1920 x 1280 Native Resolution )
» Integrated Intel HD Graphics » 128GB of Flash Storage » microSDXC Media Card Slot

» 802.17ac Wi-Fi, Bluetooth 4.0 » 8MP Rear Camera, 3.5MP Front Camera > Windows 10

RAM Storage Cell Network SKU Price
4GB 12868 Wi-Fi + 46 LTE MIGK700008 699.00
4GB 12868 Wi-Fi Only MI76500014 599.00
268 6468 Wi-Fi + 46 LTE MIGK600008 599.00
268 6468 Wi-Fi Only MI76500015 499.00

w Galaxy Tab S2
Combine powerful performance and wireless connectivity with

the white 326B Galaxy Tab 52 Multi-Touch 9.7" Wi-Fi Tablet from Samsung. 9.7" Super
AMOLED Multi-Touch Display » QXGA (2048 x 1536) Native Resolution

» Quad-Core 1.9 GHz and 1.3 GHz Processors » 3GB of RAM & 32GB of Onboard Storage
» microSD Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.1

» 2.1MP Front Camera + 8MP Rear Camera » Fingerprint Scanner

» 5870mAh Battery Capacity » Android 5.0 Lollipop

SAGTS297TW
*Available in Gold, Black or White

499.00

© ematic E60223

» 10.1" Capacitive Multi-Touch Display » 1024 x 600 Native Resolution

» 1.2 GHz Quad-Core Processor » 16B of RAM & 16GB of Onboard Storage

» microSDHC Expansion up to 3268 » Integrated 802.11b/g/n Wi-Fi & Bluetooth
» Front 0.3MP & Rear Facing 2MP Cameras » 5GB of Cloud Storage » Android Lollipop 5.0

EMEGQ223 89.99

Ienowvo. ThinkPad 10

The ThinkPad 10's 10.1” WUXGA touchscreen is made of Corning Glass for
durability. With support for ten-finger gestures, the display features a

1920 x 1200 native resolution and a 16:10 aspect ratio.

» 1.59 GHz Intel Atom Processor 23795 > Integrated Intel HD Graphics

» 10.1” WUXGA Corning Glass Touchscreen » 1920 x 1200 Native Resolution
» 2 MP Front Camera, 8 MP Rear Camera » 802.11a/b/g/n Wi-Fi, Bluetooth 4.0 » Windows 8.1 Pro (64-bit)

46B: 12868 EMMC (LETP1020C1A0)........... 849.99 26B: 64GB EMMC (LETP1020C100).............. 629.99

@ LG GPad

» 1.2 GHz Snapdragon Quad-Core CPU » 1GB of RAM & 16GB of Onboard Storage
» microSDHC Expansion Slot » Dual-Band Wi-Fi + Bluetooth 4.0

» 1.3 MP Front Camera + 5 MP Rear Camera » 8000mAh Battery Capacity

» (-Pair 2.0 Smartphone Sharing Technology » Android Lollipop 5.0

LGV700B Call or Log-on

/iSU=" 7300C-A1ZenPad

Powerful performance in a slim, modern design. This system features 16GB
of built-in storage and also has a microSD slot for added storage capacity;
the microSD slot supports microSDXC cards up to 64GB.

» 10.1" Mutti-Touch IPS LCD Display » WXGA 1280 x 800 Native Resolution
» Intel Atom x3 Quad-Core CPU (SoFIA) » 26B of RAM & 16GB of Onboard Storage

» microSDXC Expansion up to 6468 » 802.11b/g/n Wi-Fi + Bluetooth 4.0

» 0.3 MP Front Camera + 2 MP Rear Camera » ASUS VisualMaster Video Suite

» Up to 8 Hours of Battery Life » Android Lollipop 5.0

ASZP10Z300C 175.00

@ LG GPadll

Get powerful performance and wireless content sharing with the G Pad Il

Tablet in Brilliant Bronze from LG.

» 2.26 GHz Snapdragon 800 CPU » 2GB of RAM

» 101" IPS Mutti-Touch Display » 5MP Rear Camera + 2MP Front Camera

» 1920 x 1200 Native Resolution » 16GB of Flash Storage » microSDXC Card
Support up to 2TB » 802.11 a/b/g/n/ac + Bluetooth » NFC-Enabled » Android 5.0 Lollipop

LGLGV94ON

w Galaxy Tab A
» 9.7" TFT Touchscreen Display

» XGA 1024 x 768 Native Resolution » 1.2 GHz Quad-Care Processor

» 1.56B of RAM & 16GB of Onboard Storage » MicroSD Expansion Slot

» 802.11a/b/g/n Wi-Fi, Bluetooth 4.1 » 2MP Front and 5MP Rear Cameras
» 6000mAh Battery » Kids Mode and Multi Window » Android Lollipop 5.0

SAGTA9716ST
*Available in Titanium, Blue or White

329.00

299.99

<CEX Iconia One 10 B3-A20-K8UH
» 1.3 GHz MediaTek MT8163 Processor » 1 GB of DDR3L RAM
» 10.1" Mutti-Touch Display » 5SMP Rear Camera + ZMP Front Camera

~ ]
» 1280 x 800 Native Resolution » 16GB of Flash Storage iy
» microSDHC Media Card Slot » 802.11 a/b/g/n + Bluetooth 4.0 )

» 6100 mAh Li-lon Battery » Android 5.1 Lollipop

ACB3AZ0K8UH 159.99

7) Smart Buy ElitePad 1000 62
» Capacitive 10.1" Multi-Touch LCD Panel » Intel Atom 1.6 GHz \
(Quad-Core Processor » 4GB LPDDR3 SDRAM » Supports MicroSDXC Cards
» WUXGA 1920 x 1200 Display » 1 x System Connector » Front 1080p HD
Webcam / Rear 8 MP Camera » Dual Speakers, Integrated Mics
» Windows 8.1 Pro (64-Bit)

Stoarage SKU Price
12868 eMM HEEP10006414 985.00
646B eMM \ HEEP10006485 \ 709.00

Panasonic. Toughpad

» 2.0 GHz Intel Core i5-4310U Processor » 10.1" Daylight-Readable
IPS LCD Display » Glove-Sensitive + Digitizer Touchscreen

» 1920 x 1200 Native Resolution » 1286B Solid State Drive

» Wi-Fi, Bluetoath, Gigabit Ethernet » Camera, Webcam, Microphone,
Speaker » MIL-STD-810G & IP5 Certified » 4G LTE Multi-Carrier Mobile
Broadband » Windows 7 Pro / Optional 8.1 Pro Upgrade

PAFZ61J6075C

2,879.00

800-947-3308 - 212-444-6691




Micresoft Surface Pro 4

Microsoft combines the portability of a tablet and

the performance of a laptop with the 12.3" Surface Pro

4 Multi-Touch Tablet. Weighing just 1.73 pounds and
measuring just 0.33" thin, the Surface Pro 4 packs an
Intel 6th gen dual-core processor into a magnesium cas-
ing with a silver finish. Use the multi-position Kickstand
and the Surface Pro 4 Type Cover (sold separately) to turn the

Surface Pro 4 into a laptop. The included Surface Pen provides up to 1024 levels of pressure sensitivity.

» Intel Core i7 6th Gen (Skylake)

» 12.3" PixelSense 10-Point Touch Display » 2736 x 1824 Screen Resolution (267 ppi)

12” TABLETS & ACCESSORIES

for Surface Pro 4

» Bluetooth 4.0 LE Connectivity

» Aluminum Casing

» Palm Block Technology

» 1,024 Levels of Pressure
Sensitivity » Instant Editing
and Formatting Tools

» 1-Click Access to OneNote

& Surface Book » Works with

Microsoft Surface Pen

II

and Cortana » Works with Surface Pro 4

COMPUTERS

Micresoft Surface Pro 4
Type Cover

» QWERTY Keyboard
for Surface Pro 4

» Compatible with
Surface Pro 3

» Improved Keyboard Design

» Improved Ultra-Thin Touchpad

» Full Row of Function Keys F1 to F12

» Windows Shortcut Keys & Media Controls

» Backlit Keyboard for Low-Light Usage

» 802.11ac Wi-Fi, Bluetooth 4.0 » USB 3.0, Mini DisplayPort, microSD Slot Surface 3 & Surface Pro 3 » Magnets for Stability in Cover Mode
» Surface Pen Included » Windows 10 Pro MI3HYO000T 4999 MiC7oooT 129.99
RAM Storage Graphics SKUS Price
1668 118 SSD Intel Irs Graphics MISP4I7161TB 2,699.00 Surface Dock MINIDISPLAYPORT HDMI AV ADAPTER '/
1668 51268 53D Intel Iris Graphics MISP4I716512 2,199.00 —— 164.99 MIF6U00020.... 32.03 /
1668 25668 55D Intel Iris Graphics MISP4IT16256 1,799.00
868 25668 SSD Intel Iris Graphics MISP4I78256 1,599.00
868 2668550 | Intel HD Graphics 520 | MISP4I58756 1,299.00 Power Supply for Surface ./
468 12068SSD | Intel HD Graphics 520 | MISPAl54128 999.00 Pro3 / USB 3.0 ETHERNET ADAPTER
468 17868550 | Intel HD Graphics 515 | MISP4CMA128 899.00 MI04Q00001 .......... 67.99 MIFBUO002T .. 39.00 ’/
SONY DPTS1 Digital Paper System 7) Elitex2 101261
Lo ) ) » 900 MHz Intel Core m3-6Y30 Dual-Core
» 13" Hexible Electronic Paper Display » 4GB of 1866 MHz LPDDR3 RAM » 12 Mult-Touch IPS Display
» 1600 x 1200 Native Resolution > Multi-Touch Support » 1920 x 1080 Screen Resolution » Integrated Intel HD Graphics 515
» 468 Storage Capacity » microSD Media Card Slot » 12868 M.2 Solid State Drive » 2MP Front Camera, 5MP Rear Camera
» Micro-USB Connector > 802.11b/g/n Wi-Fi » Stylus Pen Included » 802.11ac Wi-Fi, Bluetooth 4.2 » Thunderbolt 3 via USB Type-C » Windows 10 Home (64-bit)
SODPTSI 799.95 HEX2101230T 892.99

Matthews Universal Tablet Mount
» Mount Any Tablet or iPad

» Adjustable Length & Thickness

» Teflon Coated » Adjustable Steel Bracket
» Spring Steel Pressure Paints

» 1/4-20" Female Threaded Hole

Basic (MAUTMB) ....61.15
Desk Kit (MAUTMDK) ... .. 149.95
Master Kit (MAUTMMK) ... 189.95

Rode smartLav+ Lavalier Condenser Microphone

» Clip-On Mic for i0S and Android » Improved
Sensitivity & Signal-to-Noise » Quality Recording
to Your Smartphone » Use with Rode Rec App for
Apple i0S » Works with Many Other Recording
Apps » Omnidirectional Polar Pattern » Mic
Clip With Cable Management Included » Kevlar-
Reinforced Cable » Foam Pop Shield Included

ROSMARTLAVP 79.00 ROVMME 59.00 XUSPT1R

Vello Anti-Static Screen Cleaning ULTRA SCREEN CLEANER Endust 6 oz. Anti-Static Gel LCD

Wipes (5-Pack) Microfiber Cloth > Cleaner with Microfiber ‘

» For Use on LCDs and m » Clean Optics, Screens, Towel > Alcohol- and -
Other Screen Types Tablets & More Ammonia-free

» Antibacterial » Remove Dust, Dirt,

Fingerprints, Residue » Made of Soft, » Holds Water

Tissue-Like Paper » Special Coating » Soft Enough to P
Prevents Scratches Scratching
VESCP106 3.99 ULUMFC118

» Absorbs Oils, & Grease

CTA Digital Kitchen Mount

» For All iPad Models/Tablets 6-8.5" Wide
» Mounts to Walls or Under Kitchen Cabinet

-

=
» Two Mounting Bases Included
» Also Works as a Tabletop Stand
» Quick Release Buttons
» Portrait / Landscape Mode
CTPADKMS 29.28

Rode VideoMic Me Directional Mic

» Lightweight at Only 1.2 Ounces
» Flexible Mounting Bracket

» 1/8" TRRS Connector

» 1/8" Headphone Jack on Rear
» Includes Furry Windshield

» Safe on Anti-Glare

Griffin PowerDock 5 Charging Station

» Charges up to 5 USB Devices
» Five Integrated USB Charging Ports
» Each Port Provides 5V @ 2.1A
» Charges iPad, iPad mini,
iPhone, & More
» Holds iPads with their Cases

GRNA388362

Call or Log-on

Xuma Stylus for Tablets

» Increased Accuracy and Comfort for Writing,
Drawing, and Navigating

» Works with Many Tablets, Smartphanes

» Supple Rubber Tip » Metal Construction

» Integrated Pocket Clip

» Helps Eliminate Smears, Fingerprints

» Thin, Lightweight, Low Profile

8.95

Xuma Clear Screen Protector

» Scratch-Resistant Protective
Film » 4H Hardness » Doesn't
Interfere with Touchscreen

» Glue-Free / Static Application

Coatings » Maintains Image Clarity
revent » Includes Accessories
et for Application = T
1.99 EN12275 10.07 AVAILABLE FOR ALL IPAD MODELS..........ooove... 79.00

www.BandH.com
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2-IN-1 NOTEBOOKS

2-in-1 Notebooks: What You Need to Know

Is that a tablet or a notebook? If you're having trouble figuring out which is which, you're not
the only one. The line that divides the two has been blurred, especially thanks to 2-in-1

notebooks. 2-in-1 notebooks provide the portability and touch support of tablets, but still provide
the performance you need from laptops. 2-in-1 notebooks are usually available in two different variants.

The 360-Degree Hinge

The 2-in-1 notebook with a 360-Degree hinge
is a concept steeped in versatility. The note-
book’s traditional yet evolved clamshell de-
sign allows the screen to be pushed back all
the way untilit lays flat against the back of the
keyboard. This lets you use the 2-in-1 note-
book as a tablet, thanks to its touchscreen.
It can get a bit weird having the keyboard ex-
posed on the other side, though. Fortunately,
the Lenovo X1 Yoga solves that problem by
having the keyboard frame automatically rise
and lock when switching to tablet mode to
prevent accidental keystrokes and provide a
more secure grip. The hinge also presents
other unique modes, like stand and tent, all
of which are designed for different uses.

The advantage of the 360-degree hinge is
that the 2-in-1 notebook is still one solid
piece. Of course, the downside of that is the
added weight from the keyboard and ports.
While the 2-in-1 notebook with a 360-degree
hinge may masquerade as a tablet at times, it
never lets you forget that it's a notebook first.

The Detachable Screen

If you want the full “tablet” experience,
there are 2-in-1 laptops on which the screen
completely detaches from the keyboard.

This allows you to use the display as a tablet
without the added weight of the keyboard.
The Microsoft Surface Book is a prime ex-
ample of the detachable screen. Its unique
hinge allows you to detach its 13.5" Pix-
elSense display easily and use it as a tablet.
You can also flip the screen around and re-
attach it to the hinge so the screen is facing
out while the Surface Book is closed. This
replicates the 360-degree hinge experi-
ence, except the keyboard isn't exposed on
the other side.

The detachable screen also allows for other
things, like having an extra battery or a dedi-
cated GPU in the keyboard dock. This allows
you to use the display as a tablet and then
get added performance and battery life when
you connect it back with the keyboard dock.
The keyboard dock will also have more ports,
allowing for better connectivity for peripher-
als and accessories.

Performance

2-in-1 notebooks are usually more perfor-
mance driven than tablets. This means that
2-in-1 notebooks are capable of running ap-
plications and programs better and faster
than most tablets. 2-in-1 notebooks can also
offer more storage, so you can store larger
files on your hard drive. If you're running low
on storage space, you can connect an exter-
nal hard drive via the USB port.

/

Price

2-in-1 notebooks don't always have to be
about performance. Sometimes, they are
about practicality. Not everyone can afford
both a tablet and a notebook or shell out the
big bucks for the top-of-the-line 2-in-1 note-
book. 2-in-1 notebooks can be the happy
medium for someone looking for a budget or
mid-range computer.

Operating System

2-in-1

notebooks == W|ndOWS1O
may repli-

cate the way tablets look and feel, but they
also provide the full Windows experience.
Most tablets run Android or i0S, but 2-in-1
notebooks give you the full benefit of Win-
dows. This means you can run full applica-
tions, not the truncated versions from an app
store [if they're even available there, in the
first place). Windows 10 offers a tablet mode,
which automatically activates when you de-
tach the 2-in-1 notebook from its keyboard
dock. The Start menu goes full-screen as do
Windows Store apps and settings, similar to
how it was in Windows 8. Then, when you re-
attach the display to the keyboard dock, it re-
verts back to the desktop version of Windows
10. This means you'll get the full experience
for tablets and notebooks. Having access
to a full Windows operating system allows
you to run full programs and get the perfor-
mance you need from your 2-in-1 notebook.

2-in-1 Notebooks are Here

2-in-1 notebooks are a unique solution for
people who want a tablet and a notebook, but
don'twant to purchase two separate devices.
If you're looking for a balance between the
portability of a tablet and the performance of
a notebook, a 2-in-1 notebook provides the
best of both worlds.

800-947-3308 - 212-444-6691



/1S5S 10.1” T100HA Transformer Book
» Detachable Tablet + Notebook Combination

» 1.44 GHz Intel Atom x5-28500 Quad-Core

» 4GB of RAM » 10.1" WXGA IPS Touch Detachable Display

» 1280 x 800 Native Resolution » Intel HD Graphics

» 646B eMMC Drive » microSDXC Card Slat, USB 3.0 Type-C

» 802.11a/b/g/n Wi-Fi, Bluetooth 4.0 » Windows 10 Home

ASTT00HAC4GR

I-’»

294.00
TOSHIBA Satellite Click10
The Toshiba Satellite Click10 Multi-Touch 2-in-1 Tablet is a Windows
10 Home computer that comes in tablet form factor so you can easily
carry and use it at home or at work and includes a keyboard dock that
converts it into a notebook, making you more productive.
» 1.6 GHz Intel Atom x5-28300 Quad-Core @/
» 268 of 1600 MHz LPDDR3 RAM » 10.1" TruBrite TFT display
» 1920 x 1200 Native Resolution » Intel HD Graphics » 802.11n Wi-Fi, Bluetoath 4.1
» Tx Micro-USB 2.0, 2x USB 2.0, microSDXC » Includes Keyboard Dock » Windows 10 Home

Storage SKU Price
64GB Flash Storage TOPDWOGUOOS 339.99
3268 Flash Storage \ TOPDWOGUOO6 \ 329.99

Micresoft 13.5” Surface Book

The Microsoft Surface Book Multi-Touch 2-in-1 Notebook is a
high-performance laptop/tablet hybrid with power and versatility. The
Surface Book packs an Intel 6th gen (Skylake) dual-core processor
into a magnesium casing with a silver finish. Use the tactile keyboard
and touchpad to stay productive. You can also detach the screen

from the dock and use the Surface Book as a tablet. The included
Surface Pen provides added precision thanks to its 1024 levels of pressure sensitivity.
» 13.5" PixelSense Detachable Display » 3000 x 2000 Screen Resolution (267 ppi)

» USB 3.0, Mini DisplayPort, SD Card Slot » 802.11ac Wi-Fi, Bluetooth 4.0

» Surface Pen Included » Windows 10 Pro

Processor RAM Storage Graphics SKU Price
2.6 GHz Intel Core i7-66000 | 166B 178 SSD NVIDIA GPU MISBI7161TB 3,199.00
2.6 GHz Intel Core i7-6600U | 166B | 51268 SSD NVIDIA GPU MIMSBI716512 | 2,699.00
2.4 GHz Intel Core i5-63000 | 8GB | 25668 SSD NVIDIA GPU MIMSBI58256N | 1,899.00
2.4 GHz Intel Core i5-6300U | 8GB | 1286B SSD Intel HD Graphics 520 MIMSBI58128 1,499.00

7 13" Pavilion x360

Thin at 0.89" and equipped with a 360° hinge design, the 13"
Pavilion x360 13-s120nr Multi-Touch 2-in-1 Notebook from HP allows
you to fold the screen a full 360°, transforming it between stand, tent,
notebook, and tablet modes.
» 46B of DDR3L RAM » 13.3" IPS Multi-Touch Display
» 1366 x 768 Native Resolution » 500GB 5400 rpm Hard Drive
» Bluetooth » USB 3.0/ USB 2.0/ HDMI / Card Reader » 360° Hinge » Windows 10 Home

Processor Graphics Wireless SKU Price
2.3 GHz Intel Core i3-6100U Dual-Core Intel HD Graphics 520 802.11ac | HEMIXO1UA | 529.99
1.6 GHz Intel Pentium N3700 Quad-Core | IntelHD Graphics | 802.11n_ |HETTKI20NRX3] 429.99

7 13.3" Spectre 13
» 2.4 GHz Intel Core i7-5500U Dual-Core
» 86B of 1600 MHz LPDDR3 SDRAM
» 13.3" Multi-Touch Display » Intel HD Graphics 5500
» Multi-Format SD Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0
» 360° Hinge » Windows 8.1 (64-bit)

e

TOUCHS!

2-IN-1 NOTEBOOKS [e{e] 4210y 523

/iSUS 11.6” Transformer Book Flip

» 1.6 GHz Intel Celeron N3050 (Braswell) » 4GB RAM

» 11.6" IPS 360° Hinged Touchscreen » 1366 x 768 Native Resolution
» Integrated Intel HD Graphics » 646B eMMC Flash Storage

» MicroSD Card Slot » 802.11ac Wi-Fi, Bluetooth 4.1

» 1xUSB 3.0 Type-C, 1x USB 3.0 » Windows 10 Home

ASTP200SA04T

/iISUS Flip R554LA

With its 360° hinge design, the black/silver Flip R554LA 2-in-1 Multi-Touch

Notebook from ASUS allows you to fold the screen a full 360°, transforming

it from a laptop to a tablet in one fluid motion.

» 15.6” Multi-Touch Glossy Display » HD 1366 x 768 Native Resolution

» SuperMulti DVD Burner » 802.11n Wi-Fi & Bluetooth 4.0 » 360° Hinge » Windows 10 (64-bit)
Processor RAM  Storage Graphics SKU

2.4 GHz Intel Core i7-5500U Dual-Core| 8GB 178 b.4k Intel HD Graphics 5500 | ASR654LARH71 | 687.00

1.7 GHz Intel Core i3-4005U Dual-Core| 66B | 5006B 5.4k | Intel HD Graphics 4400 | ASRE54LAR3TT | 499.00

13.3” Inspiron 13 7000

@ The Dell Inspiron 13 7000 Series is a convertible laptop
that features a hinge design that lets you to fold the screen a full
360°, turning it from a notebook to a tablet in one fluid motion.
While in tablet mode, you can use your fingers to perform multi-touch
gestures; you can swipe, rotate, and resize images at your preference
and tap out emails utilizing the on-screen keyboard.

» Hinged 13.3" TrueLife IPS Touchscreen » Integrated Intel HD Graphics 520

» 5006B 5400 rpm Hybrid Hard Drive » 2-in-1 SD & MMC Media Card Reader

» 802.11ac Wi-Fi & Bluetooth 4.0 » Stylus Included » Windows 10 Home (64-bit)

322.99

Price

Processor RAM Storage  Resolution SKU Price
2.5 GHz Intel Core i7-6500U Dual-Core 8GB | 2566B SSD | 1920x1080 | DEI131735984 999.00
2.3 GHz Intel Core i5-6200U Dual-Core 86B | 5006B 5.4k | 1920x 1080 DEINS4371S 749.00
2.3 GHz Intel Core i5-6200U Dual-Core 4GB | 500GBb.4k | 1366 x 768 DEI31735924 598.99

@ 11.6” Inspiron 11 3000

The Inspiron 11 3000 Multi-Touch 2-in-1 Notebook from Dell
uses a hinge design that allows you to fold the screen a full 360°

and place it in tablet, stand, tent, or laptop mode in one fluid motion.
The hybrid computer measures just 0.83" thin and weighs just 3.1 -,
pounds for a portable, lightweight design.
» 4GB of 1600 MHz DDR3L RAM » 11.6” Truelife LED-Backlit Touchscreen

» 1366 x 768 Native Resolution » 2-in-1 5D & MMC Card Reader

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » 360° Hinge Design » Windows 10 Home (64-bit)

Processor Storage Graphics SKU Price
1.9 GHz Intel Core i3-4030U Dual-Core | 500GB 5.4k | Intel HD Graphics 4400 | DEI31488841S | Log-on
1.6 GHz Intel Pentium N3700 Quad-Core | 12868 SSD Intel HD Graphics DEINS2101S 449.99
2.16 GHz Intel Celeron N2840 Dual-Core | 5006B 5.4k Intel HD Graphics DEI3T472501S | 389.00

Ilenowvo. 14 Flex3

Featuring a unique quad-mode design, the black 14" Flex 3 Multi-Touch
2-in-1 Notebook from Lenovo is a system whose screen can rotate 360°
to vary between laptop, stand, tent, and tablet mode. If you are working

on tasks that require the keyboard, such as creating Word documents or
editing a spreadsheet, the Flex 3 is best used in classic laptop mode to

help increase productivity.

» 14 10-Point Multi-Touch IPS Display » Full HD 1920 x 1080 Screen Resolution
» Integrated Intel HD 520 Graphics » 802.11ac Wi-Fi & Bluetooth 4.0

» Built-in 720p Webcam, Mic, & Speakers » Windows 10 (64-bit)

Processor RAM Storage SKU Price
Storage Resolution SKU Price 2.5 GHz Intel Core i7-6500U Dual-Core | 8GB 178 b.4k LEF380R3000U 799.00
5126B SSD 2560 x 1440 HEHPSPCTR360 1,299.00 2.3 GHz Intel Core i5-6200U Dual-Core | 4GB 5006B 5.4k LEFLEX31480R 665.00
25668 SSD \ 1920 x 1080 \ HE134003DX \ 1,199.00 2.3 GHz Intel Core i5-6200U Dual-Core | 8GB 50068 5.4k + 86BSSD LEF380R3000W 699.00

www.BandH.com
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Designed for a Web-optimized experience, the C201 provides a user-friendly interface
enhanced by the Internet. The 11.6” widescreen display has a 16:9 aspect ratio and
an HD 1366 x 768 native resolution. Its resolution can support native 720p
HD video playback without letterboxing. Additionally, the Chromebook o ®
can output video to an external display via the micro-HDMI port.
» Rockchip 3288-C SoC » 1.8GHz ARM Cortex-A17 » 11.6” LED Display
» Integrated ARM Mali-T764 Graphics » 1668 SSD » 802.11ac Wi-Fi& Bluetooth 4.0 » Chrome 0S

RAM SKU Price
46B ASC201PACA17 194.99
268 | ASC201PADSO1 | 167.03

/iSUS" Chromebook Flip

Designed for a Web-optimized experience, the ASUS Chromebook Flip 10.1”
Multi-Touch Convertible Chromebook provides a user-friendly interface
enhanced by the Internet.
» 10.1" Touchscreen » 802.11ac Wi-Fi& Bluetooth 4.0

Processor RAM

1.8GHz ARM Cortex-A17| 4GB
1.86Hz ARM Cortex-A17] 268

Storage Graphics SKU Price
166B 55D | Integrated ARM Mali-T764 Graphics | ASC100PADB0Z | 269.00
| 166B SSD | Integrated ARM Mali-T764 Graphics | ASC100PADBO1 | 239.00

/iSUS C300MA-DH02

» 2.16 GHz Intel Celeron N2830 Dual-Core » 4GB of DDR3L RAM

» 166B eMMC Flash Storage » Integrated Intel HD Graphics

» 13.3" Matte HD Display » 1366 x 768 Native Resolution

» Secure Digital Media Card Slot » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0
» Built-in Webcam, Mic, & Speakers » Chrome 0S

ASC300MADH02

219.00

acer €720

The C72011.6” Chromebook is designed for a Web-optimized
experience. With its user-friendly interface, the Acer Chromebook
offers a unigue computing experience enhanced by the Internet.
» 11.6" 1366 x 768 LED Display

» 802.11a/b/g/n Wi-Fi& Bluetooth 4.0 » Chrome 0S

Processor RAM Storage Graphics SKU Price
1.706Hz Intel Core i3-4005 46B | 326BSSD | Intel HD Graphics 4400 | ACCT203605 | 324.99
1.4 GHz Intel Celeron 29550 Haswell | 4GB | 166BSSD | IntelHD Graphics | ACC7202625 | 279.59

acer CBs

The CB5 13.3" FHD Chromebook is designed for a Web-optimized
experience. With its user-friendly interface, the Acer Chromebook
offers a unique computing experience enhanced by the Internet.

» 13.371920 x 1080 LED Display » 802.17ac Wi-Fi  » Chrome 0S
Processor RAM Storage Graphics SKU Price
2.10 GHz NVIDIA Tegra K1 Quad-Core | 4GB | 326B SSD | Integrated NVIDIA Graphics | ACCBB311T677 | 344.99

2.10 GHz NVIDIA Tegra K1 Quad-Core | 268 | 1468 SSD | Integrated NVIDIA Graphics | ACCBS311T980 | 295.83

Chromebook 11 G4
» 2.166Hz Intel Celeron N2840 » 4GB of DDR3L RAM
» 166B eMMC Flash Storage  » 11.6” Anti-Glare LED-Backlit Display
» Intel HD Graphics  » 1366 x 768 Native Resolution
» 1 Multi-Format Digital Media Reader
» 802.11a/b/g/n/ac Wi-Fi, Bluetooth 4.0
» Built-In Webcam, Mic, & Speakers » Chrome 0S
HECB11POB78U

209.00

TOSHIBA Chromebook 2

The ice silver Chromebook 2 features a textured resin finish. The 13.3" TruBrite
TFT IPS display has a 16:9 aspect ratio and its resolution can support native 1080p
FHD video playback without upscaling.

» 13.3" LED-Backlit TruBrite IPS Display
» Full HD 1920 x 1080 Native Resolution » 16GB of eMMC Flash Storage » SD Media Card Reader
» 802.11ac Wi-Fi & Bluetooth 4.0 » 1x USB 3.0 Port & 1x USB 2.0 Port  » Chrome 0S

Processor RAM Graphics SKU Price

2.1 GHz Intel Core i3-5015U Dual-Core | 4GB | Intel HD Graphics 5500 (1920 x 1080) | TOCB35C3350 | 399.99
1.7 GHz Intel Celeron 3215U Dual-Core | 4GB Intel Graphics (1920 x 1080) T0CB35C3300 | 299.99
2.16 GHz Intel Celeron N2840 Dual-Core | 4GB Intel Graphics (1920 x 1080) T0CB35B3340 | 269.99
2.16 GHz Intel Celeron N2840 Dual-Core2GB | 2GB Intel Graphics (1366 x 768) 10CB35B3330 | 219.99

acer €910-C453

Designed for a web-optimized experience using Chrome 0S. The user-friendly
Acer Chromebook offers a unigue computing experience.

» 1.5 GHz Intel Celeron 3205U Dual Core  » 4GB DDR3L SDRAM

» 166B SSD » Integrated Intel HD Graphics » Chrome 0S

» 1366 x 768 HD Resolution  » 15.6" LED-Backlit Display

» Secure Digital (SD) Media Card Slot  » 802.11ac Wi-Fi > Built-in Webcam, Speakers & Mic

ACC910C453 296.16

lenowvo. 100S

» 2.16 GHz Intel Celeron N2840 Dual-Core  » 2GB of RAM
» 11.6" HD Display » 1366 x 768 Native Resolution

» Integrated Intel HD Graphics » 166B of eMMC Storage
» 4-in-1 Media Card Reader » 802.11ac Wi-Fi & Bluetooth
» 1xUSB 3.0 Port & 1xUSB 2.0 Port  » Chrome 0S
LECHRBOQNOD9

189.00

Ienowo. ThinkPad Yoga 11e

» 1.83 GHz Intel Celeron N2940 Quad-Core  » 4GB of DDR3L RAM

» 166B eMMC Flash Storage » Integrated Intel HD Graphics

» 11.6" HD IPS Touchscreen > 1366 x 768 Native Resolution

» 802.11ac Wi-Fi, Bluetooth 4.0 » Built-in Webcam, Mic, & Speakers
» Unique 360° Multi-Mode Design  » Google Chrome 0S
LET1EYOGADUA

w Chromebook 3
» 1.6 GHz Intel Celeron N3050 Dual-Core

» 26B of LPDDR3 RAM > 11.6” Anti-Glare Display ‘
» 802.11ac Wi-Fi & Bluetooth 4.0 » USB 3.0/ USB 2.0/ HDMI > Chrome 0S

399.00

» HD 1366 x 768 Screen Resolution > Integrated Intel HD Graphics
» 166B eMMC Flash Storage » Micro SD Card Reader

RAM SKU Price
AGB SAXES00C13K2 229.00
268 | SAXEB00CT3K1 | 199.00

w Chromebook 2
» 2.0 GHz Samsung Exynos b Octa 5800
» 4GB of DOR3LRAM  » 166B eMMC Flash Storage
» Integrated ARM Graphics  » 13.3" Anti-Glare LED-Backlit Display
» Full HD 1920 x 1080 Native Resolution
» microSD Card Reader » 802.11a/b/g/nfac Wi-Fi, Bluetooth 4.0
» Built-In Webcam, Mic, & Speakers » Chrome 0S
SAXES03C32K1

379.00

800-947-3308 - 212-444-6691




1-14” WINDOW NOTEBOOKS

@ 13.3” XPS 13 9350

Go beyond Full HD 1080p with the silver anodized
aluminum XPS 13 9350 Multi-Touch Notebook. The visuals are
handled by integrated Intel HD Graphics 520 and the display has
a brightness of 400 cd/m2 and viewing angles of 170°.

» 2.5 GHz Intel Core i7-6500U Dual-Core  » 8GB of 1866 MHz LPDDR3 RAM

» 13.3" InfinityEdge Multi-Touch Display » QHD+ 3200 x 1800 Native Resolution

» Integrated Intel HD Graphics 520 » 256GB PCle Solid State Drive  » 802.11ac Wi-Fi & Bluetoath 4.1
» Thunderbolt 3/ USB 3.0/ SD Card Reader » Built-in 720p Webcam, Mic, & Speakers

» Windows 10 Home (64-hit)

2.5 GHz Intel Core i7-6500U Dual-Core
2.3 GHz Intel Core i5-6200U Dual-Core ‘

@ 13.3" XPS 13
» 2.2 GHz Intel Core i5-5200U Dual-Core

» 4GB of 1600 MHz DDR3L-RS RAM

» 13.3" InfinityEdge Display > Full HD 1920 x 1080 Native
Resolution > Integrated Intel HD Graphics 5500

» 1286B SSD  » 802.11ac Wi-Fi & Bluetooth 4.0

» USB 3.0/ Mini DP / SD Card Reader

» Built-in 720p Webcam, Mic, & Speakers  » Windows 10 Home (64-bit)

DEXPS934318S

DEXPSE340S
DEKPS4007S |

1,499.00
Call or Log-on

999.00

7 13.3" Stream 13-c110nr

» 1.6 GHz Intel Celeron N3050 Dual-Core
» 268 of DDR3L RAM  » 13.3" HD Display
» 1366 x 768 Native Resolution
» Integrated Intel HD Graphics » 3268 eMMC Storage
» MicroSD Card Reader » 802.11n Wi-Fi & Bluetooth
» Built-in HD Webcam, Mic, & Speakers » Windows 10 Home
HEP3U33UA

229.00

) 14" ProBook 640 G1

» 2.6 GHz Intel Core i5-4210M Dual-Core
» 46B of 1600 MHz DDR3 RAM  » 14" SVA Anti-Glare Display @ faRenn
» HD 1366 x 768 Native Resolution
» Integrated Intel HD 4600 Graphics
» 500GB 7200 rpm SATA Hard Drive
» SuperMulti DVD Burner & SD Card Reader '
» 802.11n Wi-Fi & Bluetooth 4.0 » Built-in 720p Webcam, Mic, & Speakers
» Windows 7 Pro + Windows 10 Pro License
HE64061T1C08

829.00

7 14" EliteBook Folio 1040 G2

Thin at 0.63", weighing 3.3 Lb, and featuring a
magnesium and aluminum alloy chassis, the EliteBook Folio
1040 GZ is an enterprise-class system that is powered by a
2.6 GHz Intel Core i7-5600U Dual-Core processor, allowing you
to run multiple applications simultaneously.

» 14" UWVA Anti-Glare Display > Integrated Intel HD Graphics 5500
» MicroSD Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0
» Built-in 720p Webcam, Mic, & Speakers » Windows 7 Pro + Windows 10 Pro

COMPUTERS

/iSU=" 13.3” ZenBook UX305CA

Thin at 0.5", the aluminum 13.3" ZenBook UX305CA

Notebook features a 13.3" widescreen IPS display with a

16:9 aspect ratio and is powered by integrated Intel HD

Graphics 515. You'll also be able to output video to an

external display using the Micro HDMI port.

» 900 MHz Intel Core m3-6Y30 Dual-Core

» 86B of 1600 MHz LPDDR3 RAM » 13.3" IPS Display

» Integrated Intel HD Graphics 515 » 25668 M.2 SSD

» SDXC Media Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0

» 3% USB 3.0 Ports & 1 x Micra HDMI Port » Windows 10 (64-bit)

|-

Resolution SKU PRICE
3200 x 1800 Glossy Touchscreen ASUX305CAMAT 799.00
1920 1080 Matte Display | ASUX305CAEHM \ Callor Log-on

» 4GB of Onboard 1600 MHz LPDDR3 RAM
» 12.2" WQXGA Anti-Reflective Display
» 2560 x 1600 Native Resolution

<CEr Aspire E11.6” Notebook
» 2.16 GHz Intel Celeron N2840 Processor
» 26B DDR3L SDRAM » 326B Flash Memory
» Integrated Intel HD Graphics » 11.6” 1366 x 768 HD LED Display
» SD Card Slot/HDMI/USB Ports » 802.11ac Wi-Fi/Gigabit Ethernet
» 3-Cell Li-Polymer 2670mAh Battery » Integrated Webcam, Mic,

and Speakers » Windows 8.1 Pro (64-Bit)

229.00

» Integrated Intel HD Graphics 5300
» 128GB SATA 11l Solid State Drive » MicroSD Media Card Slot

ACEST111MC37
» 802.11ac Wi-Fi, WiDi, Bluetooth 4.0 » Samsung Link 2.0, SideSync 3.0

w 12.2” ATIV Book 9
» Windows 8.1 (64-hit) *Free Upgrade To Windows 10 valid until 07/29/16

» 900 MHz Intel Core M-5Y31 Dual-Core
SANP930XZKK2

899.00

o

Call or Log-on

Tenowo. ThinkPad E455

» 2.2 GHz AMD A6-7000 Dual-Core CPU » 4GB RAM

» 500GB 5400 rpm Hard Drive » AMD Radeon Ré Graphics

» 14" Anti-Glare HD Display » HD 1366x768 Native Resolution

» 802.11b/g/n Wi-Fi & Bluetooth 4.0 » Built-in Webcam, Mic,
& Speakers » Windows 7 Pro + Windows 8.1 License

» *Free Upgrade To Windows 10 valid until 07/29/16

LEE45520DED0

Panasonic. Toughbook 53

» 2.0 GHz Intel Core i5-4310U CPU

» 14" LED-Backlit Display » Intel HD Graphics 4400

» 1366 x 768 Native Resolution » SuperMulti DVD Burner
» Gigabit Ethernet & 802.11ac Wi-Fi

» Secure Digital Media Card Reader

» Windows 7 Pro + Windows 8.1 Pro

=

RAM Storage SKU PRICE

CPU RAM Storage Resolution SKU PRCE 8GB 50068 7.2k PA532AMZYCM 1,749.00

2.6 GHz Intel Core i7-5600U Dual-Core | BGB | 256GB M.2 SATA SSD | 1920 x 1080 | HE104062P084 |  1,899.00 4GB 50068 7.2k PACF532ALZYC 1,559.99
2.2 GHz Intel Core i5-5200U Dual-Dnre\ 4GB \12868 M.2 SATASSD\ 1600 x 900 \HEHMIJGZPIJSM 1,204.00 4GB 3206B 5.4k PACFb32JCZYC 1,199.00

www.BandH.com
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I COMPUTERS

CEr 15.6” V3-575 Aspire V 15
Multi-Touch Notebook Computer
The black 15.6” V3-575 Aspire Notebook from Acer sports a 6th generation
Skylake processor and 1600 MHz DDR3L SDRAM for handling demanding
applications and everyday tasks without slowing down.

» 1178 5400 rpm SATA Hard Drive » 1920 x 1080 Screen Resolution

@ 15.6” Inspiron 15 3000 Series
Multi-Touch Notebook Computer
» 4GB of 1600 MHz DDR3 RAM » 15.6” LED

» 1366 x 768 Screen Resolution » Integrated Intel HD Graphics @
» 3-in-1 SD Media Card Reader » 802.11n Wi-Fi & Bluetooth 4.0

» Built-in 720p HD Webcam, Mic, & Speakers

» Integrated Intel HD Graphics 520 » SD Card Reader » 802.11ac Wi-Fi & Gigabit Ethernet LAN » Windows 10 Home (64-bit)
» USB3.0/USB 2.0/ HOMI /VGA » Windows 10 Home (64-bit) * Available In Black, Red and Blue
Screen RAM CPU SKU Price CPU Storage Screen SKU Price
Multi-Touch Display 86B | 2.5 GHz Intel Core i7-6500U Dual-Core |  ACV3I765008 799.95 1.6 GHz Intel Pentium N3700 Quad-Core |  500GB b.4k Multi-Touch Display | DEI35528044B 399.99
Anti-GlareMatte | 6GB | 2.3 GHzIntelCorei®-62000 | ACV3S7551A0 | 549.99 2.2 GHz Intel Core 5-5200U Dual-Core | 1TB5.4k | Anti-Glare Matte | DEINS5438750 * | 499.00

P 15.6” ProBook 450 62
Features a dual-core 2.2 GHz Intel Core i5-5200U processor that
pravides performance for running multiple personal or business applications.
» 500GB 5400 rpm Hard Drive » 15.6" LED-Backlit Anti-Glare Display
> FullHD 1920 x 1080 Native Resolution » NVIDIA GeForce GTX 960M GPU (46B GDDRS)
» SuperMulti DVD Burner » 02.11a/b/g/nfac Wi-Fi, Bluetooth 4.0 » 50068 HOD + 1286B 53D » 10/100/1000 Mbps Gigabit Ethernet

> Built-in Webcam, Mic, & Speakers » 802.11ac Wi-Fi, Bluetooth » HDMI, USB 3.0 » Windows 10 Home (64-bit)
» Windows 7 Pro (64-bit)

@ 15.6” Inspiron 15 7000 Series

Multi-Touch Notebaok. The IPS display features a native resolution
of 3840 x 2160, which means it can play 4K UHD content natively.
» 15.6” 4K UHD IPS Multi-Touch Display

CPU Storage Screen SKU Price
CPU RAM Graphics SKU Price 1668 50068 + 12868 SSD 3840 x 2160 Touchscreen DEI755975126 1,199.00

2.2 GHz Intel Core i5-5200U 8GB Intel HD Graphics 5500 HEPBA450G30UT 749.00 868 118 3840 x 2160 Touchscreen DEINS50126 999.00
1.7 GHzIntel Core i3-4005U | 4GB | Intel HD Graphics 4400 | HE4G0GINOPS3 |  419.96 868 B 1920 x 1080 Anti-glare matte | DEI756925128 835.00

/iSUS 15.6” ZenBook Pro
Multi-Touch Notebook

Features a 15.6” touchscreen so you may utilize the multi-touch
gestures within Windows 10 to control this system

» 2.6 GHz Intel Core i7-6700HQ Skylake » 16GB of DDR4 RAM

SUS' 15,67 F55UA-EHT1

Notebook Computer

Powered by a 2.5 GHz Intel Core i7-6500U Dual-Core processor, allowing
you to run multiple applications simultaneously.

» 2.5 GHz Intel Core i7-6500U Dual-Core  » 8GB of DDR3L RAM

» 15.6” IPS Multi-Touch Display > UHD 4K 3840 x 2160 Native Resolution » 15.6” Glossy Display » HD 1366 x 768 Native Resolution

» NVIDIA GeForce GTX 960M (26B  » 5126B PCI-Based SSD » Integrated Intel HD Graphics 520 » 178 5400 rpm Hard Drive

» SDXC Card Reader » 802.11ac Wi-Fi & Bluetooth 4.0 » Thunderbolt 3, USB 3.0, and HOMI Ports » SuperMulti DVD Burner » 802.11ac Wi-Fi & Bluetooth 4.0

» Windows 10 (64-hit) » Built-in VGA Webcam, Mic, & Speakers > Windows 10 (64-bit)

[ASUX501VWDS7) 1,499.00 (ASFS55UAEHT1) 579.00

Ienowo. 15.6” ThinkPad E565 /iSUS 15.6” R9H6LA Notebook

Notebook Computer Thin at 1.0" and weighing 5.1 (b, allows you to run multiple applications
Designed for small business, enterprise, and education users. Well suited simultaneously. The processor can be overclocked for efficient multitasking.
for web browsing, email, document creation, and multimedia playback. » 16.6” HD Matte Display » 1366 x 768 Native Resolution

» 4GB of 1600 MHz DDR3L RAM » 15.6” Display » SuperMulti DVD Burner / SD Card Reader

» HD 1366 x 768 Screen Resolution » 50068 5400 rpm Hard Drive » 802.17ac Wi-Fi & Bluetooth 4.0

» DVD£RW Drive » 802.11ac Wi-Fi &Bluetooth » 4-in-1 Card Reader, Webcam ’ BU_“H" Webcam,Mic,&Speakers
» Windows 7 Pro + Windows 10 License » Windows 10 (64-bit)
CPU Graphics SKU Price CPU RAM  Storage Graphics SKU Price
1.8 GHz A10-8700P Processor AMD Radeon R6 M340DX LEE56520EY0C 579.00 2.2 GHz Intel Core i5-5200U Dual-Core | 6GB | 1TB 5.4k | Intel HD Graphics 5500 | ASR658LARH5T | 479.00
1.6 GHz A6-8500P Processor \ AMD Radeon Rb \ LEE56520EY0A \ 514.00 1.7 GHz Intel Core i3-4005U Dual-Core \ 46B \ 5006B 5.4k \ Intel HD Graphics 4400 \ ASR556LARH31 \ 399.00
TOSHIBA 15.6” C55DT-C5245 @ LG 15.6” gram 15 Notebook
Multi-Touch NotebookComputer

Weighing less than 2.2 pounds and measuring just
0.7" thin, the gram 15 is made of magnesium alloy and has a gold finish.

» B0B of 1600 MHz DDR3L RAM  » 15.6” Full HD Display

2.2 GHz AMD A8-7410 quad-core processor and 6GB of DDR3L SDRAM
which allows you to multitask and quickly load files and programs.

» 1B 5400 rpm SATA Hard Drive » 1920 x 1080 Screen Resolution > Integrated Intel HD Graphics 520
» Integrated AMD Radeon Rb Graphics — » MicroSD Media Card Slot  » 802.11ac Wi-Fi, Bluetooth 4.0 LE

» 15.6" LED-Backlit Capacitive Touchscreen » USB 3.0 Type-C Port » Windows 10 Home (64-bit)

» 13§6 X 768 HD Nativ_e Resolution  » SuperMulti DvD Bu.rner » 8??.11b/g/n Wi-Fi, Bluetooth 4.0 CPU Storage SKU Price
» Built-In Webcam, Mic & Speakers > Windows 10 64-bit Home Edition 2.5 GHz Intel Core i7-6500U Dual-Core 51268 SSD LG15COREITP 1,499.99
(TOC55DTC5245) 475.99 2.3 GHz Intel Core i5-6200U Dual-Core | 2566BSSD |  LGISCOREISP | 1,099.99

800-947-3308 - 212-444-6691
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.’ Authorized Reseller MacBook Air
The Apple MacBook Air is an ultraportable notebook
computer with a thin and lightweight design. Apple's
engineers have leveraged the lessons they learned in
designing the miniaturized iPad and applied them to
the design of this 2.38-pound computer.

" Authorized Reseller MacBook Pro

The Apple MacBook Pro with 13.3" Retina Display is a
powerful notebook computer with an innovative, ultra-
thin, ultraportable aluminum unibody design. It is loaded
with advanced power management features and an
integrated Lithium polymer battery, which work together

to provide up to 9 hours of wireless web browsing. - .
» LED backit IPS glossy fiish » 802.11ac Wi-Fi & Bluetooth 4.0 13661768 resolution ? Backlit standard keyboard
» 2560 x 1600 resolution » Backlit chiclet keyboard » Thunderbolt Z & USB 3.0 ports » Mac 0SXT0.10 or 10,11
4 » Flash storage » Intel Graphics 6000
» Thunderbolt 2, HDMI & USB 3.0 ports » Mac 0SX10.10 0r 10.11 » 802.11c Wi-Fi & Bluetooth 4.0
» 1866 MHz DDR3 RAM » Intel Iris Graphics i ’
»
Flash storage 1.6
13.3” Processor RAM Storage SKU Price
Processor RAM T SKU Price 1.86Hz Itel Core 5 868 51268 APMBAZOMJVP3 1,389.99
2.76Hz Intel Core i5 1668 75668 APMBPMF840T 1,585.00 1.66tizlntel Core 5 168 01768 APMBAZOM.VPY 1,249.00
. 1.66Hz Intel Core i5 868 25668 APMBAZOMJVP? 1,179.00
2.76Hz Intel Core i5 1668 12868 APMBPMF8391 1,399.00 :
2.7GHz Intel Core 15 868 75668 APMBPMF3A0LL 1,399.00 1.66Hz ntel Core 9 68 15668 APHBAVIVPILL 999.00
- . 1.66Hz Intel Core i5 868 12868 APMBAZOMVM? 929.00
2.76Hz Intel Core i5 868 12868 APMBPMFB3ILL 1,249.00 T i T T i
2.9GHz Intel Core 15 L 118 APMBPMF4T5 2,459.00 2.26Hz Intel Care i7 468 51268 APMBAZOMVP6 1,589.00
2.96Hz Intel Core i 868 118 APMBPMFA14 2,299.00 2.26Hz Intel Core i7 868 75668 APMBAZOMJVPS 1,279.00
2.9GHz Intel Core i 166B 51268 APMBPMF8411 1,939.99 9 26Hz Intel Core i7 4GB 95668 APMBAZOMJVP4 1,244.00
2.9GHz Intel Core i 868 51268 APMBPMF84TLL 1,699.00 2.2GHz Intel Core i7 868 12868 APMBAZOMJVM3 1,129.00
2.96Hz Intel Core i5 1668 25668 APMBPMF8403 1,678.00 2.26Hz Intel Core i7 46B 12668 APMBAZOMJVM1 1,029.00
2.96Hz Intel Core 5 1668 12868 APMBPMF8393 1,529.99
2.96Hz Intel Core i5 868 25668 APMBPMF8402 1,534.00 13.3”
Processor RAM Storage SKU Price
3.16Hz Intel Core i7 1668 118 APMBPMFB417 2,599.00 1.66Hz Intel Core i5 88 51268 APMBAZOMIVG3 1,594.00
3.1GHz Intel Core i7 868 118 APMBPMF8416 2,469.00 1.46Hz Intel Core i5 4GB 51268 APMBAZOMJVG1 1,474.00
3.16Hz Intel Core i7 1668 51268 APMBPMF8413 2,194.00 1.66Hz Intel Core 15 868 25668 APMBAZOMJVG? 1,249.00
3.16Hz Intel Core i7 868 51268 APMBPMF8412 1,939.00 1.66Hz Intel Core i5 46B 25668 APMBAMJVG2LL 1,099.00
3.16Hz Intel Core i7 1668 25668 APMBPMF8405 1,899.00 1.66Hz Intel Core i5 468 12868 APMBAZOMJVE! 1,094.00
3.16Hz Intel Core i7 1668 12668 APMBPMFB395 1,729.00 1.66Hz Intel Core ib 46B 12668 APMBAMJVEZLL 899.99
3.16Hz Intel Core i7 868 25668 APMBPMF8404 1,729.00
3.1GHz Intel Core i7 868 12868 APMBPMF8394 1,549.00 2.2GHz Intel Core i7 86B 51268 APMBAZOMJVG6 1,669.00
2.26Hz Intel Core i7 4GB 51268 APMBAZOMJVG7 1,649.00
2.26Hz Intel Core i7 46B 25668 APMBAZOMJVGS 1,399.00
, o 2.26Hz Intel Core 7 4GB 25668 APMBAZOMJVG4 1,329.00
The Apple MacBook Pro with 15.4” Retina Display 2.06Hz Intel Core 17 38 12068 APMBAZOMIVES 1,229.00
includes all of the options of the 1.3” with the 2.26Hz Intel Core i7 468 12868 APMBAZOMJVE2 1,109.00

following exceptions

» LED backlit IPS glossy finish

» 2880 x 1800 resolution

» 1600 MHz DDR3 RAM

» Intel Iris Pro or AMD Radeon R9 graphics

.’ Authorized Reseller MacBook
. With a Retina display and a thin,
CRERARALT AN W lightweight design, the Apple

= 12" MacBook provides both

15.4” portability and performance.
Processor RAM  Storage Graphics SKU Price Measuring just 0.5” (13.1 mm)
2.26Hz Intel Core i7 1668 118 Intel Iris Pro APMBPMJLOZ4 2,799.00 thin and weighing just 2 pounds,
2.26Hz Intel Core i7 1668 51268 Intel Iris Pro APMBPMJLOZ3 2,148.00 the MacBook is compact yet still
2.26Hz Intel Core i7 1668 25668 Intel Iris Pro APMBPMJLOZLL 1,999.00 has a premium feel, thanks to its
unibody design.
2.56Hz Intel Core i7 1668 118 Radeon R9 M370X APMBPMJLT22 2,759.00
2.56Hz Intel Core i7 1668 178 Intel Iris Pro APMBPMJLOZ6 2,799.00 » 2304 x1440 resolution » Backlit standard keyboard
256HzIntel Core 7 | 1668 | 51268 Radeon R9 M370X APMBPMILTZLL | 2,289.00 » USB-C port » Mac 0S X 1010 or 10.11
2.56Hz Intel Core i7 1668 51268 Intel Iris Pro APMBPMJLOZ5 2,199.00 » Flash storage » Intel Graphics 5300
2.56Hz Intel Core i7 1668 2566B Intel Iris Pro APMBPMJLO21 1,987.00 » 802.11ac Wi-Fi & Bluetooth 4.0
2.86Hz Intel Corei7 | 1668 | 1TB Radeon RY M370 APMBPMILTZG | 2,989.00 ETocesso RAM Storage Price
2.8GHz Intel Core i7 1668 118 Intel Iris Pro APMBPMJLO28 2,879.00 1.16Hz Intel Core M 86B 25668 $1,279.00
2.86Hz Intel Core i7 1668 51268 Radeon R M370X APMBPMILTZ3 2,499.00 1.3GHz Intel Core M 8GB 25668 $1,539.00
2.8GHz Intel Core i7 1668 51268 Intel Iris Pro APMBPMJLO27 2,479.00 1.2GHz Intel Core ib 86B 51268 $1,589.00
2.8GHz Intel Core i7 1668 25668 Intel Iris Pro APMBPMJLO22 2,099.00 1.3GHz Intel Core M 868 51268 $1,749.00

*Available in Gold, Silver or Space Gray



177 WINDOWS & GAMING NOTEBOOKS

I COMPUTERS

@ 17.3" Alienware 17 R3 Notebook
Engineered for high-performance gaming, is powered by a 2.6 GHz
Intel Core i7-6700HQ Quad-Core processor that allows you to run
multiple applications simultaneously.

» 17.3" Display » Full HD 1920 x 1080 Resolution

@ 17.3" Inspiron 17 5000

Versatile system that is powered by a Dual-Core processor,
allowing multiple applications to be run simultaneously. The CPU can be
overclocked to quickly access frequently-used files and programs.
» 17.3" LED Display » AMD Radeon R5 M335 GPU (4GB DDR3) =

» 9-in-1 Media Card Reader » 802.11ac Wi-Fi & Bluetooth 4.1 » 2185400 rpm Hard Drive » SuperMulti DVD Burner

» Built-in 2MP Webcam, Mic, and Speakers » Windows 10 Home (64-bit) » Built-in 720p Webcam, Mic, & Speakers » Windows 10 Home (64-bit)
RAM Storage Graphics SKU Price Processor RAM Storage Graphics Display SKU Price
1668 178 7.2k & 2566B SSD NVIDIA GeForce GTX 980M (468) DEAW7092S 1,899.00 2.5 GHz Intel Core i7-6500U | 1668 2TB 5.4k| AMD Radeon R5 M335 |1920 x 1080 Touchscreen| DEI57598835S | 990.55
166B |  1TB7.2k & 2566B SSD NVIDIA GeForce GTX 970M (36B) | DEAWA1755 1,599.00 2.3 GHz Intel Core 5-6200U] 86B | 178 5.4k| Intel HD Graphics 520 | 1600 x 900 Anti-Glare | DEINS4129B | 664.00
868 118 7.2k NVIDIA GeForce GTX 970M (368) DEAW1675S 1,349.99

I71Si 17.3" GE72 Apache Pro-070
Gaming Notebook Computer

» 2.6 GHz Intel Core i7-6700HQ (Skylake) » 16GB of 2133 MHz DDR4 RAM
» 17.3" Full HD Display » 1920 x 1080 Native Resolution
» SuperMulti DVD Burner / Card Reader » 802.11ac Wi-Fi, Bluetooth 4.0
» USB 3.1 Type-C and SteelSeries Keyboard » Windows 10 Home

/iSUS" 17.3” Republic of Gamers GL752VW
Gaming Notebook Computer

Comes built with a 17.3" display that is powered with a dedicated
NVIDIA GeForce GTX 960M graphics card with 4GB of VRAM

» 2.6 GHz Intel Core i7-6700HQ Quad-Core » 16GB of 2133 MHz DDR4 RAM

» 17.3" Full HD Display » 1920 x 1080 Native Resolution
» NVIDIA GeForce GTX 960M GPU (4GB GDDRS) » SuperMulti DVD Burner, 3-in-1 Card Slot

Storage Graphics SKU Price - .

178 7.2k & 12868 PCle S50 NVIDIA GeForce GTX 970M (36B) | MSGETZAPACKE |  1,498.98 7 802 VTac Wi-Fi Bluetooth 4.0 US8 3.0 Type-C Port, KOMI - Windows 10 Home

1TB 7.2k & 12868 M.2 SSD NVIDIA GeForce GTX 970M (368) MSGE72APACHE 1,498.98 Storage Graphics SKU Price

1787.2k & 12868 M.2 SSD NVIDIA GeForce GTK960M (268) | _ MSGET2APD29 1,299.99 178 7.2k & 12868 SSD. NVIDIA GeForce GTX 960M (468] | ASGLTS2VWD74 | Callor Log-on
1B 7.2 NVIDIA GeForce GTX 960M (268) MSGETZAPI03 1,399.00 118 7.2k | NVIDIA GeForce GTX 960M (46B) | ASGL7S2VWD71 | Callor Log-on

2Si 17.3” 6T72S Dominator Pro G-220 /iSUS’ 15.6” Republic of Gamers GL552VW
Gaming Notebook Computer Gaming Notebook Computer

Run multiple applications concurrently without slowing down the system. Comes built with a 15.6” IPS display that produces accurate colors and
SteelSeries Keyboard with illuminated keys, Killer Networking Manager. wide-viewing angles.

» 2.7 GHz Intel Core i7-6820HK (Skylake) » 17.3" Full HD Anti-Glare » 2.6 GHz Intel Core i7-6700HQ Quad-Core » 1668 of 2133 MHz DDR4 RAM

IPS Display » 1920 x 1080 Native Resolution 128GB PCle SSD + » 15.6” IPS Display » 1920 x 1080 Native Resolution

1787200 rpm HDD » Blu-ray Burner & SDXC Card Slot » NVIDIA GeForce GTX 960M GPU (4GB GDDRS) » SuperMulti DVD Burner, 3-in-1 Card Slot
» 802.11ac Wi-Fi, Bluetooth 4.1 » USB 3.1 Type-C and SteelSeries Keyboard » Windows 10 Home » 802.11ac Wi-Fi, Bluetooth 4.0 » USB 3.1 Type-C Port, HOMI » Windows 10 Home
Storage RAM Graphics SKU Price Storage Graphics SKU Price
178 7.2k & 25668 SSD 3208 NVIDIA GeForce GTX 980M GPU (868) | MS6T72SDP220 | 2,599.00 17B 7.2k & 12868 SSD | NVIDIA GeForce GTX 960M GPU (4GB GDDRS) | ASGL652VWD74 1,249.00
11B7.2k &1286BSSD | 1668 |  NVIDIA GeForce GTX 970M GPU (36B) | MSGT7250P219 | 2,199.00 178 7.2k | NVIDIA GeForce GTX 960M GPU (4GB GDDRE) | ASGLG52VWD71 | Call or Log-on

17.3” ENVY 17-s010nr

Multi-Touch Notebook Computer
The 17.3" ENVY 17-s010nr Multi-Touch Notebook from HP is a system that
provides desktop-like power and a large amount of screen real estate.

» 2.5 GHz Intel Core i7-6500U Dual-Core » 1268 of DDR3L RAM T
» 17.3"IPS Multi-Touch Display > Full HD 1920 x 1080 Native Resolution

aCer 17.3” Aspire E5-773

Notebook Computer

Equipped with a 17.3" display that has a native resolution of 1920 x 1080.
An integrated Intel HD 520 graphics chipset outputs HD visuals through
the HDMI port to your big screen.

» 17.3" LED-Backlit ComfyView Display » Full HD 1920 x 1080 Native Resolution

» NVIDIA GeForce 940M Graphics Card (26B) » 1TB 5400 rpm Hard Drive » Integrated Intel HD Graphics 520 » 17B 5400 rpm Hard Drive » SD Media Card Reader

» SuperMulti DVD Burner / Card Reader » 802.11ac Wi-Fi, Bluetooth 4.0 » 2x USB 3.0,2 x USB 2.0, HDMI » Windows 10 Home

» 802.11ac Wi-Fi & Bluetooth 4.0

» Built-in HD Webcam, Mic, & Speakers » Windows 10 Home (84-bit) Storage RAM CPU SKU Price
(HEE17S010NR) 1,129.00 178 b.4k 1268 2.5 GHz Intel Core i7-6500U ACEB7737415 856.99

lenowvo. 17.3" ldeaPad Y700

Gamer Notebook Computer

Designed as a weapon of choice for gamers who are on the go.

» 2.6 GHz Intel Core i7-6700HQ Quad-Core

» 17.3" IPS Anti-Glare Display » Full HD 1920 x 1080 Native Resolution
» NVIDIA GeForce GTX 960M Graphics (46B) » 25668 SSD

TOSHIBA 17.3” Satellite L75
Notebook Computer

» 868 of 1600 MHz DDR3L RAM » 17.3" TruBrite TFT Display
» HD+ 1600 x 900 Native Resolution » 1TB Hard Drive

» SuperMulti DVD Burner, Memory Card Slot

» Gigabit Ethernet & 802.11n Wi-Fi

» External BD/DVD Drive (USB 2.0) » BL!ilt—inWebcam,Mic, &.Speakers

» 802.11ac Wi-Fi & Bluetooth 4.0 » Built-in 720p Webcam, Mic, & Speakers > Windows 10 (64-bit) > Windows 10 Home (64-bit)
Storage RAM Graphics SKU Price
26668 53D 1668 NVIDIA GeForce 6TX 960M GPU (4GB) | LEY70080000E | 1,275.00 CPU Graphics SKU Price
66BSSD | 0GB |  NVIDIA GeForce GTX 960M GPU (46B) | LEY70080000G | 1,299.00 2.3 6Ha Intel Core 5-6200U Dual-Core Intel HD Graphics 520 TOL75C7136 694.00

800-947-3308 - 212-444-6691




MOBILE WORKSTATIONS  [e{e] | 1Va =138

Ienowo. ThinkPad W550s

Constructed from glass-fiber reinforced plastic, the ThinkPad W550s blends the
form factor of an Ultrabook with the pracessing power of a mabile workstation.
» 868 of 1600 MHz PC3-12800 DDR3L RAM

» NVIDIA Quadro K620M Graphics Card (26B) » 15.5” IPS Display

» USB 3.0 / mini-DisplayPort / VGA » Gigabit Ethernet & 802.11ac Wi-Fi

) ZBook 15u 63

» 15.6" TN SVA Anti-Glare Display
» Full HD 1920 x 1080 Screen Resolution
» AMD FirePro W4190M Graphics Card (26B)
» 802.11ac Wi-Fi & Bluetooth 4.2 LE
» Built-in 720p Webcam, Mic, & Speakers » Windows 7 Pro + Windows 10 Pro License

» Built-in 720p Webcam, Mic, & Speakers » Windows 7 Pro + Windows 8.1 Pro License CPU RAM Storage SKU PRICE
Storage Resolution SKU PRICE 15 6Hz ntel Core i7-65000 1668 BI2GBSSD | HEZBISVIHGAU |  1,726.46
25668 OpalZ SSD 2880 x 1620 LEWB50S20E21 1,726.75 2.5 GHz Intel Core i7-6500U 868 25668 SSD HEZB15V1H63U 1,439.99
50068 7.2k 1920 x 1080 LEW550520BUS 1,269.00

) 1Book 1563

Designed for mobile professionals who require a versatile system
with powerful processing and graphics, as well as simple scalability.
» 15.6" UWVA IPS Anti-Glare Display
» NVIDIA Quadro M1000M Graphics Card (26B)
» §02.11ac Wi-Fi & Bluetooth 4.2 » Thunderbolt 3 & USB 3.1 via USB Type-C » Windows 10 Pro

Ienowo. ThinkPad W541

Designed for professionals to create 30 models, edit videos, and more.

» 868 of 1600 MHz DDR3 RAM » 256GB SSD

» 15.5” LED-Backlit Display » 802.11ac Wi-Fi, Bluetooth 4.0

» Thunderbolt 2.0 and Card Reader » Built-in Webcam, Mic, & Speakers

» Windows 7 Professional (64-bit) *Free Upgrade To Windows 10 valid until 07/29/16 CPu RAM Storage Resolution __ SKU PRICE
2.8 GHz Intel Xeon E3-1505M vb Quad-Core |16GB| 512GB Z Turbo Drive PCle SSD | 3840 x 2160 | HEZBSG315E86 | 2,899.00
CPU Storage Graphics SKU PRICE 2.6 GHz Intel Core i7-6700HQ Quad-Core | 16GB| 5126B Z Turbo Drive PCle SSD | 3840 x 2160 | HEZBSG315E17 | 2,499.00
2.8 GHz Intel Core i7-4810MQ | 25668 SSD | NVIDIA Quadro K2100M Graphics (268) - 2880 x 1620 | LEPS020ENTEU | 2,219.76 2.6 GHz Intel Core i7-6700HQ Quad-Core | 8GB | 256GB 7 Turbo Drive PCle SSD | 1920 x 1080 | HEZBSG315E14 | 1,919.70

2.5 GHz Intel Core i7-4710MQ| 50068 | NVIDIA Quadro K1100M Graphics (26B) - 1920 x 1080 | LE54120EFO0H | 1,290.63

) 1Book 1562

Designed for mabile enthusiasts who require professional 3D
graphics and strong performance from demanding applications.
» 15.6” LED-Backlit SVA Anti-Glare Display » Full HD 1920 x 1080 Native
Resolution » Gigabit Ethernet & 802.11a/b/g/n Wi-Fi » Built-in 720p
Webcam, Mic, & Speakers » Windows 7 Pro + Windows 8.1 Pro License

Ienowo. ThinkPad P50

Suited for CAD and design workflows while you are on the road.
» 15.6” IPS Display with X-Rite Color

» SDXC & MMC Reader, ExpressCard 34 Slot

» 802.11ac Wi-Fi & Bluetooth 4.1

» USB 3.0/ Thunderbolt 3 / HDMI / Mini DP » Windows 7 Pro + Windows 10 Pro License ChUN RAM __Storage Graphics SKU PRICE

U RAN __Graphics stoage 50— paice R e ot LU [ i et i R

17 He e e -0 | WD Qiho MO ) 2565?];;}15\350 LEPSUOENTED | 221976 LS AL -0 | |15 N\é,gg\hiucgaggmgﬁ[]g]w] S D

28 Gz e oo E-5054 5| WO it M110 (468) 2568&35;%\880 LEPSOZIENTSD| 20%su06 T T P égghi[seléw[%u] e | 1o
. Gt el Lot 17670040 | gy | WVADIA Qualro MO (268) | 5ogg 72 |Lepsozoenoot | 1,419.88

) 1Book 1762

» 17.3" LED-Backlit Anti-Glare Display
» FullHD 1920 x 1080 Screen Resolution
» 802.11ac Wi-Fi & Bluetooth 4.0 » Built-in Webcam, Mic, & Speakers
» Windows 7 Pro & Windows 8.1 Pro License
CPU RAM Storage Graphics SKU PRICE
2.8 GHz Intel Core i7-4810MQ 1668 T8 7.2k NVIDIA Quadro K3100M

) LBook Studio 63

» 166B of 2133 MHz DDR4 RAM
» 15.6” UWVA IPS Anti-Glare Display
» NVIDIA Quadro M1000M Graphics Card (46B)
» 51268 Z Turbo Drive PCle SSD » 802.11ac Wi-Fi & Bluetooth 4.2

» Thunderbolt 3 + DP1.2 via USB 3.1 Type-C » Windows 7 Pro + Windows 10 Pro License Quad-Core Graphics Card (46B) HEZBTTGZKAA | 2,347.31
CPU Resolution SKU PRICE 2.5 GHz Intel Core i7-4710MQ 968 25668 Z Turbo Drive| - NVIDIA Quadro K2200M HEZB1762K4K2 | 1.850.00
2 GHz Intel Xeon Qued-Core 3040 x2160 HEZBSG315E86 2,899.00 LLETH0Le 1V s ] :
2.6 GHz Intel Xeon Quad-Core 38402160 HEZBSG315E17 2,249.00 L5 Gtz Intel Core I7-4710MO | gop | 477 94 AMD FirePro M6100 | uesaizeoin | 1,999.00
2.6 GHz Intel Core i7-6700H0 Quad-Core 1920 % 1080 HEZBSG315E16 2,019.99 (ad-Lore Graphics Card (268)
B @ Precision M3800
msi Wi72

» 2.3 GHz Intel Core i7-4712HQ Quad-Core » NVIDIA Quadro
K1100M Graphics (26B) » 15.6” UltraSharp LED-Backlit Touchscreen
» Mini DisplayPort / HDMI / USB 3.0 & 2.0 » Ethernet, 802.11ac Wi-Fi,
Bluetooth 4.0 » Built-in HD Webcam, Mic, & Speakers
» Windows 7 Pro + Windows 8.1 Pro License

» 2.6 GHz Intel Core i7-4720HQ (Haswell) » 1668 of 1600 MHz DDR3L RAM
» 118 7200 rpm HDD + 128GB mSATA SSD » 17.3" Full HD eDP Widescreen Display
» 1920 x 1080 Native Resolution » Blu-ray Disc Burner

» 802.11ac Wi-Fi, Bluetooth » SteelSeries Backlit Keyboard

» Windows 7 Professional *Free Upgrade To Windows 10 valid until 07/29/16

RAM Storage Resolution SKU PRICE
Graphics SKU PRICE 1668 51268 SSD 3820 x 2160 DEM38005901 2,676.27
NVIDIA Quadro K4100M GPU (4GB) MSWT72201246 3,199.99 1268 36068 SSD 3820 x 2160 DEM38005900 2,189.99
NVIDIA Quadro K2200M GPU (26B) \ MSWT7220M104 \ 2,199.99 86B 25668 SSD 1920 x 1080 DEM38005899 1,955.04

www.BandH.com




COMPUTERS

TABLET & LAPTOP CASES

TABLET COVERS

Case Survivor All-Terrain Hideaway Case Capture Ultra Rugged BlackBelt niiiid Case Defender Defender Voyager Case Rogue Case Multi-Grip Case
. Polycarbonate shell/ - Waterproof-Fully Synthetic Synthetic - "
Material Silicone frame Silicane Rubber Polycarbonate Polycarbonate submersible to 6.6 Rubber Rubber Silicone Polycarbonate Silicone
Screen Protector Yes Yes No No Yes Yes Yes No No No
. Black, Black, Orange, Glacier, Crushed Glacier, Black, Black,
Colors Available | gy o iy Blue, White, Red, Black Black Black. Aalanche | p.rncon, Black Black Pink Black, Red Red, Yellow
SKU GRSIPA2BB GUGHIPAOB INMRSF080BLK KEK97442WW LINCIPAZBK 0TDSCIPA26LC OTDCGTABNSBK PECT1030BKGY UAGSURF3RED XUIPMKCR
Price 44.89 69.95 66.50 59.99 116.99 80.95 62.96 54.95-74.12 64.95 29.95
Mailablefor | ipad,padfir2 | TROATZGABNOE |yt Gurtacey | MIOTOSOUSUTRCE oy pag g | Pl POAT Gala Tab 8D PaOATL o Suface | ipad min
Pro, Galaxy Tab Pro Pro &iPad mini's &9.7 iPad mini

TABLET PORTFOLIOS

PLYSWN |-

o ks LDk M | el | Pelian | Samawng | Samswg | Speok | Kms | Juma |

. — Bluetooth : :
Case TriCover Tablet K1 Cover jurni Hardback Case ProGear Vault Galaxy Tab S2 Keyboard Cover StyleFolio Folio Case Rotatable Case
Material Polyurethane Polyurethane Nylon Stainless Steel ABS pl.astlc Polyurethane Polyurethane Faux Leather Hardshell Hardshell
w/ watertight seal
Closure Folding Folding Zipper Snap Latches Latch Folding Folding Locking Clasp Magnetic Magnetic
. Black, Blue, Red,
Colors Available Black Black Black Black Black, Grey Black. Gold. W, Black Green, Grey, Pink, Bla_ck. Bla_ck.
Blue, Red . . White White
Floral Pink, Rattleskin
SKU ASTCZPSBBLK NVSTK1C MAKFJUTE PE1065C PEPVIPA2G SABCGTS297B SAKBCGTS2B SPSCIM123BSG XUIPAFB XUIPARB
Price 17.99 39.99 19.95 26.38 - 36.24 58.77-91.74 48.99 106.73 17.95 24.99 29.95
Available for | AsusZenPad S8.0 |  NVIDIA Shield Kindke Fire 7°-10" Tablets [fadiing} Galavy Tab 9.7 GalaryTab 97 | I G A 2, iPad mini, iPad Air iPad Air
iPad mini (alaxy Tab, Kindle Fire
SLEEVES

. Sling Sleeve Herringbone Ultra Thin Waterpoof Textured Neoprene
Case PLS Series Deluxe Neoprene Pro Sleeve SP12 Seom Sleeve Aramon NXT Gauntlet Pouch Sleeve
Material Neoprene Weather-Resistant | Weather-Resistant Neoprene Water-_Resistant Neoprene Neoprene Molded EVA Foam Waterproof Neoprene
Nylon Neoprene Herringbone
Interior Neoprene Plush, faux fur Cushioned Padded Padded Double Seamed Neoprene Foam Waterproof Padded
Closure Zipper Zipper Tipper Tipper Tipper Tipper Zipper Zipper Double Enclosure Tipper
Colors Available Black Black Black, Green Black Brown Black Black Black Transparent b 5
Blue, Pink, Red,
SKU CAPLS15B INCL60264 INCL60226 KESP12 RUHLTS13 RULPS13B SA433211041 THTAST13BLK XUIPWPC XUSNT12R
Price 16.13-15.93 44.00 27.09 29.95 14.99-19.99 10.95-12.99 24.99 49.00 14.95 9.95
. 16-17" " " " 8-15" 10-15" B B iPad & .
Available for Tablets & Laptops 13" MacBooks 15" MacBooks 12" Tablets Tablets & Laptops | Tablets & Laptops 15.6" Laptops 13" MacBooks Pad mini 10" Tablets

800-947-3308 - 212-444-6691



TABLET & LAPTOP CASES

COMPUTE

BACKPACKS

Laptop . U100 Red Series Ruby .
Case Backpack Jaunt Backpack City Backpack ICON Pack Urban Elite 33 Tech Backpack Xenon 2 ibex TXL617 XL
. Blended Denier Kodra .
Material Nylon Polyester Weave Polyester Nylon Nylon 900D Polyester Ballistic Polyester Nylon Nylon
Interior Nylon Padded Fleece Padded Plush Lined Hard shell case 150D Polyester Padded Airflow Padding Padded
Closure Lipper Lipper Lipper Lipper Lipper Lipper Lipper Lipper Lipper
Colors Available Black Black, Blue Black, White, Grey Black, White, Red Black Black with Red Black Blue Black
SKU CAVNB217 CAWMBP115AN INCL55452 INCL55b32 PEUT00BPB RUCBB3B SAX2BP SWA731606F00 TATXL617
Price 22.99 20.49 99.95 199.95 215.97 139.95 55.99 89.99 56.95

MESSENGER / SLING BAGS

e Glastw

. Laptop - The Eco Notebook Classic
Case Collins Sleeve Plus Messenger Bag Messenger Case | Quick Sling Bag Messenger Bag Sting Bag Xenon 2 Messenger Messenger Messenger Bag
Material Chambray Nylon Polyester Canvas Canvas Nylon Ballistic Nylon Polyester Fabric w/Polyurethane Nylon
Interior High-Density Foam | Brushed Poly lining Padded Padded Padded Padded Cotton Brushed Poly Lining Padded Nylon Polyurethane
Closure Metal Hook Neoprene Zipper Tipper Snap Clips Zipper Tipper Buckle and strap Zipper Tipper
Colors Available Indigo Blue Black Black, Grey Black, Grey Navy, Olive Black Black Black Black, Blue, Green Blaggn?g”grg;“e'
SKU BRCSPC CANM217 HEH1D25AA INCL60487 MOMECME9 RUSB13B SAXZMB TATCMO04US THM2B13MGR TICMBMB
Price 59.95 30.45 28.48 99.95 33.16 16.99 Call or Log-on 17.95 94.75 99.00

BRIEFCASE & SHOULDER BAGS

abhoSHLCOLams

Collins Laptop Checkpoint i Convertible Columbian .

B Slim Brief Attache Friendly Case A AR el Laptop Case LB Leather Case S
Material Chambray Nylon Nylon Nylon Hard Shell Watertight hard case | Ballistic nylon Ballistic nylon Leather Polyester
Interior Padded Padded Foam Padding Padded Molded EVA Molded-in Foam Insert] Padded Padded Padded Padded Tricot
Closure Metal Hook Tipper Tipper Tipper Tipper Easy Open Latch Tipper Tipper Buckles Tipper

Colors Available Indigo Black Black Black Black Black Black Black Brown Black

SKU BRCSC CAVNAZ16 GAGAVLTOF HEQ6282A 0YDLMBPC13 PE1070CC RULBB102 SAX2SB156 SA45798 SWM156CBG

Price 79.95 18.99 - 40.76 Call or Log-on 90.00 30.00 62.18 39.99 23.99 109.99 59.99

. Upto15.4" 107-18" upto 17" upto17" o " upto15.6" 157-17" upto 15.6” 16"

Available for Notebooks Notebooks Notebooks Notebooks 137157 MacBooks 133 Notebooks Notebooks Notebooks Notebooks




ALL-IN-ONE COMPUTERS

I COMPUTERS

’ P
o e @ iMac 5K
iMac now offers a stunning Retina 4K display on the 21.5-inch model
and an even more spectacular Retina 5K display on the 27-inch. And a
wider color gamut means a palette of up to 2b percent more available
colors. So photos and videos look crystal clear and vibrant, and text
is razor sharp.

, .  E— s

& iMac 27 e @ IMaC 25

» 27" Retina 5K IPS Display » 5120 x 2880 Native Resolution » 4.0 GHz Intel Core i7 (Skylake) » 21.5" Retina 4K IPS Display » 4096 x 2304 Screen Resolution » 3.3 GHz Intel Core i7 Quad-Core

» 3268 of 1867 MHz DDR3 RAM » 1TB Flash Storage » AMD Radeon R9 M395X GPU (4GB GDDR5) » 1668 of 1867 MHz LPPDR3 Onboard RAM » 512GB Flash Storage » Integrated Intel Iris Pro Graphics

» Thunderbolt 2 + USB 3.0 » Magic Keyboard & Magic Mouse 2 Included » Mac 0S X 10.11 EL Capitan » Thunderbolt 2 + USB 3.0 » Magic Keyboard & Magic Mouse 2 Included » Mac 0S X 10.11 EL Capitan

CPU Storage Graphics Memory SKU Price Processor Storage Memory Graphics SKU Price

4.0 GHz Intel Core i7 1TB Flash Radeon R9 M395 4GB 326B APIMMK48259 | 4,099.00 3.3 GHz Intel Core i7 51268 Flash 16GB Intel Iris Pro | APIMMK45219 2,399.00
4.0 GHz Intel Core i7 1TB Flash Radeon R9 M395 4GB 868 APIMMK48257 | 3,499.00 3.3 GHz Intel Core i7 218 Fusion 166B IntelIris Pro | APIMMK45217 2,199.00
4.0 GHz Intel Core i7 51268 Flash Radeon R9 M395 4GB 868 APIMMK48264 | 2,999.00 3.3 GHz Intel Core i7 1TB Fusion 16GB IntelIris Pro | APIMMK45216 1,999.00
4.0 GHz Intel Core i7 1TB Fusion Radeon R9 M390 26B 868 APIMMK4T218 | 2,299.00 3.1 GHz Intel Core i 1TB Fusion 166B Intel Iris Pro APIMMK4526 1,799.00
3.3 GHz Intel Core i 218 Fusion Radeon R9 M395 2GB 868 APIMMK482LLA | 2,189.00 3.1 GHz Intel Core i5 178 b.4k 16GB Intel Iris Pro APIMMK4521 1,699.00
3.2 GHz Intel Core ib 1TB Fusion Radeon R9 M390 26B 868 APIMMKATZLLA | 1,889.00 3.1 GHz Intel Core i 1TB Fusion 868 Intel Iris Pro APIMMK4522 1,599.00
3.2 GHz Intel Core i 1TB 7.2k Radeon R9 M380 2GB 868 APIMMK462LLA | 1,699.00 3.1 GHz Intel Core i 178 5.4k 868 Intel Iris Pro | APIMMK452LLA 1,399.00

MsSUsS 1240

Full HD resolution with the icicle gold ASUS 23.8” 2240 Multi-Touch All-in-One
Desktop Computer. With a 23.8” IPS display, 10-point touch support. features the Google Chrome 0S with built-in apps like Gmail, YouTube,

If you require a second monitor, you can output video via the two HDMI ports. Hangouts, and Dacs. This system also includes 10068 of free cloud storage
» 23.8” Touchscreen Display » 2.0MP Intel 3D RealSense Camera » 802.11ac ’ for 2-years, and 2-months of free Google Play Music ALl Access.

@ LG Chromebase

The LG Chromebase 21.5” All-in-One Desktop Computer

Wi-Fi, Bluetooth 4.0 » Wireless Keyboard & Mouse Included » Windows 10 Home » 1.4 GHz Intel Celeron 2955U Dual-Core " <

CPU Memory Graphics Resolution Storage SKU  Price » 26B 1600 MHz DDR3L Memory » 166B SSD » 21.5” IPS LED Display » 1920 x 1080 Resolution
2.8 GHz Intel Core i7-6700T | 16GB |GeForce GTX 960M 2GB| 3840 x 2160 |1TB .4k & 5125SD| ASZ240C2 | 1,899.99 » 8[]2.113/b/g/n Wi-Fi + Bluetooth 4.0 » Integrated Intel HD Graphics » Google Chrome 0S (64-bit)
L2 6t ntel Core 5-64007 | 868 [GeForoe GIX 950 168] 19701080 | 1Bk | ASTDCT | 99800y g0ty ... 349.99  BLACK (6220V2418) ... 1269.00

ATIVOne7

The 27" curved LED-backlit display brings content to
life with vibrant colors and a 178° wide viewing angle. 16:9 aspect ratio and
a Full HD 1920 x 1080 native resolution. The ATIV One features a sleek,
metallic deco frame and complimentary stand.
» 2.2 GHz Intel Core i5-5200U (Broadwell) » 8GB of 1600 MHz DDR3L RAM

lenowvo (2

The 19.5” display features a 1920 x 1080 screen resolution and a 16:9
aspect ratio. You can also output video to an external display via HDMI.
» 1.5 GHz AMD E1-7010 Dual-Core » 4GB of 1600 MHz DDR3 RAM

» 19.5” Full HD Display » 1920 x 1080 Screen Resolution

» Integrated AMD Radeon R2 Graphics » 50068 Hard Drive

» SuperMulti DV Burner » 802.11b/g/n Wi-Fi, Bluetooth 4.0 » 17B 5400 rpm Hard Drive > Intel HD Graphics 5500 » 27" Curved Anti-Reflective Display
» Wired Keyboard & Mouse Included » Windows 10 Home » 1920 x 1080 Resolution » 802.17ac Wi-Fi & Bluetooth 4.0 » Windows 10 Home (64-bit)
(LEET7010) 299.00 (SADP700A7K2) 1,197.99

@ Inspiron 24 3000

@ Inspiron 24 7000
The 24" Inspiron 24 3000 Multi-Touch AU-in-One Desktop Computer

The Dell Inspiran 24 7000 Series features multi-touch support and has a
from Dellis an all-in-one system designed for general use among families. 1920 x 1080 screen resolution and a 16:9 aspect ratio for Full HD content natively.
24" Full HD TrueLife IPS WVA multi-touch display has a native 1920 x 1080 » Multi-Touch Display » 1920 x 1080 Screen Resolution » Windows 10 Home

resolution, a 16:9 aspect ratio, and touchscreen capabilities. Windows 10 Home «ameessssssssssss @ > NVIDIA GeForce 940M GPU (4GB GDDR3) » 17B 5400 rpm HDD + 3268 SSD | == W=

» SuperMulti DVD Burner » 802.11n Wi-Fi + Bluetooth 4.0 » USB 3.0/ USB 2.0/ HOMI » Intel 30 RealSense Camera » 802.11b/g/n Wi-Fi, Bluetooth 4.0 » Wireless Keyboard & Mouse Incl.
CPU Memory Graphics Storage SKU Price CPU Memory Screen size SKU Price
2.2 GHz AMD AB-7410 868 Radeon R 1TB 5.4k DEI34E932758 |  669.99 2.6 GHz Intel Core i7-6700HQ 1668 138" DEI745970708 1,299.00
20GHzAMDA6-7310 | 46B |  RadeonR4 | 500GB5.A4k | DEI34656041B | 589.99 2.3 GHz Intel Core /5-6300H0 | 1268 | w | DE0007489 | 1,049.00

Pavilion 23-r110

The 23-r110 All-in-One Desktop from HP is an
all-in-one system designed for home environments,
including family entertainment and productivity.

» 2.96Hz Pentium Dual-Core » 4GB DDR3L 1600 Miz RAM v

Sprout Immersive
Located on the Sprout is the Sprout Illuminator, which is made up of
the HP DLP projector, the high-res. camera with up to 14.6 megapixel resolution,
and the Intel RealSense 3D camera for instant capture of 2 and 3D objects.
» Sprout Illuminator » 20" 20-Paint touch mat » 3.2 GHz Intel Core i7-
47905 Quad-Core » 8GB of 1600 MHz DDR3 RAM » 23" LED-Backlit

» 118 7200 rpm Hard Drive » Intel HD Graphics Touchscreen » NVIDIA GeForce GT 745A GPU (26B) » 178 SSHD +
» 237LED » 802.11b/g/n Wi-Fi » Windows 10 86B SSD Cache » 802.11a/b/g/n Wi-Fi & Bluetooth 4.0 » Windows 10 Home (64-bit)
(HEM9Z64AA) 519.00 (HEM9Z25AA) 1,599.00

“ 800-947-3308 - 212-444-6691



ntel) Mini PCNUC Kit

L./ The NUCSI7RYH Mini PC NUC Kit from Intel is a compact system

that fits in the palm of your hand and packs the performance of a Broadwell

dual-core Intel Core processor with integrated Intel HD Graphics. Room to hold a

2.5” hard drive or SSD as well as an mSATA drive connected to the M. slot.

» Ethernet Port » Mini-HDMI, Mini DisplayPort 802.11ac Wi-Fi, Bluetooth 4.0 » 4x USB 3.0 Ports

DESKTOPS [e{e] 4210y =23

/iSUS' Chromebox
Google Chrome 0S is a Linux-based operating system designed by Google to
work exclusively with web applications. The Chromebook combines the
aspects of a cloud client with the hardware of a portable computer.

» 166B SSD » Free 100GB on Google Drive for 2 Years

» 802.11a/b/g/n Wi-Fi, Bluetooth 4.0 » DisplayPort, HOMI, USB 3.0

CPU Graphics SKU Price Processor RAM SKU Price
3.1 GHz Intel Core 7-5557U | Intel HD Graphics 6100 INBOXNUCSITR 448.49 1.7 GHz Intel Core i3-4010U 468 ASCBMO75U 249.00
1.6 GHz Intel Core /552500 | Intel HD Graphics 6000 | INBOXNUCSISR | 367.39 1.4 GHz Intel Celeron 29550 | 268 \ ASCBMO04U \ 159.99

@ Inspiron 3050
Access your favarite, games, websites, and apps with the Dell Inspiron

3050 i3050-141BLK Micro Desktop Computer. This computer is roughly 5" by 5
and can fit on any desk with its small foatprint, and you can hold it with one hand
» 2.41 GHz Intel Celeron J1800 Dual-Core

» 268 of 1600 MHz DDR3L RAM » Intel HD Graphics » 326B M.2 Solid State Drive

» 3-in-1 Card Reader » 1x Gigabit Ethernet » 802.11ac Dual-Band Wi-Fi & Bluetoath 4.0
» 1 x DisplayPort & 1 x HOMI » 3xUSB 2.0 & 1x USB 3.0 » Windows 8.1 64-bit

(DEI3050)

199.99

fenowo. ThinkCentre M600

Stay productive without taking up too much space with the Lenovo ThinkCentre M600
Tiny Desktop Computer. Its smaller design provides more desk space. It has integrated
Intel HD Graphics and you can connect to an external display via DisplayPort.

» 1.6 GHz Intel Pentium N3700 Dual-Core

» 46B of DDR3LRAM » Integrated Intel HD Graphics » 500GB 7200rpm Hard Drive
» Ethernet Port » 802.11ac Wi-Fi, Bluetooth » DisplayPort, USB 3.0

» Lenovo Keyboard & Mouse Included » Windows 7 Professional (64-bit)

(LEM600106900)

309.99

Ienowo. ThinkCentre M73

Tiny Form Factor Desktop Computer from Lenovo features a smaller footprint.
» 2.0 GHz Intel Core i5-4590T Quad-Core » 4GB of 1600 MHz PC3-12800 DDR3 RAM

» Gigabit Ethernet, 802.11b/g/n Wi-Fi » DisplayPort, VGA » 2x USB 3.0, 3x USB 2.0
» USB Mouse and Keyboard Included » Windows 7 Pro + Windows 8 Pro License

@ Inspiron 3000 1384
Dell has outfitted this computer with Wi-Fi technologies so you can access
the Internet without the need for a cable. With Windows 10 Home preinstalled, you
get a start menu that features live tiles and quick access to your most-used programs.
» 83.2 GHz Intel Core ib-4460 Quad-Core » 12GB 1600MHz DDR3 RAM
» 2TB 7200rpm Hard Drive » Integrated Intel HD Graphics 4600
» SuperMulti DVD Burner » 802.11b/g/n Wi-Fi + Bluetooth 4.0 » 5.1 Audio, 8-in-1 Card Reader
» 2xUSB3.08&6xUSB 2.0 Ports » USB Wired Keyboard & Mouse Incl. » Windows 10 Home (64-bit)

(DEI30006934B) 699.00

@ Inspiron 3000 13647

This small form factor computer lets you run multiple everyday programs
such as spreadsheets, image editing, and more. Cortana is your personal virtual
digital assistant, which is integrated into Windows 10.

» 2.9 GHz Intel Core i5-4460S Quad-Cores » 8GB 1600 MHz DDR3 RAM

» 1B 7200rpm Hard Drives » Intel HD Graphics 4600s » SuperMulti DVD Burners
» 802.11b/g/n Wi-Fi + Bluetooth 4.0s » Integrated 5.1 Audio, 8-in-1 Card Readers

» 2xUSB3.0,5xUSB 2.0 Ports » Wired Keyboard & Mouse Includeds » Windows 10 Home[ﬁA bit)
539.00

(DEI36474618B)

@ XPS 8900 Minitower

Designed for system-intensive applications such as video editing, HD video

playback, intense multitasking, and extreme gaming. 3.4 GHz Intel Core i7-6700 Quad-Core

» SuperMulti DVD Burner » 10/100/1000 Mbps Gigabit Ethernet » 802.11b/g/n Wi-Fi,
Bluetooth » USB 3.0, HOMI, DisplayPort » Dell USB Keyboard & Mouse Included

Processor Storage Graphics Storage RAM Graphics SKU Price
2.0 GHz Intel Core i5-4590T | 180GB SSD Intel HD Graphics 4600 LEM73T10AY08 218 7.2k 2468 GeForce GTX 750Ti DEXPS8900625 1,499.99
2.0 GHz Intel Core i5-4590T | 50068 5.4k Intel HD Graphics 4600 LEM7310AY08C 499.99 218 7.2k 1668 GeForce GTX 745 DEXPS3131B Call or Log-on
3.0 GHz Intel Core i3-41507 | 50068 7.2k Intel HD Graphics 4400 LEM731082US 419.00 118 7.2k 1668 GeForce GTX 745 DEXB9002506B 884.99
/iSUS" VivoPC 280 61 Microtower

Only 2.2" tall, the silver VivaPC features an Intel Celeron processor and 4GB of
RAM to offer you the same performance of a desktop computer in a mini desktop
computer case. Supports up to 166B of RAM and can accommodate up to two
2.5" SSDs or hard drives.

» 1.4 GHz Intel Celeron 2957U (Haswell) » 4GB DDR3 Memory » 500GB Hard Drive » Intel HD Graphics
» 802.11ac Wi-Fi + Bluetooth 4.0 » 4x USB3.0/2x 2.0 Ports » HDMI / DisplayPort Ports

» Compact Form Factor at 2.2" High » Dual 2W Speakers » Keyboard & Mouse » Windows 8.1 (64-bit)

(ASVM425075V)

249.00

[i/ntel)' Compute Stick

Transform your display into a fully functional computer with the
ComputeStick STCKTA3ZWFC from Intel. This thumb drive PC offers the performance
similar to other computers and allows to stream online videos, play games, and more
» 1.33 GHz Intel Atom Z3735F Quad-Core » HDMIand USB 2.0 » Micro SDXC Memory Card Slot
» 802.11b/g/n Wi-Fi, Bluetooth 4.0 » Multi-channel Audio » Space-saving Design

RAM Storage Operating System SKU Price
268 3268 Windows 10 INBOXSTCKIAW 125.00
168 \ 868 | LinuxUbuntu [ INBOXSTCKIAS | 79.99

www.BandH.com

Provide computing power to perform everyday tasks. 3.7 GHz Intel Core i3-
4170 Dual-Core » 4GB of 1600 MHz PC3-12800 DDR3 RAM » Intel HD Graphics 4400
5006B 7200 rpm SATA I1l Hard Drive » SuperMulti DVD Burner » DVI-D & VGA
2xUSB3.0/6xUSB2.0 » USB Keyboard & Mouse Included » Windows 7 Pro + 10 Pro

Processor Graphics SKU Price

3.7 GHz Intel Core i3-4170 Intel HD Graphics 4400 HE28061POC87 399.37

3 GHz Intel Core i5-4590S Intel HD Graphics 4600 HE280G1P0CB8 449.99

3.3 GHz Intel Pentium 63260 Intel HD Graphics HE28061P0CB6 382.00

/iSUS' Chromebit

Measuring less than 5™ long and 2" wide, the Chromebit is a mabile computer
that connects to the HDMI port of virtually any display. Wil fit in your hand,
and is a lightweight, portable, and convenient personal computer.

» RockChip 3288-C Processor » 268 of LPDDR3L RAM » ARM Mali-T624 Quad-Core GPU

» 1668 eMMC Storage » 802.11ac Wi-Fi & Bluetooth 4.0 » 1x USB 2.0 Port/ 1 x HDMI Port -
» Supports 1080p Video Output » Less Than 5" Long and 2" Wide » Includes a Power Adapter

» Google Chrome 0S

(ASCBBO13C) 84.99
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” Authorized Mac Pro

Reseller yith a unified thermal core, Apple opted for a leaner, lighter,
and quieter structure that was more streamlined than earlier Mac Pro's. The unique
cylinder design stands just 9.9 inches tall with a diameter of just 6.6 inches, which
allows it to be a professional workstation that can actually sit on your desk.
» Six Thunderbolt 2 Ports » Four USB 3.0 Ports, One HOMI 1.4 Port
» Supports up to Three 4K Displays » 802.11a/b/g/nfac Wi-Fi, Bluetooth 4.0
» Unique Compact Cylinder Design » Mac 0S X 10.10 or 10.11 EL-Capitan

Processor Memory Storage Display SKU Price
2.7GH Intel Xeon Twelve-Core| ~ 64GB 1B AMD FirePro D700 x2 APMPMD87816 9,599.00
3.0GHZ Intel Xeon Eight-Core |  64GB 178 AMD FirePro D700 x2 APMPMDS87811 7,874.00
3.56HZ Intel Xeon Six-Core | 166B | 5126B | AMD FirePro D700 x2 APMPMD8785 4,599.00
3.56HZ Intel Xeon Six-Core | 326B | 5126B | AMD FirePro D500 x2 APMPMD8786 4,574.00
3.56HZ Intel Xeon Six-Core | 166B | 5126B | AMD FirePro D500 x2 APMPMDS781 4,174.00
3.56HZ Intel Xeon Six-Core | 166B | 2566B | AMD FirePro D500 x2 APMPMDS78LLA 3,699.00
3.7GHZ Intel Xeon Quad-Core |  166B | 5126B | AMD FirePro D300 x2 APMPME2532 3,099.00
3.7GHZ Intel Xeon Quad-Core | 126B | 256GB | AMD FirePro D300 x2 APMPME253LLA 2,799.00

@ Precision T1700 Mini Tower Workstation
Designed for the Creative Professional.

» 16x SuperMulti DVD Burner » 4xUSB3.0/6xUSB2.0/1xLAN
» USB Keyboard and Mouse Included » Windows 8.1

WORKSTATION COMPUTERS

) 1640 Rackable Minitower Workstation

» Slim SuperMulti DVD Burner » 8x USB 3.0/2xUSB 2.0/1x RJ-45
» Tool-Less Expandable Design » Windows 7 Pro + Windows 8.1 Pro License

Processor RAM Storage Graphics SKU Price
2.4 GHz Intel Xeon Six-Core | 1668 1TB 7.2k |No Graphic Card Installed| HEZ640F1M1U 2,347.48
2.4 GHz Intel Xeon Six-Core | 86B 118 7.2k NVIDIA Quadro K2200 | HEZ640F1IMB9U 2,499.00
2.4 GHz Intel Xeon Six-Core | 86B 118 7.2k AMD FirePro W5100 HEZ640LOP11 2,199.00

f 7230 Tower Workstation

Powerful performance in a tower form factor. With the capabilities to
operate in immersive work environments and handle workloads, the 2230 delivers
processor and graphics technologies in a compact yet expandable tower.

» Gigabit Ethernet » Windows 7 Pro + Windows 8.1 Pro License

Processor Storage Graphics
3.6 GHz Intel Xeon Quad-Core | 166B | 2.2TB NVIDIA Quadro K2200 | HEZ230FIM27U | 2,199.00
3.6 GHz Intel Xeon Quad-Core | 166B | 2566B SSD |  NVIDIA Quadro K2200 | HEZ230FIM26U |  1,999.00
3.6 GHz Intel Xeon Quad-Core | 166B | 25668 SSD | Intel HD Graphics 4600 | HEZ230F1M25U |  1,499.00
3.6 GHz Intel Core i7-4790 Quad-Core| 86B | 17B7.2k | Intel HD Graphics 4600 | HEZ240L9K19U 999.99
3.3 GHz Intel Core i5-4590 Quad-Core| 4GB | 17B7.2k | Intel HD Graphics 4600 | HEZ230F1M15U 979.00

f 1240 Small Form Factor Tower Workstation

tine:-o Lo S R oAl L » SuperMulti DVD Burner » Gigabit Ethernet » 4x USB 3.0 Ports & 6 x USB 2.0 Port

35 GHz Intel Xeon E3-1241 | 166B | 500GB7.2k | AMD FirePro W5100 DET17005455 1,451.01 » Windows 7 Pro -+ Windows 8.1 Pro License

3.3 GHz Intel Xeon Quad-Core| 1668 | 17B7.2k | NVIDIA Quadro K620 DET17005453 1,309.27

3.6 GHz Intel Core i7-4790 | 8GB | 1TB7.2k | NVIDIA Quadro K620 DET17005451 1,217.20 Processor RAM  Storage Graphics SKU Price

9.6 GHz Intel Core i7-4790 | 8GB 178 7.2k AMD FirePro W4100 DET17005452 1,120.00 3.5 GHz Intel Xeon Quad-Core | 16GB | 2566B SSD | ~ NVIDIA Quadro K620 | HEZ240LK917U | 1,483.56

3.3 6Hz Intel Core i5-4590 | 8GB | 500GB 7.2k |lntel HD Graphics 4600)  DET17005450 925.00 3.6 GHz Intel Core i7-4790 Quad-Core 8GB | 1TB7.2k | NVIDIAQuadroK420 | HEZ230KIL58U | 1,249.00
3.6 GHz Intel Core i7-4790 Quad-Core 8GB | 1TB7.2k | NVIDIAQuadroK620 | HEZ230FTMI7U | 1,121.99
3.3 GHz Intel Core i5-4590 Quad-Core| 86B | 1TB7.2k | Intel HD Graphics 4600 | HEZ240L9K15U |  799.00
3.6 GHz Intel Core i3-4160 Dual-Core | 4GB | 500GB 7.2k | Intel HD Graphics 4400 | HEZ230FIM16U |  799.00

@ Precision T1700 Small Form Factor

The Precision T1700 Small Form Factor Workstation is built with hardware
capabilities used for standard processing or specialized workloads, such as gaming
and 20/3D modeling. Powered by a quad-core 3.3 GHz processor, it lets you to render
3D models, edit videos, and more. Moreaver, 8GB of 1600 MHz DDR3 ECC RAM allows
it to quickly access frequently-used files and programs.

» Bx SuperMulti DVD Burner » 24 xUSB 3.0/ 6xUSB 2.0/ 1 x LAN
» USB Keyboard and Mouse Included » Windows 8.1

Processor RAM  Storage Graphics SKU
3.3 GHz Intel Xeon Quad-Core | 86B | 5006B 7.2k | Intel HD Graphics 4400 |  DET17005447 959.77
3.3 GHz Intel Core i5-4590 | 8GB | 5006B7.2k | NVIDIA Quadro K620 DET170029622 875.00

, 1440 Minitower Workstation

Powerful performance in a minitower form factor and is designed for
professionals who require high reliability. The 2440 is well suited for tasks such
as intensive graphics, 30 rendering, multimedia, and gaming.

» Slim SuperMulti DVD Writer » Gigabit Ethernet » Windows 7 Pro +
Windows 8.1 License > Free upgrade to Windows 10 until 7/29/16

Processor Storage Graphics

3.5 GHz Intel Xeon Quad-Core | 166B | 2566B SSD | NVIDIA Quadro K&4200 | HEZ440F1M46U 2,670.31
3.5 GHz Intel Xeon Six-Core | 1668 118 7.2k NVIDIA Quadro K2200 | HEZ440F1M44U 2,611.99
3.5 GHz Intel Xeon Quad-Core | 8GB 118 7.2k NVIDIA Quadro K2200 | HEZ440F1M45U 1,899.00
3.5 GHz Intel Xeon Quad-Core | 8GB 118 7.2k NVIDIA Quadro K620 | HEZ44OFTM5TU 1,699.00
3.5 GHz Intel Xeon Quad-Core | 8GB 1TB7.2k  |No Graphic Card Installed| HEZ440FTM42U 1,599.00
3.1 GHz Intel Xeon Quad-Core| 86B | 5006B 7.2k | NVIDIA Quadro K620 | HEZ44OFIMA4U 1,549.00

) 1840 Rackable Minitower Workstation

Extreme performance in a rackable minitower form factor. The 2840 is
designed for professionals who require high reliability and is well suited for tasks
such as intensive graphics, 3D rendering, multimedia, and gaming, as well as
science and engineering applications.

» SuperMulti DVD Burner » Dual Gigabit Ethernet

» 8xUSB 3.0 Ports & 2 x USB 2.0 Port » USB Keyboard & Mouse Included
» Windows 7 Pro + Windows 8.1 Pro License

Processor RAM  Storage Graphics SKU Price
2.4 GHz Intel Xeon Eight-Core | 166B | 17B7.2k | NVIDIA Quadro K4200 | HEZB4OKTPO7U |  3,949.00
2.4 GHz Intel Xeon Eight-Core 86B | 1TB7.2k |No Graphic Card Installed | HEZ840K7PO6U | 2,799.00
2.3 GHz Intel Xeon 10-Core 166B | 17B7.2k |No Graphic Card Installed | HEZ840K7POSU | 3,401.99
2.4 GHz Intel Xeon Six-Corex2 | 166B | 1TB 7.2k | No Graphic Card Installed | HEZ840K7PO9U |  3,499.00
2.4 GHz Intel Xeon E5-2620v3 6-Core| 8GB | 17TB7.2k | No Graphic Card Installed | HEZ840K7PT0U |  2,399.00

Ienowvo. Ki50e Tower Workstation

The K&50e Tower Workstation is a high-performance system with fast processing that
is designed for warking with intensive graphics, multimedia tasks, and gaming.

» 3.6 GHz Intel Core i7-4790 Quad-Core » 126B of 1600 MHz DDR3 RAM

» 178 7200 rpm HOD + 86B SSD Cache » NVIDIA GeForce GTX 760 (26B)

» HDMI, Dual Link DVI, VGA » SuperMulti DVD Burner » Gigabit Ethernet & 802.11ac Wi-Fi
» 7.1 Channel Audio » USB Keyboard & Mouse Included » Windows 7 Pro + Windows 8.1 License
(LEK450E57818) Call or Log-on

800-947-3308 - 212-444-6691
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(@) CYBERPOWERFC

CyberpowerPC Gamer Supreme
» DVI/ HDMI / DisplayPort » 24x Dual-Layer Super-Multi Drive » 7.1 Surround Sound Audio
» Gigabit Ethernet » USB Keyboard & Mouse Included » Windows 10 Home (64-bit)

Cyberpower PC Gamer Xtreme
» Al components are housed in a black and red X-Saber 520 mid-tower case with a 600W power supply.
» DVI/ HOMI / DisplayPort » Gigabit Ethernet » USB Keyboard & Mouse Included » Windows 10 Home

884

448

L
Model $LC9000 SLC8000 SLC8800 SLC8400 SLC8600 Model GXi840 GXi820 GXi810 G6XiB00
CPU 3.56Hz Intel Core |4.0 GHz Intel Core i7-| 3.3 GHz Intel Core |40 GHz Intel Core i7-14.7 GHz AMD FX-9590 cPU 3.7 GHz Intel Core 3.4 GHz Intel Core 3.3 GHz Intel Core 3.2 GHz Intel Core
Six-Core 6700K Quad-Core | i7-5820K Six-Core | 6700K Quad-Core Eight-Core i3-6100 i7-6700 i5-6600 i5-6500
Memory 1668 DDR4 166B DDR4 1668 DDR4 1668 DDR4 16GB DDR4 Memory 8GB DDR4 1668 DDR4 8GB DDR4 8GB DDR4
Storage 2.77B 2178 2118 2178 2178 Storage 118 718 718 118
Graphics AMD Radeon R9 390 | AMD Radeon R9 | NVIDIA GeForce GTX |  NVIDIA GeForce AMD Radeon RY Graphics NVIDIA GeForce GT 730 AMD Radeon RY NVIDIA GeForce GTX AMD Radeon R7
(868) 390 (86B) 960 (46B) 67X 960 (468) 380 (46B) GPU (26B) 380 GPU 950 GPU (26B) 370 GPU (26B)
SKU CYSLC9000 CYSLCB000 CYSLCB800 CYSLCBA00 CYSLCBA00 SKU CYGXIB40 CYGXI820 CYGXI810 CYGXI800
Price 1,869.99 1,539.00 1,484.00 1,399.00 1,267.84 Price 609.00 1,229.00 949.00 869.00

CyberpowerPC Gamer Ultra
The Gamer Ultra Gaming Desktop Computer from CyberpowerPC is a high-performance desktop computer designed to meet the stringent standards of PC gamers.
» DVI/ HDMI/ DisplayPort » 24x Dual-Layer Super-Multi Drive » 7.1 Surround Sound Audio » Gigabit Ethernet » USB Keyboard & Mouse Included » Windows 10 Home (64-bit)

4908488848

Model GUAS570 GUAS550 GUA560 GUA530 GUA540 GUA520 GUA510
CcPU 3.5 GHz AMD Vishera FX-8320 | 3.5 GHz AMD Vishera FX-6300 | 3.5 GHz AMD Vishera FX-8320 | 3.8 GHz AMD Vishera FX-4300 | 3.5 GHz AMD Vishera FX-6300 | 3.8 GHz AMD Vishera FX-4300 | 3.8 GHz AMD Vishera FX-4300
Eight-Core Six-Core Eight-Core Quad-Core Six-Core Quad-Core Quad-Core
Memory 16GB DDR3 166B DDR3 86B DDR3 86B DDR3 86B DDR3 86B DDR3 86B DDR3
Storage Jal:} 18 178 178 178 178 178
Graphics NVIDIA GeForce GTX 960 NVIDIA GeForce GTX 950 NVIDIA GeForce GTX 950 AMD Radeon R7 360 AMD Radeon R5 230 NVIDIA GeForce GT 730 AMD Radeon R5 230
6PU (26B) GPU (26B) 6PU (26B) GPU (268) GPU (16B) GPU (26B) GPU (16B)
SKU CYGUAG70 CYGUAB50 CYGUAB60 CYGUAB30 CYGUAB4D CYGUAB20 CYGUABT0
Price 876.90 779.00 714.00 589.00 529.00 518.95 488.99
/iSUS 611CD /iSUS ROG

Designed for casual gamers who want a balance between high performance and ease of

use. With its futuristic outer space-inspired design with Mayan-inspired elements.

» 3.4 GHz Intel Core i7-6700 CPU » 16GB of 2133 MHz DDR4 RAM > 2TB 7200 rpm
SSHD + 25668 SSD » Blu-ray Disc Combo Drive » 802.11ac Wi-Fi, Bluetooth 4.0

» USB 3.1, USB 3.0, HDMI » USB Keyboard & Mouse Included » Windows 10 Home (64-bit)

Graphics Storage Display
NVIDIA GeForce GTX 980 GPU (4GB GDDRS) ASG11CDUS08T 1,699.00
NVIDIA GeForce GTX 970 GPU (4GB GDDRS) ASG11CDUSO7T 1,399.00
NVIDIA GeForce GTX 960 GPU (26B GDDRS) ASG11CDUS08T 999.00

The ROG Gaming Desktop Computer from ASUS is a small form factor system that is
designed for those who require reliability and high performance.

» HOMI/ DisplayPort / DVI-I / DVI-D » Slim Tray SuperMulti DVD Burner

» Gigabit Ethernet & 802.11ac Wi-Fi » 12.5-Liter Case » Windows 8.1

» USB Keyboard & Mouse Include

» Free upgrade to Windows 10 until 7/29/16

Processor Memory Storage Display SKU Price
3.6 GHz Intel Core i7-4790] 868 | 1TB 7.2k +B6B SSD| NVIDIA GeForce GTX 760 (268) |AS620AJUS009| Log-on
3.5 GHz Intel Core i3-4150] 868 | 1TB7.2k | NVIDIA GeForce GTX 745 (46B) |ASG20AJUS006| Log-on

@ Alienware Area-51R2
Designed to meet the high standards of PC gamers, features liquid cooling
for keeping temperatures down during graphics-intensive gaming.
» 3.3 GHz Intel Core i7-5820K 6-Core » 16GB of 2133 MHz DDR4 RAM
» NVIDIA GeForce GTX 970 GPU (4GB GDDRS) » 2TB 7200rpm HOD + 12868 SSD
» Slot-Loading SuperMulti DVD Burner » 802.11ac Wi-Fi, Bluetooth 4.0
» Alienware Multimedia Keyboard & Mouse » Windows 10 Home (64-bit)

(DE5TR217665) 2,108.99

ENVY Phoenix Desktop

Designed with a brushed metal finish and customizable lights, a powerful
system that has been designed for gamers who require fast processing.
» 3.4 GHz Intel Core i7-6700 Quad-Core » 16GB of 2133 MHz DDR4 RAM
» NVIDIA GeForce 6TX 960 Graphics (26B) » 128GB SATA SSD & 2TB 7200 rpm SATA HDD
» SuperMulti DVD Burner » 802.11ac Wi-Fi & Bluetooth 4.0 » USB 3.0/USB 2.0/
HOMI/ Card Reader » USB Keyboard & Mouse Included » Windows 10 Home (64-bit)
(HEEP860010)

www.BandH.com

@ Alienware X51R3
Designed for gamers, features a matte stealth black finish and dark chrome

accents. The system features a dedicated NVIDIA GeForce GTX 745 graphics card with 4GB

of DDR3 discrete memory, which provides high-res graphics for your PC games.

» 2.6 GHz Intel Core i7-6700HQ Quad-Core » 8GB of 2133 MHz DDR4 RAM » 1TB 7200 rpm
Hard Drive » SuperMulti DVD Burner » 10/100/1000 Mbps Gigabit Ethernet » HDMI,
SPDIF, USB 3.0 » Alienware Multimedia Keyboard & Mouse » Windows 10 Home (64-bit)

(DE5TR33011BK) 964.19

GIGABYTE" Brix Gaming Ultra Compact PC Kit

The Ultra Compact PC Kit from Gigabyte is a barebones kit that gives you the

flexibility to choose which aperating software and storage drive as well as

how much RAM memory to install into your ultra compact computer.

» 2.5 GHz Intel Core i7-4710HQ Quad-Core » 2 x SO-DIMM Sockets (Max 16GB)

» NVIDIA GeForce GTX 760 Graphics » Supports 2.5 SATA Drive » mSATA Slot » 2 x Mini HDMI Ports

» 4xUSB 3.0 Ports » Wi-Fi 802.11a/b/g/n/ac & Bluetooth 4.0 » VESA Bracket and Screws Included
(GIBBXI763760) 849.99




(oo] Va7 USB FLASH DRIVES
Cruzer Blade Cruzer Glide CZ43 Ultra Fit Ultra Ultra Dual Ultra Flair Extreme Extreme Pro
D A ) B N ) B c——
USB 2.0 UsB 2.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0
Retractable USB Connector Cap Design Capless USB Slider Design | USB Type-A and Micro-USB Capless USB Slider Design | Capless USB Slider Design
8GB (SACBSGBB).. 86B (SACCZ608GB)........... 4.49 | 166B (SACZ43166B) 166B (SAUUD16GB) .9.25 | 12868 (SADD31266B) ..38.59 | 16GB (SAUFU3FD16GB)...... 7.99 | 16GB (SACCZ680166B) ... 16.95 | 128 GB (SACCZ8812868)......63.98

16GB (SACB166BB]

326B (SACCZ60326B)....... 8.99
646B (SACCZ60646B)......17.48

3268 (SACZ433268)
646 (SACZ43646B)....... 17.95
1286 (SACZ431286B)....34.95

326B (SAUUD3ZGB)........ 11.95
646B (SAUUD64GB)........ 19.95
1286B (SAUUD1286B) .....33.95

25668 (SAUUD2566B).....78.95

646B (SADD3446BB)....... 19.95
326B (SADD33268)......... 12.95

326B (SAUFU3FD326B)...11.95
646B (SAUFU3FD64GB)...21.95
1286B (SAUFU3FD1266).. 34.95

326B (SACCZ680326B)....21.95
646 (SACCZ680646B).... 32.95

Kingston Personal Drives

Kingston Encrypted Drives

DataTraveler DataTraveler DataTraveler DataTraveler DataTraveler DataTraveler DataTraveler DataTraveler

micro 1G4 100 G3 SE9 62 microDuo micro 3.1 Vault Privacy 4000 62

N Bl N =D e
USB 2.0 USB 3.0 USB 3.0 USB 3.0 USB 3.0/USB micro USB 3.1 USB 3.0 USB 3.0
. ) Capless USB " . . ’ f Titanium-Coated
Protection Cap Protection Cap Slider Design Capless Design Rotating Cap Metal Casing 266-Bit Advanced Encryption Stainless Steel Casing
Ultra-Compact Durable ! : "
Form Factor Metal Casing Complex Password Protection | FIPS Validated Security

8GB (KIDTMCKSGB).......... 4.50
16GB (KIDTMCK16GB) ...... 5.95
64GB (KIDTMCK64GB) .... 19.99

8GB (KIDTIGASGB)....
166B (KIDTIGA16GB).......
3268 (KIDTIG432GB)......... 9.95
6468 (KIDTIG4646B)....... 17.33

12868 (KIDTIG41286B)......37.95

8B (KIDT100636GB)........ 4.84
16GB (KIDT10063166)....... 5.49
326B (KIDT10063326).....12.50
646B (KIDT10063646)..... 18.50
1286B (KIDT10063128) ... 33.95

8GB (KIDTSEIG28G) ........ 5.35
16GB (KIDTSEIG2166)....... 6.45
3268 (KIDTSE962326).....10.75
646B (KIDTSE962646).....18.95

12868 (KIDTSE962128)...36.95

16GB (KIDTDUO3146B) ... 7.53
326B (KIDTDU03326B)....11.95
646B (KIDTDU03646B)....19.95

16GB (KIDTMC316GB)....... 7.95
326B (KIDTMC3326B) .....13.50
646B (KIDTMC3646B) .....19.95

4GB (KIDTVP3046B)........22.95
8GB (KIDTVP3086B)........ 29.95
326B (KIDTVP30326B) ... 79.95
646B (KIDTVP30646B) .153.95

4GB (KID4000G246B)....... 34.80
8B (KID40006286B).......42.67
166B (KID400062166).....72.00
326B (KID400062326)...108.00
64GB (KID400062646)...174.00

oY I R R
Turbo 3.0 Attaché Duo Link JetFlash 820 JetFlash 810 JetFlash 790 USB 2.0 Flash Drive Store " Go V3
\.
USB 3.0 USB 2.0 USB 3.1 USB 3.0 USB 3.0 USB 3.0 USB 2.0 USB 3.0
Sliding Collar Sliding Collar Removable Cap Removable Cap Capless Desrjgpt/ Stide-Out Capless Slider Design Retractable USB Connector
p Shock/Splash/ Availabe in Also available in Also available in 3-pack kits
AUl Moisture/Dust-Resi Black or White 3-pack kits and different colors
16GB (PNT16GB).............. 9.99 | 16GB (PNA14GB).............. 7.75 | 32GB (PNDL310T6326)....24.99 | BGB (TRJF820G8GH).......... 6.99 | 8GB (TRJF8108GB) .......... 8.99 | BGB (TRJF7908GB)........... 6.99 | 2GB (VEUDZGB)............... 6.66 | BGB (VEISNGEGBB).......... 7.99

326B (PNT3268)...

326B (PNA326B). 1295

64GB (PNDL310TG44G).... 34.99

16GB (TRJF82061668)...... 9.99

16GB (TRJFBIO14GB)........ 7.99

16GB (TRJF790166BW)...... 8.99

4GB (VEUD4GB)...

16GB (VE3SNG16GBBL...... 9.97

64GB (PNT64GB).. 646B (PNAGAGB...........23.95 326B (TRJF82063268).... 15.99 | 32GB (TRIF8103268) ... 12.99 | 32GB (TRIF790326B)....... 9.99 | 8GB (VEUDSGB).. 326B (VE3SNG326BB).....12.99
128GB (PNA128GB) ......35.00 04GB (TRJF82066468)....29.99 | 64GB (TRIFB10646B)..... 20.99 | 64GB (TRIF790646BW)...15.99 | 16GB (VEUD16GB).... 64GB (VE3SNG4GBB)..... 23.92
128GB (TRJF79012668)...29.95 | 326B (VEUD32GB).........10.26 | 128GB (VE3SNG1286BB).. 44.50
6468 (VEUFD64GBBL) ... 16.99
Lexar
JumpDrive S75 JumpDrive P20 JumpDrive M20i JumpDrive M20c Blaze B30 Firma F80 PetiteKey RuggedKey
. ] ; g
w0 e ") D e O
v L N
USB 3.0 USB 3.0 USB 3.0/ Lightning USB Type-C USB 3.0 USB 2.0 USB 2.0 USB 3.0
Retractable Metal alloy base Retractable Retractable Four-Way Positioning Zinc Alloy Waterproof Wuala Secure
Connector with mirror finish Connector Connector Rotating Cover Material t0 328" Cloud Storage
1668 (LELIDS75166B)........8.95 | 326B (LELJDP2032GB).....24.77 | 166B (LEJOM20I16GB)......24.99 | 166B (LEJOM20C1EGH)....... 9.99 | 3268 (SIUFDB3032GB)......9.89 | 166B (SIUFDF016B)...... 6.82 | BGB (LAPKS)...Call or Log-on | 16GB (LARKUSB316)......24.99
326B (LELIDS75326B) ... 11.95 | 64GB (LELIDP20446B) ... 37.68 | 32GB (LEJOM201326B).... 34.99 | 32GB (LEJOM20C326B)... 14.99 | 64GB (SIUFDB3064GB) ... 16.82 | 32GB (SIUFDF80326B) ... 10.95 | 16GB (LAPKIG).............. 14.99 | 32GB (LARKUSB332)......44.99
64GB (LELIDST564GB)....... 19.95 | 128GB (LELIDP201266).....59.99 | 64GB (LEJOM20164GB)....49.99 | 64GB (LEJOM20C64GB)... 24.99 64GB (SIUFDF8064GB) ... 18.95 | 32GB (LAPK32)Call or Log-on | 64GB (LARKUSB364).....74.99
12868 (LELIDST5128)....... 32.95

75668 (LELIDST5256) .....69.00

800-947-3308 - 212-444-6691



CZ Elements

Portable Hard Drive

» USB 3.0 Interface

» Up to 5 Gb/s Data Transfer Speed

» Formatted for Windows 8, 7, Vista & XP
» Use with Mac Requires Reformatting

500GB (WEWDBUZG5000) 59.99

178 (WEWDBUZG0010) 54.99

278 (WEWDBUSY00ZE) 84.99
G-DRIVE

s« MObile Portable Hard Drive

» Time Machine Compatible

» Reformat for Windows

» Bus Powered

» Includes USB 3.0 Cable

» Transfer Rates up to 136MB/sec
» USB 3.0 Interface and USB 2.0 Compatible
» Mac Format HFS+ with Journaling

1TB 5,400 RPM (6TGDMU31) 89.95
1TB 7,200 RPM (6T6DMU3172) 99.95

TOSHIBA Canvio Connect |

Portable Hard Drive

» USB 3.0 Interface » 5400 RPM

» § MB Cache Buffer

» Easy-to-Use Backup Software

» Secure Backup with Password

» Automatic Backup

» Available in Black, White, Silver,
Gold, Red, Blue

500GB (TOHDTCB05XK3) ...47.99

1TB (TOHDTCB10XK3)....... 54.99

2TB (TOHDTC820XW3) ......99.99
3TB (TOHDTC830XR3)..... 120.69

@3 Rugged Thunderbolt
Portable External HD

» One USB 3.0 Part, 5400 rpm
» Shock, Dust, Water Resistant
» One Integrated Thunderbolt Cable

2506B SSD (LATU3250) 279.99
5006B SSD (LATU3500) 499.99
1TB (LARTUT) 179.99
2B (LARTU2) 249.99

&) transcend” StoreJet 25M3
Anti-Shock External HD

» USB 3.0

» Backup Software

» One-Touch Auto-Backup .
» Up to 5Gbps Data Transfers @
» USB 2.0 Backwards-Compatible

» Durable Anti-Shock Rubber Casing

» Meets U.S. Military Drop Test Standards

1TB (TRSJ25M31) 59.99
2TB (TRTS21SJ25M3) 102.99

www.BandH.com

PORTABLE HARD DRIVES

EZ1 My Passport
Ultra Portable HD

» Bus Powered, USB 3.0 Interface
» 256-bit AES Hardware Encryption
» Local and Cloud Backup

» Windows 8 Compatible

» Data Transfer Rates up to bGb/s
» Available in Black, Berry, White or Blue

0000

1TB (WEMPU1B0) 59.00

2TB (WEMPUZBQ) 99.00

3TB (WEMPU3B) 129.00
G-DRIVE

<o MObile Hard Drive with Thunderbolt

» Transfer Rates up to 136MB/s
» Bus Powered via Thunderbolt/USB e
» 7200rpm Speed g
» Time Machine Compatible
» USB 3.0 and Thunderbolt

Cables Included
» Preformatted HFS+ for Mac
» Can be Reformatted for Windows
17B (6T0603040)

189.95

seagate(C) Backup Plus Slim
Portable External USB HD

» USB 3.0 Port

» 5400rpm Disk Speed

» Pre-Loaded NTFS Driver for Mac

» Seagate Dashboard for Automatic Backup
» Max. Sustained Read/Write Speed: 100MB/s

» Use on Windows, Mac Without Reformatting

» Available in Black, Silver, Red, Blue

1TB (SESTDR1000B) 59.00
2TB (SESTDR20001B) 89.00

@3> Rugged Mini
Mini Portable Hard Drive

» USB 3.0 Interface

» Transfer Rate Up to 56b/s

» 47.2" Maximum Drop Height
» LaCie Private-Public Seftware
» Automatic Backup

1TB (LARMNU31) 99.99
2TB (LARMD2) 139.99
3TB (LARMDA) 229.99

‘HGST TouroS ultra-
Portable External HD

» USB 3.0 Interface

» 7200 rpm Rotational Speed

» Up to 56b/s Data Transfer Rate

» Preformatted NTFS for Windows

» Windows / Mac Compatible

» In Platinum, Silver, Gold and Ruby

5006B (H6TS5008) 61.99
1TB (H6TSTP) 66.71

COMPUTERS

© G-DRIVE 61 Portable Hard Drive

camse With Gobbler Software

» Data Transfer Rate up to 165MB/s

» 7200 rpm » USB 3.0 Port ‘

» Apple Time Machine ;
Compatible

» Aluminum Enclosure

» Preformatted HFS+ for Mac

» Windows & Mac Compatible

2TB (6T0604013) ........ 159.95
3TB (6T0603934) 179.95

4TB (6T0603935)........ 199.95
349.95

61B (6T0604014)

© G-DRIVE RaW portable Hard Drive
s With Rugged Bumper
» USB 3.0 and SATA Interfaces

» 7200 rpm

» Shock Resistant up to 4.9/ 1.5m
» USB 3.0 Transfer Speeds up to 56b/s
» Rugged and Lightweight

» Includes a Removable Bumper

» Formatted for Mac  » Windows and Mac Compatible

500GB (6TGDEVRAWS00) 89.95
1TB (GTGDEVRAW1) 109.95

seagate(C" Expansion

Portable Hard Drive

» SuperSpeed USB 3.0 Port

» Backwards Compatible
with USB 2.0

» USB 3.0 Cable

1TB (SESTEA100040)
2TB (SESTEA200040)
3TB (SESTEA300040)
4TB (SESTEA400040)

@3 Rugged Triple Interface
Portable Hard Drive

» AES 256-Bit Encryption

» USB 3.0 & FireWire 800 Ports

» Works with FireWire 400 &
USB 2.0

» Max Data Transfer Rate of Up to 80MB/s

» AES 256-Bit Encryption

500GB (LART5007) 109.99
1TB (LARTY) 139.99
2TB (LART2)

< Portable SSD T3

External HD

» USB 3.1

» 450MBs Data Transfer Speed
» Internal Solid-State Drive

» USB 3.0 Interface » AES 256-Bit EncryptionZ

250GB (SAMUPT2508AM) 99.99
500GB (SAMUPT500BAM) 179.99
1TB (SAMUPTITOBAM) 379.99
2TB (SAMUPT2TOBAM) 779.99




COMPUTERS

CZ) Elements
External Desktop HDD

» USB 3.0/ USB 2.0 Interface

» Up to 56b/s Data Transfer Rate

» Plug-and-Play Compatible

» Reformat Required for Use
with Mac 0S X

2TB (WEWDBFJK0020)........ 99.00
3TB (WEBWLG0030HB) ... 104.99

4TB (WEWDBWLG0040)......159.00
5TB (WEWDBWLG0050)......179.00

=] My Book Studio
Studio Desktop HDD

» USB 3.0/ USB 2.0 Interface

» Up to 56b/s Data Transfer Rate

» Pre-Formatted Mac 0S X 10.6.5 or Later
» Requires Reformatting for Windows 0S
» Password Protection ==

» WD Drive Utilities
3TB (WEWDBHMLOO30) ... 119,00
4TB (WEWDBHMLOOAD) ..o . 159.00

@ other World computing Mercyry Elite Pro
External Desktop HD

» SATA Drive Interface

» 1 x eSATA Port

» 1xUSB 3.0/ 2 x FireWire 800 Ports
» Up to 300 MB/s Data Transfer Rate
» 7200 rpm Rotational Speed

» 64MB Cache Memory

2TB (OWMEALD)............ 173.00
3TB (OWMEAL3)............ 195.00

4TB (OWMEALL)............ 249.00
5TB (OWMEPS)............. 275.00

@3 d2Quadra
Desktop Hard Drive

» External Drive with 3TB Capacity

» USB 3.0/ FireWire 800 / eSATA Ports

» Up to 130MB/s Data Transfers via USB 3.0

» Supports FireWire Daisy-Chaining

» Simple, User-Friendly Backup Software

» Stackable and Rack-Mountable

» Heat-Sink and Eco Power-Management Mode
3TB (LAD2QHD3V3)
5TB (LAD20V35)

External Drive

» 7200 rpm Disk Speed
» Disk Healt_h Monitoring i
» Auto-Sensing Power Input 0 --—-—-—-

» Quiet Intelligent Cooling Fan
» Read/Write Speeds up to 184MB/s
» USB 3.0, FireWire 800 and eSATA Ports

1TB (6LS1000)................. 149.00
2TB (6L52000) ................199.95  4TB (GLS4000) ............... 299.95
3TB (6L53000)................229.00  5TB (GLS5000) .............. 369.00

DESKTOP HARD DRIVES

CZ1 My Book

External Hard Drive for Mac
» USB 3.0 Connectivity

» Time Machine Compatible

» Preformatted in HFS+Journaled for Mac
» WD Security

» WD Drive Utilities

» Windows Compatible (Requires Reformat)

2TB (WEWDBYCC0020)........99.00  4TB (WEWDBYCC0040).......129.00
3TB (WEWDBYCC0030) ......109.00  6TB (WEWDBYCCO06D) ... 199.00

seagate(C" Expansion
External Desktop USB 3.0 HD
» USB 3.0
» Up to 56b/s Data Transfer Rate
» Pre-Formatted Mac 0S X 10.6.5 or Later
» Windows 8 and 7 Compatible
(32 & 64-bit), Password Protection

2TB (SESTEB200010) 86.99

3TB (SESTEB300010) 99.00

4TB (SESTEBA400010) 119.99

5TB (SESTER500010) 129.99
G-DRIVE

ceomee EXternal Desktop HD with

Thunderbolt

» One Thunderbolt Port o
» One USB 3.0 Port
» Upto 165MB/s Data

Transfer Speed
» Preformatted HFS+ for Mac
3TB (6TGDT3)..... 279.95
4TB (GTGDTA)..... 379.95
6TB (GTGDTG)..... 479.95

> d?2 Thunderbolt 2
Desktop Hard Drive

» Data Transfer Rates up to 220MB/s
» 7200 rpm Rotational Speed

» Two Thunderbolt 2 Ports

» One USB 3.0 Port

» AES 256-bit Software Encryption

» Fan-Free AU-Aluminum Enclosure

31B (LAD2T23) .. 279.99
4TB (LADZT24) .. 349.99
6B (LAD2T26) .. 449.99

‘HGST Touro Desk DX3
USB 3.0 Hard Disk Drive

» 3.5" External Hard Disk Drive
» Stackable Desktop Design
» Windows/Mac Compatible
» Smooth, Textured Body for
Solid Good Looks
» Plug-and-Play, No Drivers Needed
» Fast USB 3.0 Interface

»

4TB (HGTBDX34) 179.92

CZ3 MyBook
Desktop External HDD
» USB 3.0 Interface

» Up to 56b/s Data Transfer Speed
» Local and Cloud Backup

» Preformatted for Windows 8, 7, Vista, XP
» Reformat for Mac 0S X Operating Systems
» WD SmartWare Pro

» Acronis True Image WD Edition
2TB (WEWDBFJK0020)........ 99.00
3TB (WEWDBFJK0030) ... 109.00

4TB (WEWDBFJK0040).......129.00
6TB (WEWDBFJK0060).......199.00

seagate(C) Backup Plus

Desktop Drive

» One USB 3.0 Port

» 05 / Android Compatible
Seagate App

» Simplified Backup Options

» Windows & Mac Compatible

2TB (SESTDT200010)........109.99
3TB (SESTDT300010).........109.99
4TB (SESTDT400010).........129.99

5TB (SESTDT500010).......... 139.00
6TB (SESTDT600010)....... 199.99
8TB (SESTDTB00010)........ 249.99

G-DRIVE
cmsn Professional Strength External HD
» One USB 3.0 Port
» One eSATA Port ;
» Two Firewire 800 Ports L&
» 7200 RPM Speed
» SATA 6Gbps Interface » 64MB Cache
» Customizable for up to 16 Partitions

2TB (6T6D62) e 199.95
3TB (6T6D63) e 229.95
4TB (6T6D64) e 299.95

@ F.A. Porsche Designed
Desktop Hard Drive

» Capacity of bTB

» USB 3.0 Port

» Data Transfers up to 56bps

» Wuala Cloud Storage with 106B
» Backup and Password Protection Software
» Eco-Mode » Classic, Thick, Aluminum Design

3TB (LAHDP92303) e 119.99
4TB (LAHDP93204) e 149.99
5TB (LAP9230) S 179.99

TOSHIBA Canvio

Desktop External Hard Drive

» USB 3.0 Interface

» 5700 RPM Speed

» JIMB Cache Buffer

» Compact Desktop Design

» Easy-to-Use Backup Software
» Secure Backup with Password

3TB (TOHDECBS) ............. 102.53
4TB (TOHDECBY)............ 115.81

5TB (TOHDECBS)............... 134.99
6TB (TOHDECBY) .............. 189.00

800-947-3308 - 212-444-6691




CZ3 MyBook Duo
External RAID Storage

» Two USB 3.0 Ports

» Formatted in NTFS for Windows

» Max. Data Transfer Rate: 290 MB/s
» 156-Bit AES Encryption

» RAID 0, 1, and JBOD Configurations
» Includes WD Drive Utilities

RAID

CZ1 My Book
Thunderbolt Duo

» 2 x Thunderbolt Ports

» Up to 10Gb/s Data Transfer Rate

» Designed with Two Removable Drives
» RAID 0, 1 & JBOD Compatible

» Daisy Chain up to Six Devices

» Compatible w/ Mac 0S X 10.6.8 or Higher —

COMPUTERS

G-RAID Studio
seemoee Thunderbolt 2 External Storage System
» 330MB/s Transfer Rate

» 7200rpm Drive Speed

» Supports RAID 0, 1, and JBOD

» Two Thunderbolt 2 Ports

» Preformatted for Mac

» Supports 2K and Compressed 4K Video

» User Serviceable Enclosure 4TB (WEWDBUTV0040) 409.99 4TB (6TGRS6TB)
4TB (WEWDBLWEOD40) ... 249.00  8TB (WEWDBLWED0S0) ... Log-on 6TB (WEWDBUTV0040) 449.00 8TB (GTGRS8T)
6TB (WEWDBLWEO060) ...299.00  12TB (WEWDBLWE0120) .. 449.99 8TB (WEWDBUTV0080) 549.00 12TB (GTGRS12TB)
G-RAID
s External Hard Drive Array /A NA | GOG0A0E5 | GTOG0A093 | GTOGO4D
e 4 Thunderbolt [ ORAID BT oms 0.1
underholt 2 UsB 3.0 = - 799.95 | 999.95 | 1,299.95
+ Dual Drive N/A GTGRTATB GTGRTSTB N/A N/A
» 7200rpm Thc:(}::gm 2xThunderbolt | Up to 327 MBfs 0
» Enterprise-Class Hard Drives u - 449.95 549.95 - -
» Aluminum Enclosure USB 3.0, eSATA, 670603240 N/A 670603244 | 610603411 N/A
» Pre-formatted for G-RAID oFroneqy | POAOMBS | JB0DD.1 995 - ERETE -
Mac 05107« N/A N/A 670604069 | GT0GO4077 | GTOG04081
» Windows Compatible G-RAID 61 USB 3.0 Upto400 MBfs | JBOD,0,1
via a Reformat = = 599.95 | 799.95 | 1,199.95
RRONISE Pegasus?
Thunderbolt 2
RAID Storage Array Pegasus? . 01,5, PRPZMAHDAUS | PRPZR4HDBUS | PRPZR4HD12US N/A N/A N/A N/A
» Two Thunderbolt 2 Ports Ré 610 Callorlog-on 1,099.00 | 1,499.00 = - - -
» Hot-Swappable Drive Bays
» Compatible with Pegasus? . 0.1.5.6, N/A N/A PRPZR6HD12US | PRPZR6HD18US | PRPZREHD24US N/A N/A
Time Machine in 05 X R 10,50 - - 174900 | 224900 | 2,799.00 - -
» Built-In Promise
Utility Pegasus? ' 0.1.5.6, N/A N/A N/A N/A PRPZR8HD24US | PRPZR8HD3272 | PRPZRBHDABUS
B [URLU - - - 2799.00 CallorLog-on  4.999.00
=D ?2hig @D 5hig @3 ?hig Quadra
Thunderbolt 2 Series 2-Bay RAID Thunderbolt 2 Series 5-Bay RAID USB 3.0 2-Bay RAID Array
» Dual Thunderbolt 2 Parts ° » Two Thunderbolt 2 Ports — » 7200 rpm Speed, 32MB Cache
» Preconfigured HFS+ RAID 0 » Up to 660MB/s Data Transfer Speeds . » USB 3.0 and FireWire 800 Connectivity
» RAID 0/ 1/ JBOD Compatible » Preconfigured HFS+ RAID b » RAID 0, 1 Modes
» Easy RAID Selection Button » RAID 0/1/5/6/10/JBOD Configurations » Hot Swappable Drives
» Max. Data Transfer Rates of 360 MB/s » Support for DisplayPort 1.2 Connectivity » Email Alerts for Temp and RAID Events
» USB 3.0 for PC and Mac Compatibility . » Advanced Cooling System » Includes USB 3.0 and FireWire 800 Cables
6TB (LAZBT26) 579.00 10TB (LA5BTZR10) 1,299.00 6TB (LA2BQ6)
8TB (LA2BT28) 679.00 20TB (LA5BT220) 1,999.00 8TB (LAZB08) .
12TB (LA28T212) 899.00 307B (LA5BT230) 2,799.00 10TB (LA28D10) 649.00

Storage Array

» 7200 RPM Disk Speed

» RAID 0and 1 Support

» Auto-Sensing Power

» Disk Health Monitoring

» Quiet Intelligent Cooling Fan
» USB 3.0, FireWire 800 & eSATA Ports

2TB (6LSR2000)............... 299.95
4TB (6LSR4000)...... 359.00  8TB (6LSRB000)............... 559.95
6TB (6LSR6000)...... 479.00  10TB (6LSR10000)........... 699.00

www.BandH.com

= ThunderBay 4
"» Hard Drive Array

» SATAIII (6Gb/s) Interface
» 7200 rpm, 32MB Cache

» Preformatted in RAID

» Two Thunderbolt 2 Ports
» Supports RAID via SoftRAID b Software
LTB (OWTB4TB24) ... 729.00
8TB (OWTB4TB2S)............ 849.00
12TB (OWTB4TB212)......... 947.00
16TB (0WTB4TB216) ... 1,148.00

20TB (0WTB4TB220)....1,279.00
24TB (OWT424)............ 1,775.00
32TB (OWT432)............. 3,099.00

BUFFALD DriveStation Duo

Storage Array

» 4TB Storage Capacity

» Includes 2 x 2TB Hard Drives

» SATA Il Internal Drive Interfaces

» 1xUSB 3.0 Interface

» Supports RAID 0/1/J80D

» Windows / Windows Server / Mac 0S X

278.00
339.99

4TB (BUHDWHATU3R1)
6TB (BUHDWHTU3R1)




I VAl NTERNAL HARD DRIVES

SSD STORAGE

Speed 2TB 118 51268 25668 12868
850 EVO Pro ;ATA(\j ! 6}? b/; Intetrfif]z 000 10PS Read 550MB/s | (SAMZTKEZTOBW) | (SAMZTKEITOBW) | (SAMZTKES12BW) | (SAMZTKEZ56BW) | (SAMZTKE128BW)
IO T L Wiite 520MBfs | 874.99 435.00 228.00 126.00 89.99
Random Write up to 90,000 10PS
30 V-NAND flash memory Speed 21B 118 5006B 2506B 1206B
850 EVO 26 (7mm) Read 540MB/s | (SAMZ7SE2TOBA) | (SAMZTSE1TOBA) | (SAMZTSES00BA) | (SAMZTSEZ50BA) | (SAMZTSE120BA)
. iy Write 520MB/s 679.00 339.00 159.99 88.00 71.00
[ SanDiskSSD | Speed 96068 48068 24068 12068
Read 550 MB/s (SASSDXPS960) [SASSDXPS480) (SASSDXPS240)
Extreme Pro quma 1 66t/ Interface Write 515 MBJs 419.99 219.99 129.99 -
Ultra Il 15006 Shock Resistance Read 550 MB/s (SADSSDHII940) (SADSSDHIL480) (SADSSDHII240) (SADSSDHIIT20)
I' Low Latency Write 500 MB/s 299.99 164.00 89.99 55.00
SSD PL 25" (Tmm) Read 480 MB/s (SASDSSDAA80G) (SASDSSDA2406) [SASDSSDA1206)
T8 Write 400 MB/s - 149.00 75.99 49.99
Speed 1B 5006B 2506B
MX200 Read 555 MB/s (CR1TBMX200) [CR5006MX200S) (CR2506MX200S)
SATA IIII 66Gb/s Interface . Write 500 MB/s 200,00 139.00 05 55
Adaptive Thermal Protection
I [7mm] Speed 960GB 480GB 2406B
BX200 ’ Read 540 MB/s (CR960GBBX200) (CR4B0GBBX200) (CR2406BBX200)
Write 490 MB/ 239.99 119.99 64.99
[ KingstonSSD | Speed 48068 24068 12068 6068
V300 Read 450 MB/s, 73,000 0PS (KISV30037A48) | (KISV30037A24) |  (KISV30037A12) |  (KISV30037A60)
SATAII 66bs Interface Wite 450 MB/s, 26,000 10PS 129.99 64.99 a9 4299
HyoerX Sals 25" (Tmm) Read 550 MB/s, 100,000 I0PS | (KISHSSI7AB0) | (KISHSSI7A260) | (KISHSS37AT20) _
Upaissi Wiite 530 MB/s, 88.00010PS | 149.99 8.99 62.99

Samsung 850 Evo M.2

SATA I 66b/s Interface size w Price

540 MB/s Sequential Read Speed 5006B | (SAMINGESO0BW).....175.99
500 MBs Sequential Write Speed 25068 | (SAMINGEZ50BW).......89.99
M.2 Form Factor

Samsung 850 Evo mSATA

SATA Il 66b/s Interface 18 (SAMZMBETTOBW)...... 328.00
540 MB/s Sequential Read Speed 5006B  (SAMZMSES00BW)...... 169.99
520 MB/s Sequential Write Speed 5068 | (SAMZMBELSOBW..... 89.99
mSATA Form Factor

1206B (SAMZNSE120BW)....... 77.99 1206B (SAMZMBE120BW)......... 73.00

HARD DRIVES

HGST Deskstar
6TB

T 128MB Cache | (46DSHD6)... 258.99
?200 660/s Interface “era ™ 1omp cache | eosios. 22995
o 4TB  64MBCache | (4G0S0364)..... 159.99
3.5" Hard Drive

1B 64MBCache | (HGOSISECD)..... 124,24

Western Digital Red

SATA I 660/ Inte 6TB (WEWDGOEFRX)........... 249.00
s Interface
4TB WEWDAOEFRX)........ 149.99
64MB Cashe : :

. . 31B (WEWD30EFRX) 109.99
3.5" Hard Drive
21B (WEWD20EFRX)............. 89.99

Seagate Barracuda Western Digital Caviar

SATA Il 6 Gb/s Interface 3TB | 64MB Cache | (SEST3000DM00).....87.99 SATA Il 66b/s Interface 4TB (WEIDDPA) ..o 219.00

7200rpm 21B | 64MB Cache | (SESTZ0000M00)....71.99 64MB Cashe, 7200rpm 218 (WEIDDP2)... 129.00

3.5" Hard Drive 1B | 64MB Cache | (SEST10000M00)....51.99 3.5" Hard Drive 118 (WEIDDP1).... 7400
HGST Travelstar

SATAIII 6 Gbfs Interface | 6TB | 128MB Cache | (TOWE10KISTA) 199.99 SATAIII 8Gb/s Interface MB | (HGHDISOS) 67.99

7200rpm 5TB | 128MBCache | (TOWEIS0KZSTA) 144.99 32MB Cashe, 7200rpm

3.5" Hard Drive 4TB | 128MB Cache | (TOWE140XZSTA) 172.99 25" (9.5mm) 500MB | (HGOS03788)........cccc. 54.95

E 800-947-3308 - 212-444-6691



° Personal Cloud Series

NAS DRIVES

COMPUTERS

| Model interface _ Bays | CPU | Raid 2B B 48| ¢ 61B |

Personal 1 Gigait Dyl Core WEWDBCTLODZ0 | WEWDBCTLOO3) | WEWDBCTLODA) | WEWDBCTLODGD N/A
Cloud Storage MyCloud | Ethemet/ | Sigle ., " NA
» My Cloud mobile app 1xUSB 3.0 129.99 169.00 186.99 239.99 -
» mycloud.com web access ¢ Gicani 18000
» DLNA 1.5 & UPnP certified My_(:luud X bigabr 136tz LU NA NA WEWDBWVZ0040 WEWDBWVZ0060 WEWDBWVZ0080
for media streaming I ’ -’ Mirror Ethenet/ | Two-Bay dual-core 1 & span-
(Gen2) ’ i - - 299. 49. 99.
» Automatic backup - — — / PxUsB a0 nng 0 343.00 39.00
My Cloud Expert Seres [ ote_mrace Bays CPU Rt |48 _iTh b i st e
Cloud Storage My Cloud 1 Gigabit | 1. . ' JBOD.0. | WEWDBVBZiD N/A WEWDBVBZB0 | WEWDBVBZ120  WEWDBVBZ160 N/A
NAS Server EX2 Ethernet/ Bay cPU 1&
Ultra |9y ysB 3.0 spanning | 349.00 - 449.00 599.00 749.99 - -
» |deal for Prosumers and
Creative professionals 1 Gigabit JBOD, O, N/A N/A WEMYEX4CS08 | WEMYEX4CST2 N/A WEMYEX4CS20 | WEMYEX4CS24
» DLNA1.5 & UPnP MR et |0 P05 0
certified for 2xUsB30 | gaming = - 699.00 872.36 - 1249.00  1,379.00
media streaming . Marvel
5 15051, volume virtualization My Cloud ZEtXhE:lngfI/t o |ARMADA JB?ZD, WEMCEX210001 | WEMCEX2100K2 | WEMCEX210002 /A N/A N/A NIA
» FTP, File, Backup & EX2100 25 U8B Bay | 1.30Hz qaming | 40899 413750 528.98 _ _ _ _
P2P server d&t-cnr{e
N . L arve
Altmodels available My Cloud Dxbigabit | oo D000 | WEMCEKG100KT N/A WEMCEX41008 N/A | WEMCEX410016 | WEMCEX4100K3 A WEMCEXA10024
without disks EX4100 Ethernet / Bay | 136Hz 1,5 10&
» Automatic backup 2830 | Y iLeorg SYMng | 655.00 - 749.00 - 1,049.00 | 1,115.00 | 1,449.00
Synology’ DiskStation BeyondCloud Synology DiskStation BDS415+ Synology’ DiskStation DS1515+
1-Bay NAS 4-Bay NAS Server 5-Bay NAS Server Kit
» SATA Il HDD / SSD Drive Bays » Synology DiskStation Manager 0S » 2.4 GHz Intel Atom C2538 Quad-Core
» Marvell Armada 800MHz CPU » 4x35 or 2.5 SATAIII Drive Bays » 26B DDR3 Memory
» 256MB DDR3 Memory » 2.4 GHz Intel Atom Quad-Core CPU » 4 x Gigabit Ethernet Ports
» 2xUSB 2.0 » 26B DDR3 RAM » 4xUSB 3.0/2 xeSATA Ports
» 1 x Gigabit LAN » Read Speed: 228 MB/s, Write: 233 MB/s » RAID O, 1,5, 6, 10, JBOD Support
» iSCSI Ready : » 2 x Gigabit Ethernet » USB 3.0 / USB 2.0/ eSATA Interface » Read: 450.77 MB/s, Write: 396.50 MB/s
» Pre-Installed NAS 0S 7 » RAIDO, 1,5, 6,10, JBOD
» Supports DLNA devices 127TB (SYDS415P4300) 1,029.79 15TB (SYDS1515PK2) .. 1,259.74  25TB (SYDS1515PK4) .. 1,629.99
2TB (SYBC115J1200) N 174.99 16TB (SYDSA15PK4) 1,229.79 207B (SYDS1515P20T)....1,509.94  30TB (SYDS1515PK5) .. 1,979.99
@& CloudBox seagateC) 2-Bay seagate " 4-Bay
Home Network Hard Drive NAS Pro Server NAS Pro Server
» 1 x Gigabit Ethernet Port » ARM 1.2 GHz Processor » Includes 4 x 2TB Hard Drives
» Up to 60MB/s Performance » 512MB DDR3 Memory » 81B Total Storage Capacity
» 10 x Password Protected » One Gigabit LAN, Wake on LAN » 1 x Ethernet Ports
Users » Backup PC & Mac » iSCSI, SNMP Integration » 1xUSB 3.0 Port
» iTunes & Windows Media Server » RAIDO,1,and JBOD » Two USB 3.0 » Free Android, iPhone,
» LaCie MyNAS Remote Access » Seagate Apps, Plus Third-Party Apps iPad Applications
» Wuala: Share with Friends, Sync Files » Mac, Windows, Linux Compatible » RAIDG, 1,5, & 10 Configuration Options
2TB (LACB2TB) N 129.99 2TB (SESTCT200010)......... 249.99  8TB (SESTCTB00010).......... 499.99
8TB (LACB4) Call or Log-on 4TB (SESTCT400010) ....... 327.99 10TB (SESTCT100001) ....... 534.99 8TB (SESTBPSOOOTO) oo 649,99

BUFFALD LinkStation 220

Personal Cloud NAS storage

» Gigabit Ethernet Port, USB 2.0 Port

» Supports RAID 0/1/J80D

» Windows & Mac Compatible

» Windows RT, Android, i0S Compatible

» Stream Media Directly from LinkStation
» Setup Directly from Table or Smartphane

i 199.99

2TB (BULS22000202) ...
. 379.99

8TB (BULS220D0802) ...

www.BandH.com

BUFFALD TeraStation 3400

4-Bay NAS Server
» 16B DDR3 RAM » Dual Gigahit NICs

» RAID 0/1/5/6/10/J80D

» One USB 3.0 & Two USB 2.0 Parts

» Failover Support » Remote File Access
» Dual-Core 1.33 GHz ARM Processor

» Buffalo Surveillance Video Manager

4TB (BUTS34004)
12TB (BUTS340012)
16TB (BUTS340016)

BUFFALD LinkStation 5800N

RAID NAS Server

» Eight Hot-Swappable Drive Bays
» Gigabit LAN / USB 3.0/ USB 2.0
» RAID 0/1/5/6/10/50/51/60/61/JB0D
» 2.13 GHz Intel Atom D2700 Processor
» 26B of DDR3 RAM

» Eleven Licenses of NovaBACKUP

502.11 24TB (BUTS5800DN24)
823.99 32TB (BUTS58000N32)
1,299.00 48TB (BUTS5800DN48)




I [T MONITORS

UltraSharp

This UltraSharp Widescreen LED
Backlit IPS Monitor from Dell

utilizes in-plane switching technology
to produce 178° horizontal and vertical
viewing angles. The widescreen display
features a 16:10 aspect ratio with ; "
a1,000:1 contrast ratio and a 6 ms U2414H U2612M 2415 02413
response time for crisp, clear picture
quality. The Dell monitors comes

ENERGY STAR Qualified, EPEAT Gold Model Resolution  ScreenSize  Ratio  Brightness Ports Media Card Reader SKU
Rated, and TCO Certified U2614H | 192041080 By 16:09 | 250 cdfm? HDMI, DisplayPort, mini DisplayPort, USB 3.0 NIA DEUZ4TAH | 239.99
» In-Plane Switching (IPS) Technology UM | 1920x1200 w 16:10 | 300 cdfm? DVI-D, DisplayPort, VGA, USB 2.0 NIA DEUZ4IZM |  239.95
» 1,000:1 Contrast Ratio V2415 | 1920x1200 w 16:10 | 300 cdfm? HDMI, DisplayPort, mini DisplayPort, USB 3.0 NIA DEUZ4I5 | 269.99
» 16.7 miilion colors U2413 | 1920x1200 Wu 16:10 | 360cd/m? HDMI, DisplayPort, mini DisplayPort, DVI-D, USB 3.0 Yes DEU2413 385.00
» 178°/178° Viewing Angles UPZ516D | 25601440 % 16:09 | 300 cdfm? HDMI, DisplayPort, mini DisplayPort, USB 3.0 NIA DEUPZSIED |  487.49
» Titt/Swivel Pivot/Height Adjustability UZ7ISH | 25601440 i 1609 | 360cdim? HOMI, DisplayPort,mini isplayPort, USB 3.0 NIA DEUTIGH | 529.99
UP2716D | 2560x1440 Vi 16:09 | 300 cdfm? HDMI, DisplayPort, mini DisplayPort, USB 3.0 NIA DEUP2716D |  696.46
isus

Wide Viewing Monitors

ASUS has included a blue light filter
and nearly eliminated all flicker from
within the display. By lowering blue
light emissions and eliminating display
flicker users benefit from increased
viewing comfort and reduced eye strain.
Additionally, ASUS has included their Model

VP239H-P VP247H-P VP2790-P VP228H

Screen Size Ports SKU

own GamePLus functionality poviding VP239H-P w HOMI D-Sub DVI-D ASVP239HP 139.00
gamers with both 0SD crosshair and -
i VP24TH-P 36 HOMI D-Sub DVI-D ASVP247HP 138.99
timer features. . -
» 16.7 miilion colors VP2790-P 7 HOMI D-Sub DisplayPort ASVP2790P 219.00
» 1920 % 1080 Resolution VP228H ns HOMI D-Sub DVI-D ASVP228H 109.99
» 250 cd/m? Brightness VP278H-P 2w HOMI D-Sub ASVP278HP 239.00
@ U3415W @ ruthorizeareseier 27 THUNAerbolt Display NEC PA272W-BK 27" LED

21:9 Curved Widescreen Display » Thunderbolt Port + FireWire 800 HDMI + (Mini) DisplayPort + DVI-D
» In-Plane Switching (IPS) Technology » 3xUSB 2.0

» HDMI/MHL/DisplayPort/Mini
DisplayPort » WQHD 3440 x 1440
Native Resolution

» 1,000:1 Typical Contrast Ratio

» Gigabit Ethernet Port

» Kensington Security Slot
» 1000:1 Contrast

» 178°/178° Viewing Angle

» 2560 x 1440 Resolution

» 1,000:1 Contrast Ratio

» 340 cd/m? Brightness

» 178°/178° Viewing Angles

» 6 ms Response Time

» 1.07 Billion Color Support
—_—

» 300 cd/m? Brightness » 12ms Response Time
» 178°/172° Viewing Angles » Built-In 2.1 Speaker System » 14-bit Lookup Table
» Up to 8 ms Response Time » 1.074 Billion Colors » Built-In Face Time HD Camera with Mic » 16:9 Aspect Ratio » Enhanced Color Gamut
DEU34&T5W 779.99 APMC914LLB 929.00 NEPA272WBK 1,199.00
w LS24D300HL 23.6” Full HD " Pavilion 27xw BenqQ GW2765HT
LED Backlit Display » In-Plane Switching (IPS) Technology 27” LED Monitor
» 1920 x 1080 Resolution » Detachable Base, » 2560x1440 WQHD Resolution
» 16:9 Aspect Ratio Security Lock Ready » TeroFlicker & Low Blue Light for
» 700:1 Contrast Ratio » Low Haze Panel extended viewing comfort
» 200 cd/m? Brightness » 1920 x 1080 Resolution » HDMI Multimedia Interface
» 90°/65° Viewing Angles » Plug-and-Play » Built-in Speakers
» b 'ms GtG Response Time » 1xVGA, 2 x HDMI Inputs » Ultra-Flexible Height
»16.7 Million Color Support »10,000,000:1 Dynamic Contrast Ratio » Adjustment System (HAS)
» 1xVGA/ 1 x HDMI Inputs » 8 ms GtG Response Time
SAS24D300HL 199.99 HE2TXWH $199.99 BEGW2765HT 379.99

800-947-3308 - 212-444-6691



4K MONITORS & CALIBRATION SOLUTIONS

@ P27150 27> 4k Monitor
» In-Plane Switching (IPS) Technology

» DisplayPort Input + DisplayPort Output

» Mini DisplayPort + HDMI (MHL) Inputs

» 3840 x 2160 Resolution i

» 2,000,000:1 Contrast Ratio

» 350 cd/m? Brightness

» 178°/178° Viewing Angles

» 9 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Hub

DEP27150

578.06

/iSUS PB2870

28” Widescreen 4K UHD Monitor

» 3840 x 2160 4K Resolution

» 1 ms Response Time

» 300 cd/m? Brightness

» 1.073 Billion Color Support

» 170°/160° Viewing Angles

» 8 x SPLENDID Video Preset Modes
» 3 x Skin Tone Selection Modes

» & x Color Temperature Selectiom Modes

ASPB2870

479.99

BeéNQ BL3201PH 32” widescreen LED

Backlit LCD IPS 4K Monitor

» In-Plane Switching (IPS) Technology

» DVI-DL/DP1.2/ mDP1.2 / Dual HOMI

» 3840 x 2160 Resolution

» 1,000:1 Contrast Ratio

» 350 cd/m? Brightness » 178°/178°
Viewing Angles » 4 ms Response Time

» 1.07 Billion Color Support » 100% sRGB
Color Gamut » Integrated USB 3.0 Hub

BEBL3201PH

929.99

@ UP2715K 277 uUltrasharp 27 Ultra HD
5K LED Monitor

» In-Plane Switching (IPS) Technology
» DisplayPort + Mini DisplayPort Inputs
» 5120 x 2880 Resolution

» §,000,000:1 Dynamic Contrast Ratio

» 350 cd/m? Brightness

» 178°/178° Viewing Angles

» § ms Response Time

»1.074 Billion Colors » Built-In USB 3.0 Hub

DEUP2715K

1,579.00

yZexrite i1Display Pro

» Ergonomic: 3 Integrated Functions

» Advanced Filter and Optical Systems

» Works On All Modern Display
Technologies » Field-Upgradeable
for Future Technology

» Rotating Diffuser Arm / Tripod Mount

» Basic and Advanced Modes

» Ambient Light Measurement/Smart Control

» Flare Correct » Intelligent Profiling for Color Accuracy

XREODIS3

249.00

www.BandH.com

@ P24150 24” ultra HD 4K Monitor
» In-Plane Switching (IPS) Technology

» DisplayPort Input + DisplayPort Output

» Mini DisplayPort + HDMI (MHL) Inputs

» 3840 x 2160 Resolution

» 2,000,000:1 Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles

» 8 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Huh  ~=—ou_~

DEP24150 389.99

/iSUS PB2790

27” Widescreen 4K UHD Monitor

» In-Plane Switching (IPS) Technology
» HDMI/MHL + DisplayPort + Mini
DP Inputs » 3840 x 2160 4K UHD
Resolution » 1,000:1 Contrast Ratio
» 100,000,000:1 ASUS Smart Contrast
Ratio » 300 cd/m? Brightness
» 178°/178° Viewing Angles
» 5 ms Response Time (Gray to Gray)
ASPB2790

626.32

@ LG Digital Cinema 31MU97-B
31” Widescreen LED Backlit IPS 4K Monitor

» In-Plane Switching (IPS) Technology

» HDMI/ DisplayPort / Mini
DisplayPort

» 4096 x 2160 Resolution

»1,000,000:1 Contrast Ratio

» 320 cd/m? Brightness

» 178°/178° Viewing Angles

» 17:9 Aspect Ratio

LG3TMU97B

Call or Log-on

127q 277 Widescreen LED
Backlit LCD Monitor

» In-Plane Switching (IPS) Technology

» 2x DisplayPort 1.2 Inputs

» 5120 x 2880 Resolution

» 1,000:1 Contrast Ratio

» 300 cd/m? Brightness

» 178°/178° Viewing Angles

» 14 ms Response Time

» 1.07 Billion Color Support » USB 3.0 Hub

HEZ27027MSBY

1,097.00

datacolor s Spyder5PRO
Display Calibration System

» Calibrate Laptops, Desktop Manitors
» Includes Color Probe

» 16 Calibration Choices

» 3 Ambient Light Settings

» Before and After Evaluation

» Basic Display Analysis

» Comes in a Reusable Box / Case

DAS5P100 179.00

COMPUTERS

@ UP3216Q
» 31.5"IPS Panel
» HDMI/DisplayPort/mini-DisplayPort Inputs
» 3840 x 2160 Resolution
» 1,000:1 Contrast Ratio
» 300 cd/m? Brightness
» 178°/178° Viewing Angles
» 6 ms Response Time (GtG)
» 1.07 Billion Color Support
» Tilt/Swivel/Pivot/Height Adjustab

DEUP32160

1,299.99

NEC MultiSync EA275UHD-BK
27” Monitor

» In-Plane Switching (IPS) Technology

» DVI-D + DisplayPort + HDMI
Inputs » 3840 x 2160
Resolution » 1000:1 Contrast
Ratio » 350 cd/m? Brightness

» 178°/178° Viewing Angles

» 6 ms Response Time

» 1.07 Billion Colors » Built-In USB 3.0 Hub

NEEA275UHDBK

Call or Log-on

w U28E590D 28” Widescreen
LED Backlit UHD Monitor
» Twisted Nematic Display Technology

» HOMI / DisplayPort Inputs -
» 3840 x 2160 Resolution

» 1,000:1 Static Contrast Ratio
» 370 cd/m? Brightness

» 170°/160° Viewing Angles

» 1 ms Response Time

» AMD FreeSync Technology » 1 Billion Color Support

SAUZBE590D

599.00

@star* M280A1 28 Class 4K Widescreen
LED-Backlit Monitor
» HDMI, DV, and
DisplayPort
» 3840 x 2160 Resolution
» Widescreen with 16:9
Display Format
» 1000:1 Contrast Ratio
» 300 Brightness
» 3840 x 2160 Response Time
UPMZ80A1

399.00

yzax-rite ColorMunki Display
» Ergonomic: 3 Integrated Functions

» Advanced Filter and Optical Systems

» For Virtually All Modern Displays

» Field-Upgradeable for Future Technology
» Rotating Diffuser Arm / Tripod Mount

» Easy and Advanced Modes

» Ambient Light Measurement/Smart Control

» Flare Correct » Intelligent Profiling for Color Accuracy
» Automatic Hardware Adjustment

XRCMUNDIS

164.95




COMPUTERS

NVIDIA GeForce GTX 980
Graphics Cards

With a slightly altered “Big Maxwell”
chip, NVIDIA's GeForce GTX 980 Super-
clocked Graphics Card is geared towards
high resolution gaming at fast frame rates.

GRAPHIC DISPLAY CARDS

NVIDIA GeForce GTX 970
Graphics Cards

Gamers can take advantage of the GTX

970's integrated performance technologies
to improve frame rates and reduce unwanted
artifacts like tearing and aliasing when playing games at high resolutions.

» 4096 x 2160 » §4-Bit Memory Interface » Tx DVI-I DL » 4096 x 2160 » 256-Bit Memory Interface » TxDVI-IDL /1xDVI-D DL
» Dual Slot PCle 3.0 x16 » 2816 CUDA Cores » 3 x DisplayPort » Dual Slot PCle 3.0 x16 » 1664 CUDA Cores » 3 x DisplayPort
» 6GB GDDRS Memory » Four Display Monitors Simultaneously » 1x HOMI » 4GB GDDRb Memory » Four Display Monitors Simultaneously » 1x HOMI
. . GeForce GTX 970
+ + GTX 980 Ti : Strix GeForce i GeForce GeForce
Model GTX 980 Ti V1 GTX 980 46 GTX 980 Ti Hybrid GTX 980 Ti Model GTX 970 46 6TX 970 Mlllloéldnil‘l:]stone 6TX 970 6TX 970
Base Clock 1000 MHz 1216 MHz 1000 MHz 1140 MHz 1190 MHz Base Clock 1051 MHz 1114 MHz 1051 MHz 1178 MHz 1050 MHz
Max Boost Clock 1076 MHz 1317 MHz 1076 MHz 1228 MHz 1317 MHz Max Boost Clock 1271 MHz 1253 MHz 1279 MHz 1329 MHz 1178 MHz
Coolin Exhaust Fan Twin Frozr V Blower-Style | Hybrid Liquid/Air DirectCU 11l Coolin Twin Frozr V DirectCU Il Twin FrozrV WINDFORCE ACX 2.0
9 Cooler Cooler Cooler Cooler Cooler 9 Cooler Cooler Cooler 3X Cooler Cooler
SKU MSGTX980TIV1 MSGTX980646 EVGTX980TI66 EV6GP41996 ASG980TI6GDS SKU MSGTX970646 | ASGTX970FOC MSGTX9701ME GIGVN97061 EVGTX970ACX2
Price Call or Log-on 519.99 669.99 728.95 679.99 Price 339.99 325.99 347.99 349.99 343N
NVIDIA GeForce GTX NVIDIA GeForce GTX 750

TITAN X Graphics Cards

As the first implementation of “Big
Maxwell”, the TITAN X Graphics Card offers
an impressive chipset configuration inclined towards high-resolution
gaming and graphics rendering. The CUDA cores are arranged using
NVIDIA's Maxwell architecture, allowing the GPU to operate using
less power while generating less heat than the previous generation
Kepler architecture. Operating at full tilt during intense gaming se-
quences, the card will only draw a maximum of 300 watts of power.

Graphics Cards

The GTX 750 graphics card can N ’
connect to a variety of display types,
including computer monitors, HDTVs, : \
projectors, and even many 3D devices. -
It is fitted with dual dust-proof fans for 2x
improved airflow and 3x quieter life-span. Super

Alloy Power components offer optimal stability.

» 2560 x 1600 » 128-Bit Memary Interface » 2xDVI-D
» 4096 x 2160 » 384-Bit Memory Interface » 1x DVI-I DL » Dual Slot PCle 3.0x16 » 640 CUDA Cores » 1xVGA
» Dual Slot PCle 3.0 x16 » 3072 CUDA Cores » 3 x DisplayPort » 26B GDDRb Memory » Four Display Monitors Simultaneously » 1x HOMI
» 126B GDDRS Memory » Four Display Monitors Simultaneously » 1 x HOMI
e o o oo e
Model GTX 750 Ti GTX 750 Ti GTX 750 Ti GTX 750 Ti GTX 750 Ti
Model GTXTITANX GTXTITANX GTXTITANX GTXTITANX Base Clock 1072 MHz 1020 MHz 1189 MHz 1059 MHz 1020 MHz
Base Clock 1000z 127 1000 192 MaxBoostClock | 1150 Mz 1085 MHz 1268 Mz 1137 Mz 1163 Mz
Max Boost Clock 1076 M 1216 Mz 1075 Mifz 1241 Mifz . Dualfn | ActiveFansitk | Dualfan  WINDFORCEZX | Twin Frozr IV
Cooling Blower-Style Cooler | Blower-Style Cooler | Blower-Style Cooler | Blower-Style Cooler Cooling Cooling Cooler Cooling Cooling System Cooler
SKU ASGTX12GDDRS EVGTXSC126R5 EVGTX126BTXC EVGTX12GDDRS SKU ASGTX750TIOC | MSN750TI2GLP EVGGTX750TI GIGVN75TWAGI | MSN750TITF26
Price 1,039.99 1,099.99 1,069.89 1,149.99 Price 129.99 113.85 129.99 149.99 134.99

mMatroX pualHead2Go Digital ME

Graphics eXpansion Module

» Connects up to Two Monitors
» Stretched Desktop Support

» Support for DVI Monitors

» Matrox PowerDesk Software

mMatrox TripleHead2Go Digital SE

External Adapter

» Add up to 3 Monitors

» DisplayPort or Mini
DisplayPort Input

» Works for DVI via Adapter

matfoxX TripleHead2Go DP Edition
External GXM '

» Drive 2 or 3 Displays
from 1 Connector
» DisplayPort (DP) Input/Qutput
» Works for DVI/VGA/HDMI/MDP via

Adapter » Max Resolution Per Monitor: 1920 x 1080 » Maximum Resolution up to 5760 x 1080 » HDCP Compliance
» Total Max Resolution: 5760 x 1080 » Features Surround Gaming » Use In Media Creation » Clone Mode
(MAT26DP) 303.99 (MAT26DP3DIF) 234.99 (MAD2GDP2DMIF) 150.99

08 + 212-444-6691




GRAPHIC DISPLAY CARDS

NVIDIA Quadro Graphic Cards

The NVIDIA Quadro Professional Graphics Cards
provides the APl support and parallel
processing performance required for S
CAD modeling and DDC applications

that involve rendering 3D graphics. The

processing power can also be harnessed for other

computationally intensive tasks, such as transcoding video or data
analysis. The Quadro series features CUDA Cores, which are general
purpose stream processors that not only render display graphics, they

COMPUTERS

NVIDIA GeForce GTX 960
Graphics Cards

Not just for driving displays, this card
features NVIDIA's Maxwell architecture.
Graphics intensive programs can

utilize the Maxwell architecture’s parallel
configuration of the 1024 CUDA cores to speed
up render times and other tasks that benefit

from parallel processing.

also allow dozens of computations to be performed simultaneousl A6 X710 ” 4GB GDORS Memory " 1024 CLDA Cores
P P Y- » Dual Slot PCle 3.0 x16 » 128-Bit Memory Interface » Four Display Monitors Simultaneously
» 3840 x 2160 » Dual Slot PCle 2.0 x16 » Four display monitors simultaneously
Model Quadro K620 | Quadro K2200 | Quadro K4200 | Quadro M4000 | Quadro K5000 Base Clock 1178 MHz 1178 MHz 1228 MHz 1165 MHz 1279 MHz
CUDA Cores 384 640 1344 1664 1536 Max Boost Clock 1241 MHz 1304 MHz 1317 MHz 1228 MHz 1342 MHz
Memory 268 DDR3 4GB GDDRS 4GB GDDRS 868 GDDRS 468 GDDRS Memory 26B GDDRS 4GB GDDRS 26B GDDRS 26B GDDRS 26B GDDRS
128-bit 128-bit 256-bit 256-bit 256-bit
1% DV DL _ 1OV DL 1X OV DL X OV DL 11:[']]\)"'_’['J 1x OV DL
Display Ports |, l)[(]i[l‘lll: E’trt ) )3 I;(Isnvlla-lPDoLrts ) Q S@‘t'%ﬁs 4xDisplayPort | 1xDVI-DDL Display Ports | 3xDisplayPort | 3xDisplayPort | 3 x DisplayPort 1% HOMI 3 x DisplayPort
play play play 2 DisplayPorts 1x HOMI 1x HOMI TXHOML ot | XHOM
. Active Active Active Blower-Style Ultra-Quiet . Armor 2X Twin Frozr V DirectCU 11 Fansink ACX 2.0+
Cooling Fansink Fansink Fansink Cooler Active Fan Sink Cooling Cooler Cooler Cooler Cooler Cooler
SKU PNVCQK620PB | PNVCQOK2200PB HEJ3G89AT PNVCAM4000 | PNVCQK5000MA SKU MSG96026D5T0 | MSGTX960GMG4 | ASGTX9602GD5 | GIN960IXOC26 | EVGTX96026SC
Price 156.94 429.00 819.00 859.00 1,696.39 Price 199.99 225.00 214.99 Call or Log-on 209.99

AMD FirePro Graphics Cards

AMD Radeon Graphics Cards

Built for gaming at high resolutions,
AMD's Radeon Graphics Cards

features GDDR5 vRAM for loading

large textures and graphics coupled

to over 1280 Stream Processors running
at a base speed of 1000 MHz with between

256 and 512-bit memory bus . Using the included utility, the GPU's
can be overclocked up when running in OC mode, which also boosts
the GPU clock speed.

The FirePro graphics incorporate
an Autodetect technology. As you
open new 3D applications or move
between them, driver settings

are automatically configured

for optimized performance of
supported applications, no matter what
your workflow demands.

I Y S TR

Model Radeon R9 390 Radeon R9 380 Radeon R9 380X Performance 3.3 TFLOPS 1.43 TFLOPS 645.1 GFLOPS
Base Clock 1000 MHz 970 MHz 970 MHz Stream Processors 1792 768 512
Max Clock 1060 MHz 1000 MHz 990 MHz Memory 868 GDDR5 256-bit 4GB GDDRS 128-bit 26B GDDRb 128-bit
Stream Processors 2560 1792 2048 Display Ports 4 x DisplayPorts 4x DisplayPorts 4 Mini DisplayPorts
Memory 86B GDDRS 612-bit 46B GDDR5 256-bit 468 GDDRS 384-bit Cooling Discreet active cooling Discreet active cooling Discreet active cooling
1xDVI-D DL 1xDVI-D DL SKU AMFW7100 AMFW5100 AMFWA4100
. b DDt X DVH DL XDV DL
Display Ports 1 xHOMI 1 x HOMI 1x HOMI Price 649.99 323.99 $159.99
1x DisplayPort * ST
1 x DisplayPort 2 x Mini DisplayPorts
Cooling Twin Frozr V Cooler Twin Frozr V Cooler DirectCU 11 Cooler E
Toviewafulllistingofall RGN : rvisitour websit
SKU MSR93906AMBG MSRY3B0GAMAG ASRI380X46BC 0 view a Tull isting of a THIS Orvisitourwensite
Graphic Display Cards BandH.com/w1573
Price 329.99 239.99 239.99 CODESI |




Mid-Tower Cases w/ Windowed Side Panel
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POWER SUPPLIES AND COMPUTER CASES

Gaming Cases

NZIXT Corsair Cooler Master BitFenix Corsair Cooler Master NZIXT Thermaltake
Model 5340 Obsidian 750D MasterCase Pro Neos Model Carbide Series SPEC-02|  CM Storm Trooper Guardian 921 Chaser A71
Motherboard ATX, Micro-ATX, | ATX, E-ATX, mATX, Micro | ATX, Micro-ATX, ) - Motherboard ATX, Micro-ATX, ) ) .
compatiblity Mini-ITX AT Mini ITX, XL-ATX Mini-ITk ATX, Micro-ATX, Mini-ITX compatiblity Mini-IT ATX, Micro-ATX, XL-ATX |ATX, Micro-ATX, Baby AT| ATX, Micro-ATX, eATX
Expansion Slots 7 9 7 7 Expansion Slots 7 9+1 7 8
Available Colors | Black, White Black Black Purpl, Blue, White, Red, Available Colors Black Black Black w/ Blue LED Black
Black, Gold, Silver
SKU NZCAS340WW1 C0C9011035WW COMCYD05PKWN BIBNEOTWWWKP SKU cocc9oTos1w COGCH000KWN1 NZ921RBO01BL THVP40OMIW2N
Price 74.99 149.99 125.46 59.99 Price 59.99 149.99 69.99 129.99
Cube Cases Mid-Tower Cases

durm 4467

Corsair

Corsair

Thermaltake

Thermaltake

Cooler Master NIXT Antec BitFenix
Model Carbide Series Air 540 | Carbide Series Air 240 Core V1 Core X9 Model Silencio 352 H230 Three Hundred Two Prodigy
Motherboard ATX, Micro-ATX, o - A ATX, Micro-ATX, Motherhoard ) - ATX, Micro-ATX, ATX, Micro-ATX, -
compatiblity i, | MEAT M Hinrik Mini-ITX, E-ATX compatibtity | AT Mini-ITX Mini-ITX Mini-ITX Mini-ITX
Expansion Slots 8 4 2 8 Expansion Slots 4 7 8 2
Available Colors | Black, Silver White White Black, White Available Colors Black Black. White Black e, M L,
Red, Black, White
SKU COCSH40ACCBK Coc9o11069WW THCA1BB00S6W THCATDB00FTW SKU C0SL352MKKN1 NZCAH230IB1 AN302MDTWRCS BIBPRO3WWXKW
Price 129.79 89.99 54.99 169.99 Price 82.07 69.99 59.99 85.00

Power Supplies

For the user wanting to build thier PC from the ground up, or the advanced gamer who need to upgrade to more power, B&H carries a wide
assortmant of internal Power Supplies that are fully compatible with most computer cases. Whether you are looking for a unit with cables
hard-wired or a fully modular Power Supply without any permanently attached cables that simplifies installation and allows you to use only the
cables you need for a neat and clean build by improving performance by reducing airflow obstruction.

VY9 9esveeinw

Corsair Corsair Sea Sonic Corsair Thermaltake Sea Sonic Thermaltake Corsair Antec Logitech
Model AX1500i HX1000i Snow Silent 750 RM750 SP-550P RM850 SP-750P CX600 VP-450 PS550
Wattage 1500 W 1000 W 750 W 750 W 550 W 850 W 750 W 600 W 450 W 550 W
Modular Modular Modular Modular Modular Non-Modular Modular Non-Modular Non-Modular Non-Modular Non-Modular
Pov:\e‘:rt:yaitor Active No Active Active Active Active Active Active No No
+12V Rails Multiple Multiple Single Single Single Single Single Single Dual Single
Certification | 80 PLUS Titanium | 80 PLUS Platinum | 80 PLUS Platinum 80 PLUS Gold 80 PLUS Bronze 80 PLUS Gold 80 PLUS Bronze 80 PLUS Bronze 80 PLUS Certified 80 PLUS
SKU COP9020057NA C0C9020074NA SESS750 COP9020055NA THSP550P SEM121162062 THSP750P C0P9020048US ANVP450 LOPS550E12BK
Price 399.05 191.99 154.99 119.99 49.99 74.99 67.78 64.99 37.93 26.99

800-947-3308 - 212-444-6691



Motherboards
B&H carries Motherboards that support 4th and 5th generation Intel processors in the LGA1150 socket and AMD models that support 970 and
SB950 chipsets that deliver CPU power, integrated graphics, RAID support, built-in surround sound and a wide selection of PCle slots and I/0
ports for the user looking to custom build their ideal gaming system.

MOTHERBOARDS, CPUS AND COOLING SYSTEMS

S

COMPUTERS

hd o

Asus Asus Gigabyte Gigabyte Asus Gigabyte
Model X99-EWS X99 Deluxe X99A GA-2170-HD3P GA-HT10M-A 2170-A 197 Gammg 5 GRYPHON 297 GA-H97M-D3H
Form Factor CEB ATX ATX ATX Micro-ATX ATX ATX Micro-ATX Micro-ATX
Chipset Intel X99 Intel X99 Intel X99 Intel 2170 Intel H110 Intel 2170 Intel 297 Intel 297 Intel H97
CPU Socket LGA 2011 v3 LGA 201 L6A 2011 LGA 1151 LGA 1151 LGA 1151 LGA 1150 L6A 1150 LGA 1150
Memory Support DDR4 DDR4 DDR4 DDR4 DDR4 DDR4 DDR3 DDR3 DDR3
Maximum Memory 12868 6468 12868 646B 3268 6468 3268 3268 326B
RAID None 0,1.5,10 0,1,510 01,510 None 0,1,5,10 0,1,5,10 01,510 0,1.5,10
CrossFire / SLI CrossFire and SLI CrossFire and SLI CrossFire and SLI CrossFire None CrossFire and SLI CrossFire and SLI CrossFire and SLI CrossFire
SKU ASX99E31WSMB ASX99DLXUS31 MSX99ASLIPMB GIGAZ170HD3P GIGAHT10MA ASZ170A MSZ97GAMINGS ASGRYPHZ97MB GIGAH97MD3H
Price 529.00 398.27 229.99 129.99 59.99 157.95 139.99 178.99 $84.99
AMD Motherboards CPUs

Gigabyte Asus Asus
Model 970 Gammg ABBXI-AC GA-990FXA-UD3 Rb MBAT8L-M LE AMIM-A
Form Factor ATX Micro-ATX ATX Micro-ATX Micro-ATX
Chipset AMD 970 / SB950 AMD 88X AMD 990FX / SB950 AMD 7606 (780L) / SB710
CPU Socket AM3 [ AM3+ FM2+ [ FM2 AM3 [ AM3+ AM3 [ AM3+ AMD AM1
Memory Support DDR3 DDR3 DDR3 DDR3 DDR3
Maximum Memory 326B 3268 326B 1668 3268
RAID 0,1,5,10 01,510 0,1,5,10 0,10 None
CrossFire / SLI CrossFire and SLI None CrossFire and SLI CrossFire None
SKU MS970GAMING MSABBXIACV? GI990FXMB ASMBA78LMLU3 ASAMIMA
Price 92.20 97.99 119.99 55.00 3691

B&H carries over 250 different CPUs,
including the latest Haswell-E and Xeon
lines, supporting LGA1150,

LGA2011 and many other

CPU socket
types in the

Intel family of

processors.

fullline of available
AMD processors are

The

also available, including AM3+ and 12-core

chips for the serious gamer.

CPU Air Coolers

BYERD

CPU Liquid Coolers

o= B B, B @

Corsair Corsair Corsair Deepcool Thermaltake Cooler Master  Cooler Master Intel Thermaltake ~ Zalman CNPS8900
Model Hydro MO0 | Hydro HBQI Hydro H5 Captein pndter 0 Model | Hyper2I2EV0 | Hyper 612 TSIEA | NiC Series C5 Hyper TX
Fan Speed 2400rpm 2400rpm 1700rpm 200rpm 2000rpm Fan Speed 2000rpm 1300rpm 3850rpm 2000rpm 1500rpm
Airflow 70 CFM 70 CFM 57 CFM 70 CFM 81 CFM Airflow 82 CFM 44 CFM 40 CFM 99 CFM 54 CFM
Sound 37 dBA 37 dBA 30 dBA 39 dba 27dba Sound 36dba 20dba 40dba 39dba 2bdba
SKU COCW9060025 | COCW906017WW COHb5 DECAPTAINZ40 THCLW02228 SKU CORR212E20R2 | CORH6V213PR1 INBXTS15A THCLPO608 ZACNPSB900QU
Price 107.73 99.50 59.99 89.00 66.99 Price 29.49 40.49 30.88 48.63 38.99
. . H n tE'C BFEri< *@gﬁﬁ?é Thermaltake
LED Strip Lights hd 22 NZXT. *

LED Lighting Kit allows enthusiasts to set up lighting inside their computer cases. Using sleeved wires paired with multiple LEDs, an LED kit allows
users to hide lights between side panels and under components, creating a red glow effect and set the mood with different available colors.



COMPUTERS

" Dancing Water
XCELLON' Stereo Speakers
» USB-Powered for
Convenience and Mobility
» Water and Lights
Dance to Your Music
» Four Streams of Water
Black (xcOWS1008)........ 19.95
White (XCOWS100W)....... 19.95

M4V Companion 20
Multimedia Speaker System
» Dual Speakers with
Full, Natural Sound
» Advanced Ported
Design for Low-Notes
» Control Pod with Volume
and Mute Control

(BOC20MS) ... 249.00

(@ audioengine A2+

2.75” Powered Desktop Speakers

» 2.0 Powered Speaker System

» 2.75" Kevlar Woofer

» 34" Silk Dome
Tweeters

» 60W Total
Peak Power

[AUSAZPB) ...

BassPULSE
& 21 Channel Speaker System

» Full-Range Satellite
Speakers
» Side-Firing
Subwoofer
» 3.5mm
Aux Input

(60GGBPO00T00).....c

249.00

RazeRr Leviathan

Elite Gaming Soundbar

» Bluetooth 4.0 Wireless Streaming

» Supports aptX Codec

» 5.1-Channel Surround
Sound

» Dedicated
Subwoofer

[RALEGMSB)

169.99

CA-2880

Cyber Acoustics USB Powered Speaker

» Dual 1.6
Neodymium
Full-Range Drivers

» Chrome 3.5mm Input » USB-Powered

» Attaches to Laptop via Clip

» Desktop Volume Control & On/0ff Switch

[CYCAZBB0) ...

16.33

SPEAKERS

a' Dancing Water
XCELLON' Stereo Speakers
» Water and Lights

Dance to Your Music
» 6 Multi-Colored LED Lights
» b Streams of Water
» 3.5mm Stereo Audio Input
» USB-Powered

(XCOWS2008)................

24.95

M4V Companion 2

Series Il Multimedia Speakers

» Stereo Sound

» Digital Signal Processing
» Ported Cabinet Design

» Auxiliary Input

» Volume Control

» Headphone Jack

[BOCZIMS) ..o

99.00

(<- Logitech 7200
Multimedia Speakers
» 2.0-Channel Speakers
» 10 W Peak Power

» Auxiliary Input

» Bass Control

» Volume & Power Controls
» Headphone Jack

[LOZ20OMB) .

24.99

harman/kardon

SoundSticks Il 2.1-Channel
Desktop Speakers
» Up to 40W of Total Power
» 8 Full-Range Transducers LY
» §" Down-Firing Subwoofer [ .
» 1x 3.5mm Auxiliary Input
» Touch Controls for Volume and Mute
(HASS3AMA) oo

A5505.1

Cyber Acoustics Speaker System

» .1-Channel System

» Creative IFP Design

» Subwoofer with
Adjustable Bass

» Wired Remote

Control » Space-Saving Design
(CRA5508)

@ ACST
USB Soundbar

» Stereo Playback » 2 x 1.25 W of Power
» 1x Aux-In / 1x Headphone-Qut
» Compact Design at 16" Wide

» USB Powered
» Compatible with
Select Dell Monitors

(DENCW95) ... ..21.53

55.99

CA 2014

Cyber Acoustics Computer Speakers

11.58

» Stereo Sound

» Front-Panel Power
and Volume Control

» Integrated 3.5mm
Audio Cable

» Headphone Jack

(CYCA2014)

CREATIVE Inspire T10
Speaker System

» 2.0 Audio System

» Dedicated Tweeters
» BasXPort Technology
» Headphone Jack

» Auxiliary Input

39.95

[CRITI0).

(e- Logitech $-120
Speaker System
» Dual Speaker System
» Volume & Power
Control Knab
» Built-In Headphane Jack
» Designed for Computer Use
» Ultra-Affordable

[LOST20)

12.95

CA-3602

Cyber Acoustics Computer Speakers

» Subwoofer Delivers Thunderous Bass
» For Gaming, Computers, MP3 / DVD Players

» Aux-In & Headphone
Jacks » Exceptional
Amplifier Technology ﬂ

» Wired Remote

(CYCA3602) .........

39 95

T63005.1

Cyber Acoustics Speaker System

» Two Large 7W Satellite Speakers

» Three Medium 7W Satellite Speakers

» Down-Firing 22W Ported
Subwoofer

» Adjustable Bass
Level Control

[CRITB30081) o

$78.99

AX510

» For Dell UltraSharp Series Monitors
» For Dell Professional Series Monitors
» Low Profile Design » 10W of Total Power
» Dual Headphane Jacks

T

(DEAX510) L1781

CA-2050 Curve.Sonic

cyber Acoustics Computer Speakers

» Powered Stereo
Speakers

» Power and Volume
Controls

» Headphone Output

» Titanium Drivers

[CYCAZO50) .o

12.95

CREATIVE GigaWorks T20

Series Il Stereo Speakers

» 28W RMS

» Headphone
Jack

» BassXport

(CRGT202) oo 89,99

(e- Logitech S-150
USB Digital Speaker System

» USB Powered
» Compact Design
(LOS150) o 11,62

CA-3090
Cyber Acoustics ngh Quallty Sound

» Pair of Impeccably Clear Speakers

» Subwoofer w/ Bass
21.99

Violume Control :
» For Gaming, el
Computers, =

MP3 / DVD Players
(CYCA3090) oo

Peavey BTS 5.35

Bluetooth Speaker

» Wireless A2DP Bluetooth Stereo Music

» 30 Watts RMS / 50 Watts Max

» Dual 2.5" Midrange
and Tweeter Drivers

» Down-Firing 5.25”
Subwoofer

(PEBTS5.368)

SonaVERSE UBR
Soundbar

» W RMS Power

» Dual Drivers

» Fits Under
Computer Monitor

» USB-Powered

» Angled Upward for Desk Use

(GOSVUBRTBKEW)....c..occ

184.99

29.95

800-947-3308 - 212-444-6691




R Z€R Kraken Pro 2015

Gaming Headset

» In-Line Volume & Mute Controls
» Large 40mm Neodymium
Magnet Drivers
» Fully Retractable

Microphone Boom
Green (RAKP2015HSGN) ... /oo 69.99
Black (RAKP2015HSBK) ... 69.99

HKOSS" SB4S
Communication Headset
» Dual 3.5mm Plug Connectors

» 18 Hz to 20 kHz Freg. Response
» Soft Leatherette Ear Cushions
» Noise-Reducing Clear

Voice Tech Mic
» Anisotropic Ferrite Magnet Structures

(K0184747)

24.45

Kingston HyperX Cloud I
Gaming Headset
» Hi-Fi Capable 53mm

Dynamic Drivers
» Detachable Microphone
» Padded Leatherette Headband
» Aluminum Construction 1
Black (KIHXH3CLWR). ... 76.99
White (KIHXH3CLW) ..o T1.00

ADY QHM-100

w Stereo Headphones

» Condenser Mic with Flexible Boom
» 40mm Drivers
» Extra-Long 10" Cable
» Inline Volume & Mic
Control » 3.5mm Mini
Female-to-Male Y Cable

(NAQHM1000)

15.99

SONY Uncharted 4
Limited Edition Gold
Wireless Headset

» B7.1 Virtual Surround Sound
» Hidden Noise Canceling

Microphane
» Headset Companion App
» PC & Mac Compatible

(SOWLHSUABLD)...........ccc...

e 19,78

71 sennHEISER PC 333D
Gaming Headset
» Simulated 7.1 Surround Sound

Experience » Noise Canceling

Microphane » On-ear

Cup Vglume Control -—
» Automatic Microphone Mute
» Closed Circumaural Ear Cup Design

[SEPC330D) 179.95

www.BandH.com

71 sennHEISER (GAME ZERO

Gaming Headsets A
e

» Leatherette & Memory -

Foam Pads » Closed Design -
» Noise Cancelling Mic Q
» Ergonomic Acoustic

Refinement e a4
Black (SE506079)............... 189.99
White (SE506064)................ 189.99

HIKOSS" SB45USB

Communication Headset

» USB Plug Headset Connection
» Noise-Reducing Mic

» 18 Hz - 20 kHz Freg. Response
» Soft Leatherette Ear Cushions
» Foldable Design
» Anisotropic Ferrite Magnet Structures

(KOT78203) oo 30,00

G 02

USB Stereo Headphones

» USB Connection to Computer
» Integrated Headphones

and Condenser Mic
» Windows and “.\\

Mac 0S Compatible h
(CAV2) o 39.00
Kingston HyperX Cloud

Gaming Headset

» Hi-Fi Capable 53mm
Dynamic Drivers

» Detachable Microphone

» Padded Leatherette
Headband

» Aluminum Construction

(KIHXH3CLWR) ..o

B ]

SONYY PlayStation Gold
Wireless Stereo Headset
» 7.1 Virtual Surround Sound
» Hidden Noise Canceling MIC
» Headset Companion App

» PC & Mac Compatible

» Mobile Devices Supported

» PS Vita, PS3, & PS4 Compatible

[SOPSAHSG) .o 18,90

Raz€&Rr KrakenUSB
Over-Ear PC Headset
» Virtual 7.1 Surround Sound

» 1.3" Neodymium Drivers
» Unidirectional Analog Mic
» Closed Ear Cup Design

» Extended Gaming Comfort

53,99

(RAKUSBOEHSBK] ..................

GAMING HEADSETS

71 sennHEISER GAME ONE

Gaming Headset

» Plush Velvet Ear Pads

» Cushioned Headband

» Noise Cancelling Mic

» Volume Controls on
Right Ear Cup

(SEB060B0).....oo . 167.68

RKOSS" 5100 USB
Over-The-Head Headset

» PC Voice & Interactive Gaming Use
» Electret, Noise Reduction Mic
» Extended Frequency Response
» Foam Ear Cushions
» Single USB Plug

» 8" (2.4 m) Cord

(KO178188) ..o

i 2218

CREATIVE Fatallty

Gaming Headset
» Dual 40mm Neodymium
Drivers » Detachable, Noise-
Canceling Microphone
» Velvet and Fabric Padding
e_

[CRFGHS) oo 2095
» Included Xbox One

Headset Adapter g

» Stereo Headset, Over-the-Ear Design
(MIXBONESHSB).....ooooo . 4998

Microsoft Xbox One

Stereo Headset

» Unidirectional Microphane
» Game/Chat Balance Buttons
» Volume Control, Mute Button

Kingston HyperX Cloud Il
Gaming Headset
» Virtual 7.1 Surround Sound
» Hi-Fi-Capable 53mm

Dynamic Drivers
» Detachable Microphone
» Auto Gain Control + Echo Cancellation
Red (KIHXHSCPRD) ..o 99.99
Gunmetal (KIHXHSCPGM) ... 99.99
Razer Kraken7.1Chroma

Surround Sound Gaming Headset

» 7.1 Virtual Surround Sound
Engine » Enhanced Digital Mic

» Chroma Lighting

» Razer Synapse Enabled

» Closed Ear Cup Design

» Foldable Ear Cups

(RAK71CSUSBGH) ... 83,99

COMPUTERS

71 seEnNHEISER PC 151
Stereo Headset
» For Computer Games, VoIP
and Skype
» Qver the Head
» Unidirectional Microphone

pa———

(SEPCTHT) ... Call or Log-0n

RKOSS $B4Y
Communication Headset
» 18 Hz - 20 kHz Freq. Response
» Clear Voice Tech. (CVT) Mic

» Oxygen-Free Copper Voice Coils =%
» Soft Leatherette Ear Cushions i
» Volume Control on Cord T

» Foldable Design ——eoB—

(k0186008) 28.77

Plantronics GameCom 380
Stereo Gaming Headset

» 1.5" (40mm) Speakers
» Noise-Canceling Microphone
» On-Ear Volume / Mute Controls
» Built-In Spin Jaints for
Easy Storage
» 3.5mm Audio/Headphone Plugs

(PL8605001) 49.95

TRITTON Kama
Stereo Headset for PlayStation 4

» 40mm Speaker Diameter

» Neodymium Magnets

» Flexible Microphone

» In-Line Controls

» Extends 1.25” on Each Side
» Soft, Swiveling Earcups

(TRKSHS) 29.99

Osteelseries Siberia P800
Wireless Gaming Headset
for PlayStation 4
» Dobly 7.1 Virtual Surround

Sound » 40mm Neodymium

Drivers » Swiveling,

Closed-Back Earcups
» Memory Foam Lined Headband & Earcups

(ST61301) 279.99

RazeRr Tiamat 7.1 Elite

7.1 Surround Sound Gaming Headset

e

169.99

» 10 x Discrete Neodymium
Drivers

» Dual Titanium Coated
Bass Drivers

» Retractable Noise-
Filtering Microphane

(RASAGHS)




(ele] VUi I MICE & TRACKBALLS / KEYBOARDS

MINI & SLIM MICE

B0

Wired

STANDARD MICE

L

Wireless

Wireless Wired

Apple Gyration Dell Apple Adesso Kensington Adesso Microsoft 3Dconnexion Logitech Macally
Magic Mouse 2 | Air Mouse Mobile WM615 Wired Mouse iMouse W2 Suretrack Any Surface| iMouse M300W | Mobile Mouse 4000 CAD Mouse M500 3-Button Mouse
Bluetooth 2.46Hz Wireless Bluetooth Touch-Sensitive Buttons USB Bluetooth Bluetooth 2.4GHz Wireless Braided USB USB UsB
(APMLAOZLLA) (6YGYM2200) (DEWM615BDF) (APWM) (ADIMOUSEW?) (KEK72437AM) [AD3BOSMMWWT) | (MIWLMM4000B) (3DCADMSE) (LOM500) (MAIM2)
78.00 52.96 30.95 47.99 21.95 36.95 20.59 18.92 93.00 24.68 $9.99
GAMING & ERGONOMIC MICE TRACKBALLS VERTICAL MICE TRACKPADS

\%—-—-
— ]

Wireless Wired [ Kensington | Kensington | Evoluent | 3M | _ Apple
Razer Logitech Razer Razer Razer SlimBall Trackball | Expert Trackball | VerticalMouse 4 EM500GPL Magic Trackpad 2 | Motion Controller
Mamba Gaming MX Master . Mamba Tournament | Naga Expert DiamondEye Optical | Avoids Forearm Vertical-Handle oL ;
Mouse Wireless Orochi Edition MMO UsB Tracking Technology Twisting Design Bluetooth 150° Field of View
Wireless with Bluetooth &RF | Dual Wired/Wireless . . Built-In
Charging Dock Wireless Connectivity 3B UsB Multleaul?ctmn Scroll Ring A USB/PS2 Rechargeable Motion Control
16000dpi56 | Darkfield Laser | 8,200 dpi 46 1600065 8200 cpi Precision Right Hand (EVVMAW) Battery
Laser Sensor Works on Glass Laser Sensor Laser Sensor 46 Laser Sensor Media Mode Wrist Pad 104.99 Thumb Button bx 45" Free Apps
(RAMCERGM) (LOMXMWLM) (RA0B200CMGM) (RAMTEEGMB) (RANEMMOGM) (KEK723270) [KEMEPU) LeftHand (EVM4L) |  (3MEMS500GPL) (APMJZR2LLA) (LELMCO1US)
119.99 7459 69.99 69.99 64.99 74.99 66.99 81.90 55.76 121.00 69.99
Santard RENBOARDS I TR
Apple Keyboard Apple Magic Keyboard
Anodized Aluminum Enclosure . Ben mEg i +H . : Bluetooth
[ [} i [ e
Low Profile Keys [ I . ] : J'_l'_ e ——- = Scissor Mechanism for Keys
Two USB 2.0 Ports TR 4 Low Profile, Compact Design
[APMBITOLLB) ..o 4849 (APMLAZZLLAY ..o 96.83

Microsoft All-in-One Keyboard

Wireless Connectivity via USB

Customizable Media Hotkeys

Integrated Multi-Touch Trackpad

[MIN9ZOOO0T ..o 2495
UsB

Tri-Color Backlight

Smk-link Wireless Ultra-Mini Touchpad

Wireless 2.4GHz Transmission

Ergonomic Handheld Design

(QWERTY Keyboard

(SMVPO364) ... 5995
Wireless Distance of up to 30°

Supports Most Phones and Tablets

Membrane Switch Type Connect Three Devices Simultaneously
[AZKBBO5U)....ocococcsnnnn 2145 (L0920006342) ....ccooccecrerrnn 3113
Ergonomic Gaming
Microsoft Natural Ergonomic 4000 AZ10 MGK1
UsB Braided USB
Zoom Slider Kailh Blue Mechanical Key Switches
Multimedia & Internet Hot Keys White LED Backlight
[MIKBNEAOOD)......co. 3495 [AZMOKT) .o Th99
USB RF Receiver USB
Cushioned Palm Rest Slim Chiclet Keys
Thumb Scoop Chroma Backlighting
(MISEKBB)........ (RADSCMCKB).....coo ... 8499
Matias Ergo Pro
3xUSB 2.0 Ports Braided USB
Split Keyboard with 17" Bridge Cable 10-Key Rollover
Anti-Ghosting Circuitry Programmable Backlit Keys
(MAFKAO3Q) oo 199.95 [ O] ) — 159.99

800-947-3308 - 212-444-6691




Microsoft Windows 10 Pro
» Expanded Start Menu —
» Microsoft Edge Web B
Browser » Cortana Digital
Personal Assistant » Snap H
Window Enhancements
» Multiple Virtual Desktops
» Action Center Icon
» Bitlocker » Enterprise Data Protection
64 Bit/OEM DVD (MIFOC08930)................. 129.00
32 Bit/OEM DVD (MIFQc08970) 134.99
32/64 Bit USB Flash Drive (MIWP10FD)..... 199.00
32/64 Bit Download (MIFOC009131).......... 199.99
LO/JACK Laptops
Standard Edition
» Track & Recover Your Stolen
Laptop » Device Lock
Blacks Access Remotely
» Data Delete Erases Personal
Information » Theft Recovery

Team Support » Single Computer
License » 1-Year Subscription

LO JACK

LOLIM 69.95

F.\ Adobe Acrobat

» Edit & Share PDFs
Across Devices

» Document Cloud
Services

» Adobe Acrobat OC
Mobile App Compatible

» Windows Compatible

Pro (ADAPDC20TOW) oo £419.00
Standard (ADASDC2015) ..o 279.00

Microsoft LifeCam Studio

for Business

» CMOS Sensor Technology
» 1920 x 1080 Sensor
Resolution » Up to 30 Frames
Per Second » 5 Megapixel Still
Images » 75° Diagonal Field of
View » 720p HD Video Chat » Auto Focus
from 0.3 to 32.8" » 360° Rotation

MILCSTOBOWCG ... 54.95

(- Logitech' C930e Webcam

» Full HD 1080p Video Calling

» H.264/SVC Video
Compression » 90° Field
of View » 4XZoom in
1080p » RightLight 2
Technology » Carl Zeiss
Certified Lens » Integrated Autofocus »
External Privacy Shutter

LOC930E

Call or Log-on

www.BandH.com

SOFTWARE & WEBCAMS

Micresoft Windows 10 Home
» Expanded Start Menu
» Microsoft Edge Web

Browser » Cortana Personal
Digital Assistant » Snap
Window Enhancements

» Multiple Virtual Desktops

» Action Center lcon

» Touch, Keyboard, & Mouse Support

64 Bit/OEM DVD (MIKW900140)................86.86
32 Bit/OEM DVD (MIKW900186) 99.94
32/64 Bit USB Flash Drive (MIWH10FD) .. 119.00
32/64 Bit Download (MIKW900265) ... 109.99

McAfee Internet Security 2015

» Protects Against Viruses

» Real-Time Protection
from Latest Threats

» Privacy and PC
Optimization Tools

» SiteAdvisor

» Parental Controls

» Anti-Spam Email Filter » Windows Compatible

MCMISTBEBF3R ..ooooooo 14.95

COREL. WordPerfect Office X7
Home & Student Edition

» WordPerfect Word Processor

» Quattro Pro Spreadsheet
Program » Presentations
Slideshow Creator

» WordPerfect Lightning
Digital Notebook

» WordPerfect Address Book

» WordPerfect XML Project Designer

COWPCXTHSB ..o 19.00

Microsoft LifeCam Studio
» CMOS Sensor Technology
» 1920 x 1080 Sensor
Resolution » Up to 30 Frames
Per Second » b Megapixel Still
Images » 75° Diagonal Field of
View » 720p HD Video Chat
» Auto Focus from 0.3 to 32.8'
» 360° Rotation » Wide-Band Microphone

MILCSPL2 52.09

(e- Logitech: Webcam C170
» Supports VGA 640 x 480 Video Calling
» XVGA Video Capture
Up to 1024 x 768
» Take BMP Photos
(Software Enhanced)
» Logitech Fluid
Crystal Technology
» Built-In Microphone with Noise Reduction

L0C170 19.95

Micresoft 0ffice Home 2016
» Microsoft Word ;
» Microsoft Excel Office

» Microsoft PowerPoint

» Microsoft OneNote = !]
» OneDrive Cloud Storage =

STUDENT EDITIONS e
Mac 1-user License (MIGZA00666) ........... 124.94
Windows 1-user License (MI796043¢68)..... 123.99
BUSINESS EDITIONS

Mac 1-user License (MIW6F00501) ......... 179.95
Windows 1-user License (MIT5002375).... 179.95

KASPERYKY Internet Security 2016
» Internet Protection Against
AU Viruses » Protection

Against Online Threats
» Secure Online Banking
and Shopping » Detects
New and Emerging Threats
» Safeguards Your Digital
Identity » Secure Keyboard Against Keyloggers
» Parental Controls » Webcam Protection

KAIS20161Y3U 49.99

INTERNET
SECURITY

|| Parallels Desktop 11

» Travel Mode

» One-Click Performance
Tuning » Use Cortana for
Both Windows & Mac Apps

» Supports Windows 10

RUN WINDOWS

» Ready for Mac 0S X
. ON YOUR MAC
0.17 EL Capitan R
» Supports Linux &
Google Chrome 0S
PADTT1MBOX 66.76

Microsoft LifeCam Cinema
» CMOS Sensor Technology
» 1280 x 720 Resolution
» Up to 30 Frames per
Second » 73° Diagonal
Field of View
» 720p HD Video Chat
» Auto Focus » 360-degree Rotation
» Wideband Microphone

MILCXC 39.95

CREATIVE Live! Cam ChatHD
Webcam
» 720p Online Video
Chatting @ 30 fps
» 5.7MP Still Images
» Noise-Canceling Mic
» One-Click Upload to Facebook and YouTube
» Supports Password Protection Controls

CRLCCHDWC 21.94

COMPUTERS

Microsoft 0ffice 365
» Word » Excel
» PowerPoint » OneNote
» OneDrive Cloud Storage
» Access (PC Only)
» Publisher (PC Only)
» Use on Mobile Devices
» OneDrive + 20 GB

of Storage
» 60 Minutes of Skype Calls Per Month

Personal (MI0365SLPMT) ............ Call or Log-on
Premium (MI66Q00091).........oooooo 84.99

-~ Norton Security 2016 Deluxe
Protects PCs, Macs, Android,
iOS Devices

» Provides Real-Time
Protection » Safeguards
Against Viruses
and Spyware » Stops
Ransomware and Malware

» Manages Usernames and Passwords

» Warns About Unsafe Websites

SYNSD315 60.00

we Dragon NaturallySpeaking 13 Home

Voice Recognition Software

» Standard Headset =
& USB Adapter Included - —
» Increased Productivity e

» Software Adapts to
Learn and Proofreads

» Free Dragon Remote
Mic App » Use with
Microsoft Office and the Web

NUKADAGODTS ..o 79.99

Microsoft LifeCam HD-3000

» 720p HD Video, 30 fps

» 16:9 Widescreen

» Integrated Omnidirectional
Microphone

» TrueColor Technolagy,
24-hit Color Depth

» Movie Maker & Photo Gallery
Software » Skype Certified

MIHD3000 29.95

CREATIVE Live! Cam Sync HD
Webcam
» 720p Online Video
Chatting (@ 30 fps
» 3.7MP Still Images
» Noise-Cancelling Mic
» One-Click Upload to Facebook and YouTube
» Supports Password Protection Controls

CRLCW 19.42
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Pen Tablets
0’! Intuos Pro
uJacom
» 2048 Levels of Pen Pres-

sure Sensitivity » Multi-Touch Support, USB Interface
» Express View Display, Touch Ring » 8 Programmable Express Keys
» Included Wireless Kit » Mac & Windows Compatible
Intuos Small (6.2 X3.9) (WAIPPTS) ............... e 249.95
Intuos Medium (8.8 X 5.57) (WAIPPTM) ............. e 349.95
Intuos Pro (12.8 X 87 (WAIPPTL)

Pen Displays
S Cintig 27 OHD

LUBEDm

» 235x13.2" Active Area
» 27" AHVA'LCD Pen-Only Display

» QHD 2560 x 1440 Native Resolution
» 330 cd/m? Brightness

» 178°/178° Viewing Angles

» 97% Adobe RGB, 1.07 Billion Colors
» 2,048 Levels of Pressure Sensitivity
» ExpressKey Remote

» Included Pro Pen & Pen Stand

» Mac & Windows Compatible

Cintiq 27 QHD Touch (WAC27QHDT)...........cc.c..
Cintig 27 QHD (WAC270HD)

..2,799.95
..2,299.95

AIESS[) CyberTablet 212
=y

» 10x6.25" Surface Area

» 1024 Levels of Pressure Sensitivity
» 12 Programmable Hot Keys

» 18 Programmable Macro Keys

» Handwriting Recognition Technology
» Supports up to 2000 Lines Per Inch
» Included Cordless 2-Button Drawing Pen
» USB Powered

» Compatible with Mac and Windows

ADCTZTZQ e 72.19
®, Q' -
‘ss Intuosk oo Intuosé/5 ‘o9 ProPen
wacom Grip Pen wacom Classic Pen wacom
» Draw, Erase, and Mouse Functions » Slim, Classic Look w/ » Included Spare Nibs

a Natural Feel

» Draw, Erase, and Mouse Func-
tions » Pressure and
Tilt Sensitivities

» Weighted Stand

» Extra Nibs

» Works w/ Intuosé & 5
Generation Tablets

» Pressure and Tilt Sensitivities

» Ergonomic Design, Natural Feel

» Weighted Stand » Replacement
Nibs » Only Works w/ Intuosé
Generation Tablets

WAIGP ... 64,95 WAICP o 64,95

» Included Color Identification Rings
» Compatible w/ Intuos Cintig Tablets
» Compatible w/ Intuos Pro Tablets

WAPPCC ..o

GRAPHIC TABLETS AND DIGITAL PENS

- . .
‘eg Intuos Creative Pen Series

wacom
-

» 6.0x 3.7" Active Area » 1,024 Levels of Pressure Sensitivity » USB Interface
» 4 Programmable ExpressKeys » Pressure-Sensitive, Battery-Free Pen » Corel Painter Essentials

» Mac & Windows Compatible
Intuos Draw (WAIDPSTW)

69.95

Intuos Art (WAIAPTSBK) ...
Intuos Photo (WAIPPTSBK]

99.95
99.95

Intuos Comic (WAICPTSBK)

99.95

?” Cintiq 22HD

UJaCOﬂ'I

» 19.5"x 1157 Active Display

» Mac and PC
Compatible

» USB/DVI-I
Connectivity

» 230 cdm?
Brightness

» 2,048 Levels of
Pressure Sensitivity

» 16-User Assignable ExpressKeys

«

WAC22 1,799.95

RIS Notes 2 Executive

Document to Knowledge™

» Captures Handwritten Notes & Graphs
» Converts Notes into Editable Text

» Full Mouse & Tablet Functionality

» Works Online & Offline

IR457489 89.99

\1/
‘e g ArtPen
wacom'

» Unique 360 Degree
Rotation Sensitivity

» Pressure / Tilt Sensitivity

» Chisel and Bullet
Tipped Nibs » Digital
Eraser » Weighted Stand

» Nib Extractor

» Replacement Nibs

» Works with all Intuosé
& Intuosh Models

WAIAMP .. 84,20

*'! Cintig 13HD

UJEICDI‘H

» 11.8x6.8” Active Area ;

» 13.3" Full HD IPS Touchscreen

» 1920 x 1080 Native
Resolution

» 250 cd/m? Brightness

» 178° Viewing Angle

» 75% Adobe RGB, 16.7
Million Colors

» 2048 Levels of Pressure Sensitivity

» Programmable ExpressKeys & Touch Strips

Cintiq 13HD Touch (WACT3H..............999.95
Cintiq 13HD (WACT3) ... 799.95
2L

oy Bamboo Spark
wacom

» Pocket for Smartphane & Business Cards
» Bamboo Spark Pen » 30-Page Notepad

» 1 Replacement Ink Cartridges

» Nib Removal Too » USB Cable

159.95
159.95

w/ Gadget Pocket (WABSGP)
w/ Tablet Sleeve (WABSTS) ...

‘e’ Bamboo
wacom Capture Pen
» Designed for CTLAT0/471
Bamboo Tablet
» +[-0.25mm
Pen Accuracy
» 16mm Pen
Detection

WABCPBL ..o 29.95

800-947-3308 - 212-444-6691



How to make your Wi-Fi Fly

Want to pump up your home network? Why not infuse a
little Life into it? If | could take my 1991 Geo Prism and make
it run like a Porsche Carerra, why wouldn't I? Why wouldn't
you? With just a few simple products, and a few even simpler
tips, you could turn your Wi-Fi into Wow-Fi. Here are some

questions to ask.

Is my router a dual-band router?
Do I need that?

Maybe. The short explanation is this; Wi-Fi
traffic travels along lanes of bandwidth. The
2.4 GHz is the old country road—everyone
gets on it because it's comforting, it's reliable,
and you've been traveling on it since you were
a kid. But if you take a quick look to your left,
you'll see a brand-new, four-lane highway
that has much less traffic, and on which cars
are flying by. That's the 5.0 GHz lane. A dual-
band router lets you travel on either lane, and
even combines the lanes so that you can in-
crease your traffic and download speed. Hop
on the fast lane with a dual band router.

Is my router capable of Gigabit
Ethernet speeds?

It may say that on the box, but don't expect
10/100/1000 Mbps of traffic just yet. Your
router’s speed is dependent on the incom-
ing line. If you're using DSL or dial-up, that
will dictate the speed of traffic through your
network. You can't buy a Gigabit speed router
and expect to see your DSL connection in-
crease exponentially.

Who's Afraid of the Big Bad Wi-Fi?

Consider the home in which you're setting up
your network. Think about how many walls
the signal will be bouncing from, whether
those walls are made of wood, or brick, and
how many levels there are in your house. Do
you want the same strength from your signal
that you get sitting next to the router as you
do sitting two floors and six walls away from
the router? Then you should consider some
type of extender or booster [more later). Solid
metal doors or aluminum studs will impact
your signal negatively, as will objects such as
walls with insulation, water (as in fish tanks),
mirrors, file cabinets, brick, glass, steel, met-
al, and concrete.

WM COMPUTERS @-

Wi-Fi Range

Extender

Is my signal leaking?

Does your Wi-Fi seem slower for no reason
at all? You should consult some readily avail-
able online software for that. There are nu-
merous and very simple ways that hackers
can crack your Wi-Fi password within min-
utes of you setting up your network. Invest in
software that shows who's using your con-
nection, and keep tabs on it constantly. That
neighbor who borrows a cup of sugar and
never returns one? They're probably piggy-
backing on your Wi-Fi, too.

What's the difference between a
bridge, extender, access point, and
router (also, the NFL and CFL)?

The short answer is this: The NFL plays foot-
ball. About the other Wi-Fi stuff, try this on
for size. A router, also known as a wireless
access point, is a complete package. It con-
tains the capabilities of all the other terms,
and can be configured as an access point,
extender, and repeater. But an access point,
repeater, and extender cannot perform many
of the functions that a router does.

So, let's clear up some more terminology.
What's an Access Point? Basically, any router
is an access point. You use a router to access
the signal on another machine. Some rout-
ers only use wired connections, while most
produced today use wired and Wi-Fi connec-
tions, so you're not running wires like a sci-fi
movie to every device in the house.

AWi-Fi bridge is basically a device that con-
nects two wired networks over Wi-Fi. So, you
have a wired network, and in another room,
you have a computer without wireless capa-
bility (or a game console that you want hard-
wired). You use a bridge to latch onto the
signal from the router, catch it, and transmit
it to another router, which can now be hard-
wired to your other computer or game con-

T

l--—---- Existing Wi-Fi

sole. What you've done is create a “bridge”
for the Wi-Fi signal, to extend it—which is
why bridges and extenders are often mis-
taken for the same thing. What sets a bridge
apart from an extender is that an extender
may not have Ethernet jacks, and usually
just extends the signal.

Do | need a modem?

Yes. A modem brings your Internet into the
home, and resides between your incoming
signal and your router. Some modems now
come with routers built in, but the typical
setup has your ISP providing the modem,
and you providing the router.

Plug-and-Play with PowerLines

A Powerline adapter is a device that plugs
into a wall and uses the current wiring in
your home to extend a Wi-Fi signal. Say you
have a router downstairs, but your game
console is upstairs. You connect one of the
adapters in this kit to your router and then
into a wall outlet near your router, and then
plug the other adapter into the outlet in
the room with the game console. Now you
have extended the signal to the room with
the game console. Magic. Disadvantages to
PowerLine networks? Slower speeds and
limited connection options.

Need a Boost

Some users will not want to add to their
network and simply need a small boost to a
weak signal. Antennas and boosters can add
some power to your signal, and can cut down
on the noise level of competing technologies
[your microwave and cordless phones are
your biggest culprits).

And that's a basic breakdown. With this in-
formation in hand, go out and see if you
make your Wi-Fi fly.
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00 i AirPort Extreme
Base Station
» Simultaneous Dual-Band 802.11ac
Wi-Fi. WPA/WPA? Encryption
» NAT Firewall, USB Port

» 3 Gigabit Ethernet LAN Ports \/:
(APAPEQ) 179.99
TP-LINK

Archer C9 AC1900 ALl
» Dual-Band Gigabit Router ~
» 802.11afb/g/n/ac Wi-Fi Netwark o

» 1900 Mbps Total Bandwidth
» Dual-Band 2.46Hz / 5.06Hz Frequencies
» 4x10/100/1000 LAN Ports, T x WAN Port

(TPARCHERCY) ..o 149.95

NETGEAR R7000
Nighthawk AC1900 Smart-Router

O s AirPort Time Capsule

» Simultaneous Dual-Band 802.11ac o
Wi-Fi. WPA/WPA? Encryption |

» NAT Firewall, USB Port

» 3x Gigabit Ethernet LAN Parts

3TB (APAPTC3)

2TB (APAPTC2)

TP-LINK
Archer C7 AC1750

» |EEE 802.11 a/b/g/n/ac
» Up to 1.75 Ghps Total
Bandwidth » 2.4 GHz / 5 GHz Frequencies
» 4 x10/100/1000 Mbps LAN Ports
» 1x10/100/1000 Mbps WAN Port

(TPARCHERCT) 89.89

ofeer]ee RVI3OW
CISCO Wireless-N VPN Router

WIRELESS ROUTERS

WIRELESS NETWORKING

/15> RT-AC68U wireless
Dual-Band Gigabit Router
» 802.17ac Protocal » Up to
1734 Mb/s at 5 GHz
» Dual-Band 2.4 GHz/5 GHz
» File, Printer & 36/46 Sharing
[ASRTAC68U) 189.95

TP-LINK

TL-WR841IN N Router

» Up to 300Mbps @ - )
» 2.4-2.48356Hz —

» Easy Setup Assistant '
» Quick Security Setup » SPI Firewall

» Dual 5dBi Omni Directional Antennas
(TPTLWRB4IN) 24.95

D-Link AC3200 wireless
Tri Band Gigabit Cloud Router

/iSUS RT-AC5300 Tri-Band
Wireless Gigabit Router

» 802.1ac WiFi Protocol
» Up to 5334 Mb/s at 5 GHz
» Dual-Band 2.4 GHz/5 GHz
» File, Printer & 36/46 Sharing
(ASRTACH300) .. 373.27

(& TRenDnet TEW-823DRU
» Wireless Network Speed
» Dual-Band 2.4 GHz /

5.0 GHz Frequencies
» 4 x Gigabit LAN Ports
» 1xWAN Port » USB Share Port
» One Touch Setup with

WPS Button

(TREW823DRU) 74.95

LINKSYS' WRT1900AC
» Wireless 802.11a/b/g/n/ac Compatible

» Wireless 802.11ac » 802.11b/g/n Wi-Fi Standards » 802.11a/g/nfac Protocol 802.3/3u Protocol » Dual Band 2.4 / 5 GHz
1900 Router » Up to 800 Mbps NAT » Upto 3.2 Gbps » 1.2 GHz Dual-Core
» 2.46Hz & 5GHz Dual Band » 2.4 GHz WLAN Frequency » Tri-Band: 2.4 GHz ARM Processor
» bx Gigabit Ethernet Ports » 4 x Gigabit Ethernet LAN &Dual 5.0 GHz » 128MB Flash / 256MB DDR3 RAM
» 1xUSB 3.0, 1x USB 2.0 and WAN Ports » USB 36/46 Modem Sharing » Four Gigabit LAN Ports » 4 x Gigabit LAN Ports » USB 2.0/ 3.0 Ports
(NER7000T00PA) .. 189.95 [CIRVIZOWAKIA) ..o 81.94 [DLDIRBIOLR). ..o .289.95 (LIWRTT900AC) oo Call or Log-on
WIRELESS ACCESS POINTS
«J UAP-AC-PRO (J UAP-PRO &) UAP-AC-LITE J UAP
UBIQUIT! UniFi Access Point UBIQUITI UniFi Access Point UBIQUIT! UniFi Access Point UBIQU UniFi Access Point
» 802.11 afblg/n » 802.11 a/blg/n » 802.11 a/blg/n » 802.11 b/g/n Wi-Fi
Wi-Fi Standards Wi-Fi Standards Wi-Fi Standards Standards
» Range of up to 400° @ » Range of up to 400° » Range of up to 400° @ » Range of up to 400°
» 1 x Ethernet Ports » 2 x Ethernet Ports » Ethernet Ports & Speed of 300 Mb/s
» Integrated Omni Antennas » 5/4 dBi Omni Antennas » Integrated Omni Antennas » UniFi Controller Software
(UBUAPACPRO) 189.95 (UBUAPPRO) 199.95 (UBUAPACLITE) 83.99 (UBUAP) 58.95

08 sumoissarcsaes AirPort Express
Base Station
» Simultaneous Dual Band
802.11n / Wi-Fi
» Easy Setup from iPhane,
iPad, iPod » Extend Wi-Fi Range
» Supports 2.46Hz and bGHz Frequencies
» Plays iTunes on Any Speaker
(APAPEBSTUSA) ...oooo oo 93.99

afraln WAP371 Dual Radio
CISCO Access Point
» 802.11a/blg/nfac
Wi-Fi Bands R 1)
» 2.4 GHz and b GHz Fregs \ '
» 3x3 MIMO Technology
» Integrated 2 dBi Antenna
» 10/100/1000 Ethernet » Power over Ethernet

[CIWAPSTIAKD) ..o 178.01

EnGenius EAP400

Indoor Access Point

» Dual Band Wireless for
Expanded Capacity a

» Wireless N600 Speed S

» Long-Range for Multi-Floor Penetration

» Industry Standard Security » SSID-to-VLAN
Tagging » 802.3at/af PoE Compatible

(ENEAP600) 119.99

sl WAP321 selectable-
CISCO Band Access Point

» Up to 300Mbps

» Supports 802.11b/g/n Wi-Fi

» 2.46Hz or bGHz
Selectable-Band

» Power over Ethernet (PoF)

» WEP/WPA/WPA2/WPS Security

(CIWAP321AK9) 144.95

300MBps Access Point

» |EEE 802.11 b/g/n Standards

» 2417 ~ 7.472GHz Frequencies

» Designed for Outdoor Deployments

» Infrastructure & Ad-Hoc Modes ‘
» Up to 300Mbps Data Transfer Speeds

» Internal High-Gain 10dBi Antenna
(ENH202) 79.99

EnGenius ENH202 [

e,

TP-LINK

TL-WABOIND

» Up To 300 Mbps Data Rate
» |EEE 802.11n Wireless

» 2.4 - 2.4835 GHz

» 2x 4dBi Detach. Antennas » MIMO Technology
» WI-FI Setup Compatible (0SS)

» Power Over Ethernet: Up To 100°

(TPTLWABOIND) 22.38

/i=SU= N-300 3-in-1 Router/
Access Point/Range Extender
» 802.11n Speeds up to 300Mb/s
» 7 x Detachable 5 dBi Antennas
» 2.4 GHz Operating Frequency
» 1xRJ-45 Port for 10/100 Base
T for WAN
» 4 xRJ-45 Port for 10/100 Base T for LAN
(ASRTN12D1) 37.06

LINKSYS" WAP300N

Dual-Band Access Point
» 802.11a/b/g/n Wi-Fi Compliant
» Dual Band 2.4 GHz &5 GHz
Frequencies
» 1 x Fast Ethernet Port
» Power/WPS/Ethernet/Wireless LEDs
» Up to 300 Mbps Data Throughput
(LIWAPSOON) ..o 77.4077.40

800-947-3308 - 212-444-6691



WIRELESS NETWORKING

NBE-5AC-19 NanoBeam ac

» airtMAX Technology » Atheros e

MIPS 74K, 720 MHz Processor -
» 128MB DDRZ, 8MB Memory {
» 1x10/100/1000 Ethernet Port

[UBNBEBACTIUS) ... 99.00

EnGenius ENH500 High-Powered,
Long Range 5 GHz Outdoor Bridge
» 600mW High Power Long Range
» Up to 1 mile Coverage » Wireless

N300 Speed » 2 Fast Ethernet Ports bl
» Internal 13 dBi Directional Antenna
» |Pb5 Waterproof Housing

(ENENH500) 81.99

(J NanoStation5 outdoor

» Atheros AR2313 S 180MHz Processor S5
» 16MB SDRAM, 4MB Flash Memory _

» 10/100 BASE-TX Ethernet Interface !

» 2 x 14dBi Dual Polarity Antennas P

(UBNSM5) 82.99

EnGenius ENH500 High-Powered,
Long Range 5 GHz Outdoor Bridge
» 600mW High Power Long Range
» Up to 1 mile Coverage » Wireless

N300 Speed » 2 Fast Ethernet Ports Ll
» Internal 13 dBi Directional Antenna
» |P55 Waterproof Housing & Mount Kit

[ENNENHBOOKIT) oo 163.95

TP-LINK RE210AC750
Wi-Fi Range Extender
» 802.11ac Wi-Fi Standards
Compatible » 2.4 GHz /5 6Hz
Dual-Band Connectivity ‘;‘\‘
» Up to 750 Mbps Bandwidth i
» Gigabit Ethernet Port -

(TPRE210) 69.95

D-Link DAP-1320

Wireless Range Extender

» |EEE 802.11 n/g Standards

» Extend Internet Access 3

» 1 Internal Antennas N

» WPA, WPAZ, WPS '
Security Encryption N

(DLDAP1320) 39.95

TP-LINK AC750
Wi-Fi Range Extender

» High Power Long Range Coverage

» Up to 1 mile Coverage

» Wireless N300 Speed

» Internal 13 dBi Directional Antenna .
» |Pbb Waterproof Housing -

(TPRE200) 37.99

NETGEAR WN3000RP
Wi-Fi Range Extender

TP-LINK TLWN823N
Mini Wireless N USB Adapter
» 802.11b/g/n Compatible =
» Up to 300Mbps

Data Transfer Speeds
» USB 2.0 Interface
» Soft AP / Client Mode Compatible

(TPTLWNBZ3N) ..o 14.97

(intel‘) Wireless-AC 7260

Dual Band Adapter

» PCle/USB System
Interface

» 802.11a/b/g/n/ac
Wi-Fi Network Standards

» 2.4 GHz & 5 GHz
Operating Frequencies

(IN7260HMWWBR) .....ccccoe 25.75

WIRELESS BRIDGES

WIRELESS RANGE EXTENDERS

COMPUTERS

() NBE-M5-16 GHz16dBi

» airMAX Technology ~
» Atheros MIPS 74Kc, 560 MHz \
Processor » 64MB DDR2, %
8MB Flash Memory » Ethernet Port
(UBNBEMS16) 62.80

EnGenius ENS500 High-Powered,

Long-Range 5 GHz Outdoor Bridge

» 400mW Power Delivers Long-Range
Coverage » Up to 300 Mb/s Wireless
Speed » Backward Compatible to
802.11b/g » Dual Polarity 8 dBi e
Directional Antenna L B

(ENENS500) 69.99

U NBE-5AC-16 NanoBeam

» airMAX Technology o«
» Atheros MIPS 74Kc, 720 MHz

Processor » 128MB DDRZ,

8MB Flash Memory » Ethernet Port

(UBNBESAC16) 75.75

EnGenius ENS202 High-Powered,
Long-Range 2.4 GHz Outdoor Bridge
» 400mW Power Delivers Long-Range

Coverage » Up to 300 Mb/s Wireless

Speed » Backward Compatible to

802.11b/g » Dual Polarity 8 dBi

Directional Antenna

(ENENS202) ..o 59.99

TP-LINK TL-WA854RE

300 Mb/s Wi-Fi Range Extender

» |EEE 802.11b/g/n Wi-Fi Network
Standards » 2.4~2.4835 GHz
Frequency » 2 x Internal Antennas
» Up to 300 Mb/s Data Transfer Rate bo)
» Plug & Play Configuration

(TPTLWABBARE) 19.95

/I=SU=S RP-N53 neoo

Dual-Band Range Extender
» |EEE 802.11 afb/g/n Network

TP-LINK TL-WA850RE
300 Mb/s Wi-Fi Range Extender
» 10/100M Ethernet Port (RJ-45)

Interface » 2.4 to 2.4835 GHz

Frequency » Flexible Deployment
» 7 x Internal Antennas
» bx Signal Indicator Lights

(TPTLWAB5ORE) 19.45

amped|wirelessﬂﬁ AC1750
Plug-In Wi-Fi Range Extender

» Wireless Signals up to 10,000°

» Extends Wireless Coverage " ]
» Universal Compatibility » Ethenet Interface - » 802.11a/b/g/nfac Wireless Standard
» Easy Install - No CD Required » 2x On-Board PCB Antenna 3 7 Upto 1750 Mbps Data Transfer = o
» Connect Your iPad, Sma[tphones . » 2485 6Hz Ope[atmg FFEQUBHCY t » Dual Band 2.4 GHZ/5 GHz Freq_ 4
» Extends Range of Any Wireless Router » 80211 afblgfn Data Rate » RJ-4510/100/1000 Mbps LAN Port
(NEWN30OORP) ... 59.95  ASRPNGI) 60.00  (AMRECI3H 119.00
WIRELESS ADAPTERS
TP-LINK TL-WN722N (& TRenDner TEW-648UBM =nimax EW-7811UN
High Gain Wireless USB Adapter N150 Micro USB WiFi Adapter Nano USB WiFi Adapter
» Wireless N Speeds » USB 2.0 » Compliant With » USB 2.0 » Compliant With e
Up to 150 Mbps IEEE 802.11n Standard |EEE 802.11b/g/n Standard
» Compliant with IEEE 802.11n » One-Touch Wireless Connection NN » Data Rate Up to 150 Mb/s
» USB 2.0 » 64/128-bit » QoS Data Prioritization » Increases Wireless Coverage by 3x
WEP /WPA/2/PSK/2-PSK /9; » Ultra Compact Form Factor » Green Power Saving & Internal Antenn
(TPTLWN722N) ..o 13.44 / (TRTEWEABUBM) ...ooooo oo 9.69 (EDEW7811UN) 9.95

SUS AC1900 pcie
Dual-Band Wireless Adapter

» 802.11ac Wi-Fi Standard

» Broadcom TurboQAM
Hardware

» Flexible Extended Antenna

Placement - ’
» bth Generation 802.11ac Chipset R

[ASPCEACG8) 94.99

/1SS PCE-AC56 AC1300
PCle Dual-Band Wireless Adapter
» 802.17ac Wi-Fi Connectivity
» 2.4 &5 GHz Frequencies
» Broadcom TurboQAM

Technology » Up to

1300 Mb/s Data Transfer Rate
» WEPMWPAMPA? Encryption 4’

[ASPCEACS6) 63.78

TP-LINK TL-WNS8IND

Wireless N PCI Express Adapter

» |EEE 802.11b/g/n Standards -
Compliant

» PCl Express 2.0

» 2.4-1.4835 Frequencies

» 300Mbps Wireless N PCI Adapter

» 20dBm Wireless Transmit Power

(TPTLWNBBTND).....occc 18.98



COMPUTERS

NETWORKING

) veoum EdgeSwitch
24 Port Managed Switch w/SFP
» 2hx Giga-

bit Ethernet Ports » 2x 1 Gbps SFP Ports
» 250 Watt Max. Power Consumption
» Auto-Sensing IEEE 802.3af/at PoE
(UBESZA250W) ... 399.00

ot ter]ee SG300-10PP-K9
CISCO 10-Port Switcher

» 2% Combo _

mini-GBIC Ports » 8x 10/100/1000 PoE+ Ports
» QoS Support » IPv4 / IPv6 Support
» Advanced Security Management
» Auto Voice VLAN Capabilities

[CISG300KINAD ..o 189.00

D-Link TL-S6108E

8-Port Easy Smart Switch

» 8x10/100/1000 4
RJ-45 Parts

» Netwark Monitoring » Traffic Prioritization

» VLAN Features » 80% Power Saving

» |EEE 802.3x Flow Control

(TPTLSG108E) 35.28

J veourr UniFi Managed

PoE+ Gigabit 24 Port Switch

» Process == Ssmmmsanamn
All Ports at Line Rate / No Loss

» Upto 26 Gbps Non-Blocking Throughput

» 52 Gbps Switching Capacity

(UBUSZAZB0W) oo 1369.99

llllnllll $6300-10
CISCO 10-Port Switcher

. TN

mini-GBIC Ports » 8x 10/100/1000 PoE+ Ports
» QoS Support » IPvA [ IPv Support
» Advanced Security Management
» Auto Voice VLAN Capabilities

(CIS630010) 132.14

D-Link TL-56108
8-Port Desktop Switch

" Authorized THUNderbolt to
Reseller  Ethernet Adapter

I i
» Supports 10/100/1000BASE-TNetworks
» Small & Compact

(APMDA63LLA) 29.99

LINKsYS' USB3GIG
USB 3.0 Ethernet Adapter
» Gigabit Ethernet
Speeds
» Upto 328°
(100 m) Range
» Up to 30 W Power
» Fast, Easy Setup and Installation
(LIUSB3616) 22.43

(ONNET TWIN10G-TB2

10GbE Dual-Port 10 Gigabit
Ethernet Thunderbolt 2 Adapte

» 2 x Thunderbolt 2
Connectors

» 1 x RJ-45 Connectors

» Adds 10GbE Connectivity

» Supports Wake-on-LAN, Transparent Failover

[SOTWINTOG) - 479.99

NETWORK SWITCHERS

J vsoum TS-8-PRO
TOUGHSwitch Pro 8-Port Controller
» 8x10/100/1000

Ethernet Data Ports
» 1x10/100 Ethernet Management Port
» MIPS 24K, 400 MHz Processor
(UBTS8PRO) 169.41

otlar]re SG6200-08
CISCO 8-port Eathernet Switch

» 810/100/1000
Ports
» 2x Combo mini-GBIC Ports
» (oS Support » IPv4 [ IPvé Support
» Advanced Security Management

(CIS620008) 69.50

NETGEAR ProSafe
5-Port Desktop Switch

J vereum TS-5-POE

TOUGHSwitch Pro 5-Port Controller

» 5x10/100/1000 —
Ethernet Data Ports

» 1x10/100 Ethernet Management Port

» MIPS 24K, 400 MHz Processor

(UBTS5POE) 87.99

otfrar]ee SG110D
CISCO g-Port Network Switch

» § x Ethernet Ports

» Fanless Design

» 802.3/3u/3ab/3z/3x
Network Standards » 16 Gbps Switching
Capacity » 11.9 Mpps Forwarding Capacity

(CIS6110D08) 44.95

& TRENDneT TEG-S506
5-Port GREENnet Switch

» |EEE 802.3 Full Duplex Flow Control
» Power Conserving Design

(TRTEGS506) 19.99

» IEEE802.3/3u/ 4 » 5 Parts
Jab/ .3x Stds » 10/100/1000
» 8x10/100/1000 Mbps Ethernet Ports Mbps Gigabit
» Fanless Design Ethernet
» Store and Forward Transfer Method » Up to 2000 Mbps in Full-Duplex Mode
(TPTLSG108) 24.95 (NEGS105NA) 31.95
NETWORK ADAPTERS

" Authorized USB Ethernet
Reseller Adapter
» USB 2.0 to 10/100BASE-T

Fast Ethernet
» For MacBook Air - "
» Mac 0S Xv.10.4.8

or later

[APMC704LLA) 21.99

StarTech<om JSB31000S
USB 3.0 to Gigabit Ethernet
NIC Network Adapter
» Gigabit Ethernet Port
» Meets IEEE 802.3/ufab
Standards
» Crossover Detection
& Auto-Correction
(STUSB31000S) 26.99

RRQNUSE SANLink2

TECHNOLOGY, INC.

20 Gb/s Thunderbolt 2 to 10G
Base-T Ethernet Bridge Adapter

» Full Duplex @ 10 Gb/s

» Auto-Negotiate -
with 1Gb/s

» Daisy-Chain Support > Dual Thunderbolt 2

Ports » Dual 10GBase-T Ethernet Ports
(PRSL2TB210E) oo -499.00

€ TRENDNeT TU3-ETG
USB 3.0 to Ethernet Adapter
» SuperSpeed USB 3.0 Part g—
» USB Data Rates

up to 5 Gbfs — [~
» Windows and Mac Compatible _
» LED Indicator » GREENnet Technology

(TRTU3ETG) 18.49

kanex KU3CGBT
USB-C to Gigabit
Ethernet Adapter
» connect your MacBook/ -
Chromebook or any other 1
USB-C ready computer
directly to Internet.

(KAKU3CGBT) 14.95

BRGNS SANLink2

TECHNOLOGY, INC.
Thunderbolt 2 to 8 Gb/s FC

» Dual 8 Gb/s Fibre Channel Ports
» Dual 20 Gb/s

Thunderbolt 2 Ports -
» Daisy-Chain Support
» Includes Thunderbolt Cable
» Mac Compatible
(PRSL2TB28GA) ..o 725.00

£ TRENDNeT TU2-ET100
USB 2.0 to Ethernet Adapter
» USB 2.0 o ~

to 10/100Mbps \

Fast Ethernet
Adapter

(TRTU2ET100) 12.96

TP-LINK T6-3468
Gigabit PCI Express

Network Adapter

» 1 x Gigabit Port

» 10/100/1000Mbps Half-Duplex
» 20/200/2000Mbps Full-Duplex
» 32-bit PCl Interface

» LED Status Indicators
(TPT63468) 11.58

™ EOX95AA

Ethernet 1210-T1 b
GbE Network Interface Card

» 1xRJ-45 Connector

» PCle x1 Host Interface |

» Intel 1210 GbE Controller

» Audio Video Bridging (AVB) Support

» ECC Memory Support » DMA Coalescing

(HEEOX95AA) 39.00

800-947-3308 - 212-444-6691



TP-LINK TC-7610

DOCSIS 3.0 Cable Modem

» Compatible with Most Major ISPs

» Eliminate Monthly Fees

» DOCSIS 3.0, 2.0, 1.1, & 1.0 Compatible

» Channel Bonding 4 Upstream

(TPTC7610) 54.99

NETGEAR (6300-100NAS
Dual Band Wireless-AC1750

Wi-Fi Cable Modem Router

» 802.11a/b/g/nfac Wi-Fi Standards

» DOCSIS 3.0 Modem

» Dual-Band 2.4 GHz / 5.0 GHz Freq.

» 4 x Ethernet Ports, 1 x USB 2.0 Port

[NECO300TOONS) ..o 194.95

ARR1S SBG6580 SURFhoard
DOCSIS 3.0 Cable Modem

» 802.11a/b/g/n Wi-Fi

» Female F-Connector Interface

» 4 x Gigabit Ethernet Ports

» SNMP v2 &v3 Network Managemen
[ARSBG6580) 129.95

NETGEAR CM600 tigh speed
DOCSIS 3.0 Cable Modem

» 1 Gigabit Ethernet Port

» Supports DOCSIS 3.0 Standard

» Pvé Compatible

» Advanced Quality of Service Support

» 128MB RAM / 8MB NOR Memory

[NECMOOOBLK). ..o 129.95

TP-LINK TL-PAS010PKIT
AV1200 Gigabit Passthrough
Powerline Starter Kit

» HomePlug AV / AV2 Compliant

» Gigabit Ethernet Port and

Power Socket per Adapter
» 984’ (300 m) Range -
(TPTLPABDTOP)....oo 69.99

LINKSYS' Powerline AV
4-Port Network Adapter Kit
» High Speed of up to

200 Mbps
» 128-bit Encryption
» Connects to Any Device with Ethernet
» Pairs with Any Linksys E-Series Router

(LIPLSKAOONP) 62.49

TP-LINK TL-WPA:220KIT
Wi-Fi Range Extender AV500
Powerline Edition

» IEEE 802.3/3u Ethemet \
» IEEE 802.11b/g/n Wi-Fi e
» 2x10/100 Ethernet Ports * &~

» 984°/300 m Range Over Electrical Circuit

(TPTLWPAG220K).....cccc 49.99

LINKSYS' Powerline AV
1-Port Network Adapter Kit
» High Speed of up to

200 Mbps
» 128-bit Encryption
» Connects to Any Device with Ethernet
» Pairs with Any Linksys E-Series Router

[LIPLEKAOONP) .. 35.49

() INS-8023AF-0

802.3af Outdoor Adapter
» Transforms PoE devices /
into 48V, 802.3af- .

compliant products
» Works with 802.3af switches

(UBINSB023AF0) 20.99

AXISa T8134

60W High PoE Midspan with

Data Connectivity

» |EEE 802.3at &
|EEE 802.3af
compliant

» For indoor
applications

(AX5900334) 148.95

www.BandH.com

() POE-24-12W-G

» Provides grounding
» Protection against surge,
clamping, maximum surge
discharge, and peak pulse current
» Provides protection against ESD attacks

(UBPOE2ATZWG) ....occccce 16.95

AXISa T8120

Power over Ethernet Midspan

» 154 Wof
Maximum Power
» |EEE 802.3af Compliant \
= L
(AX6026204) 57.99

POWERLINE ADAPTERS

NETWORKING

COMPUTERS

TP-LINK Archer CR700
Dual Band DOCSIS 3.0

Cable Modem & Router
»802.11ac Network Std Compatible

» Up to 1750 Mbps Data Throughput

» Dual-Band 2.4 GHz /5.0 GHz

(TPARCHRCRTO0) .. .159.99

NETGEAR N300
Wi-Fi Cable Modem Router
» 802.11b/g/n Pratocol

» Up to 340 Mb/s

» Single-Band 2.4 GHz Frequency

» Two 10/100/1000 Ethernet Ports

» USB 2.0 Port

(NEC300OTOONS) ..o 89.75

TP-LINK TC-7610

DOCSIS 3.0 Cable Modem

Kit with TrendNET
TEW-823DRU Router

» Cable Modem

» 802.17ac Wi-Fi Compatible Router
(TPTC7610RK) 82.94

NETGEAR CM400
DOCSIS 3.0 High Speed
Cable Modem

» Speeds up to 340 Mbps

» 1x Gigabit Ethernet LAN Port

» 1x WAN Cable/Coaxial Connection
» Gigabit Ethernet with Auto-Sensing

(NECMAOOTOONS) ..o 59.95

TP-LINK TL-WPA4220
AV500 Wi-Fi Powerlin@TP

Extender Ms,

» HomePlug AV Standard @ '|||

» |EEE 802.3 / 3u Standards ‘% b _

» |EEE 802.11b/g/n Standards
» 7 x Ethernet Ports Pair, Reset, Wi-FiButton

(TPTLWPAG220) ..o 42.99

D-Link DHP-701AV
Powerline AV2 Network

Extender Kit =

» |EEE 802.3 / 3u Network = =
» HomePlug AV &

HomePlug 2 Compatible -
» Gigabit Ethernet Interface
(DLDHP701AV) 89.95

TP-LINK  TL-PAZ010KIT
AV500 Nano Powerline Adapter
Starter Kit
» HomePlug AV standard

compliant
» High-speed data transfer

rate of up to 500 Mb/s » Miniature design

(TPTLPAADTOK...oc 34.99

ZyXEL PLA5206KIT

Powerline Ethernet Adapter Kit

» Includes 2 x Powerline nan o
Network Adapters

» HomePlug AV2 : :
Compliant e

» Up to 1000 Mbps Data Transfer Rates

(ZYPLAB20BKIT) ..o 79.16

J  INS-8023AF-|
UBIQUITT 802,3af Passive PoE to
802.3af Indoor Adapter
» Transforms PoE devices

into 48Y, 802.3af- 1 =

compliant products
» Works with 802.3af switches

(UBINSBOZ3AFI)....cco 18.99

TP-LINK TL-POE150S

Power Over Ethernet Injector

» |EEE 802.3, 3u, 3af Compliant

» 1x10/100/1000M
LAN Port

» 1 x Power Socket
(DCIN)

» 1x10/100/1000M PoE Port

(TPTLPOETB0S) e 17.43

) POE-24-24W-G
UBIQUIT! poE 1A Gigabit Adaptor
» 1 x Gigabit LAN/1 x PoE Port
» Remote Reset Capability
» 80+% Efficiency
» 65 kHz Switching Frequency
» |EC-320 C6 AC Connector

(UBPOE2A2ZAWG) ....occcc 17.95

TP-LINK TL-POE10R

Power Over Ethernet Splitter

» EEE 802.3, 3u, Jaf Standards
Compliant

» 1x10/100M Auto-
Negotiation PoE Port

» 1x 10/100M Auto-Negotiation
LAN Port » 1 x Power Socket (DC 0UT)

(TPTLPOETOR) 13.1




COMPUTERS

” 10-Port Powered USB
XceLron® 3.0 Aluminum Hub

» 10 x USB 3.0 Ports

» AC Powered

» 1xLED Indicator per Port

» Up to 5Gbps Transfer
Speed Per Port

XCUSBIOPHVZ.......oovccs 59.95

smerent<_ 4-Port USB Hub
with Individual Switches
» 4 x Downstream USB 2.0 Ports
» Data Transfer Rate Up to
480 Mb/s
» Windows / Mac Compatible

SAHBUMLS

a USB-4311B
XCELLON' 4-Port

Portable USB 3.1 Hub
» 4xUSB 3.1 (Gen 1) Ports
» Up to b Gbps Transfer
Speed per Port
» Hot-Swap & Plug-and-
Play Functionality

XCUSBATIB ..o 17.95

srerenNsZ_ 4 Port USB 3.0 Travel Hub

4

» Thin, Lightweight Design
» Plug-and-Play
No Drivers Required

®rocears 2-Port USB
KVM Switch

» USB Keyboard
& Mouse
» V6A Display &
» Integrated Cables
106CS22U 16.49

& Trenoner 2-Port USB

KVM Switch

» Share a single monitor,
keyboard, mouse, -
microphone & speakers

» Hot-Key and Push-Button Switching

TRTK207K 17.82

HUBS

HUBS, KVM SWITCHES, POWER SUPPLY, MOBILE CHARGING STATIONS

@ rocears L-PortUSB 2.0 Hub
» Compact Size
» Hot Swappable

104PUSBZH 4.95

B E L KIN. FAU058TT
SuperSpeed USB 3.0 4-Port Hub

» 4 x USB 3.0 Ports
» b Gbps Max. Data

& Transcend- 4-Port USB 3.0 Hub
» USB 3.0 Interface
» 4xUSB 3.0 Ports
» USB 1.2 Charging

Specification

TRUSBPH 18.99

KKINGWIN KW-HUB-9U3
Multi-Port USB 3.0 Hub
with 1Q Charging Ports

» 9xUSB 3.0 Ports

» 2xUSB 3.0 1Q Charging Ports

» 2.6A Output Current on each 10 Port
KIKWHUB9US ... 31.95

» Windows & Mac Transfer Rate
Compatible » Easy Installation
SAHBSGAR BEF4U058TT 42.24
KVM SWITCHES

®@roeears 4-PortUSB Cable
KVM Switch

» USB Keyboard & Mouse
» VIGA Display - l

» Integrated Cables

I0KVMCS4P 34.06

IRF-ILimi«< 2Port HDMIUSB
» Video Resolution up to

1920 x 1200
» 2 Extra Sets of Built-in USB

2.0 Ports » Front Panel LED Indicators

KVM Switch -
» Auto Scan Feature -
RFHUK1020 89.00

APC BE5506 Back-UPS 550
8 Outlet Surge Protector &
Battery Backup
» Output: 330 W /550 VA
» Input: 120V » 4 x Battery-

Powered, 4 x Surge Protector
» 50/60 Hz +/- 3 Hz Output Frequency

APBES50G 57.34

APC Power-Saving Back-UPS

Pro 1500

» Qutput: 865W/1500VA » Input: 120V

» bx Battery Backup, 5x Surge
Protection » NEMA5-16R

» Recharge Time: 8 Hours

» Audio Alarms » RJ-45 Connector

APBR15006 164.94

@Garirrin PowerDock 5
Charging Station
» Charges up to 5 USB Devices
» Five Integrated USB Charging
Ports » Each Port Provides
5V 2.1A » Charges iPad, iPad mini, iPhane,
&More » Holds iPads with their Cases

GRNA3B3BZ ... _Call or Log-on

BELKIN. Storeand
Charge Station ‘

» Stores and Charges up
to 10 Devices
» Fits Most Cases up to 1.18" Th|ck
» Holds Laptops or Chromebooks up to 13"
» Built-In Cable Management

BETSCSAC 157.45

UNINTERRUPTIBLE POWER SUPPLY (UPS)

MOBILE CHARGING STATIONS

®rocears 2-Port DVI-D
KVM Switch

» USB Keyboard/Mouse )
Connectors - Q(DV

» DVI Monitor Connectors

» Line-In (Mic) + Line-0ut (Speakers)

|0DDKZPCSAM 88.95

EXT-DVI-241DL
2x1DVI DL Switcher

(2) dual-link
DVI computers & USB 2.0 keyboard and mouse

» Resolutions up to 3840x2400
» Controlled through IR remate control

BEDDLS oo Call or Log-on

®rocears 8-Port USB PS/2
Combo KVMP Switch

» Connects Directly @%

to 8 Computers p
» Supports 2-Level Cascade
(128 Computers) » USB and PS/2 Support

10VK8PSUC 279.00

StarTechcom 8-Port 1U

Rackmount USB KVM Switch

» Supports
Resolutions up to
1920 x 1440 » USB PC Interface

» 0SD Security » Auto-Scan Function

» Cascade Configuration » Hotkey Functions

STSVB3TDUSBK ....oooooo .322.92

l

APC Smart-UPS 750VA
with LCD
» Output: 500 Watts / 750 VA
» Input: 120V » 6 x Battery
Powered Outlets » 6 x NEMA
5-15R Out » Recharge Time: 3 Hours
» Audio Alarm » Smart-Slot / USB Connections

APSMT750 258.33

APC Smart-UPS C 1440VA
with LCD

» Output:900W/T440VA

» Input: 120V » 8x Battery
Powered Qutlets » 8x NEMA
5-15R » Recharge Time: 3 Hours

» Audio Alarm » 1 x USB Port

APSMC1500

330.95

" Charge and
Sync Station 16
» 16 USB Ports
» Supports i0S and Android
» Charge up to 16 Devices Simultaneously.
» Power for a Full 2.4A Per Port
» Heavy-Duty, Metal Enclosure

AL400103 Call or Log-on

LUXOR LLTP24-B 24 Laptop

Charging Station

» Charges and secures up to
24 laptops/tablets Rubber-
coated dividers is 1.75" apart

» Two 4" stationary casters and
two full-swivel ball-bearing locking casters

LULLTP24B 559.95

“ 800-947-3308 - 212-444-6691



OPTICAL DRIVES & BURNERS, DUPLICATORS

" Authorized Reseller USB superDrive
External Slot-Loading
Optical Drive

» USB Powered

» Slim & Portable

> ForMacwith e eeee—
USB Port

APMMDB64LLA 77.98

@ LG BE14NU4D
Blu-ray, DVD, & CD Writer

» Supports BDXL 1286B Discs

» USB 3.0 -

» Blu-ray 14x

» DVD 16x (2

» CD 48x

LGBETANUAD oo 119.95

BUFFALD MediaStation

» USB 2.0

» CD 24x

» DVD Bx

» DVD Dual Layer 6x
» DVD-RAM 5x

» Bus-Powered

<« SE-506CB/RSBD

USB 2.0 Powered Interface

» Blu-ray 200ms Access Time
» BD 6x » Supports Single/Dual/Triple

& Quad BD
» DVD Bx
» CD 24x
SASESO6CBRSB. ... 79.59

@ LG WH16NS40

» BD-R 16x » DVD+/-R 16X
» Read & Write Blu-ray,

DVD and CD Discs o
» 3D Blu-Ray Title  f—
Playback

i 58.99

LOWHTONSAD ...

@ Mercury Pro

» FireWire 800/400,
USB 3.0/2.0

» 16X Blu-ray Write :
Speed » 12X Blu-ray
Read Speed » Includes Roxio

OPTICAL DRIVES AND BURNERS

COMPUTERS

< SE-208DB/TSBS
» USB 2.0
» 150ms Random Access Time
» 1MB Buffer Memory
» Mac Compatible
» Horizontal Drive
Installation
» Slim Design

SASE2086BRSB........ $22.95

@ LG GP6ONB50

» DVD= 8X » CD 24X

» M-Disc Support

» USB2.0

» Supports Double
Layer DVD+ R Discs

LGGPOONBDD.........oooc 27.95

roneer BDR-XS06
» Slot Loading Mechanism
» USB Bus-Powered
» 12868 Quad Layer
Blu-ray Media — e——
» 1006B Triple
Layer Blu-ray Media

/iSUS' SDRW-08D2S-U/B

» DVD 8x / CD 24x
» Up to 160 ms DVD Access Time
» 140 ms CD Access Time
» USB 2.0
» Windows & Mac
Compatible

ASDRW08DZS 32.95

@ LG GP65NB60
14mm Thick DVD Writer Drive

» USB 2.0 Interface

» DVD 8x !

» CD 24x
25.51

L6GP65NB6O

Proneer BDR-XD05S
Blu-Ray, DVD & CD Writer

» Reads & Writes BD-XL TL,
(L BD-R & BD-RE

» Reads BD-ROM :

» 6x BD-R Read/Write
Speed » Connects and

Toast Software » M-Disc Technology Powered via USB 3.0
BUDVSMPTS8U2 $49.99 OWCMR3FBBI6S ... .219.00 PIBDRXSD6 ..o 129,95 PIBDRXD05S 89.95
DUPLICATORS
merosonos (0D 1:10 Ateratec 1:16 USB 3.0 Copy Cruiser e 5Target e 3 Target

CD/DVD Duplicator
» 1:10 CD/DVD Duplication

» CD-6 Support

» Standalone Operation

» LCD Display & Control Panel

749.00

MIQDDVD1210

PRIMERA Bravo SE Disc Publisher
» 20-Disc Capacity
» USB 2.0
» Primera PTPublisher
SureThing CD Label
Software

PRBSE o _Call or Log-on

Mini Duplicator
» Duplicates up to
16 USB 3.0/2.0
Drives » SuperSpeed
USB 3.0 Technology
» USB Flash/Pen Drive Media Type
» Aleratec Software Suite

AL330115 419.99

PRIMERA Bravo 4051 Disc Publisher

» Fast Six Second Printing =

» High-resolution 4800 DPI
Inkjet Printing

» Prints up to 50 Discs at a
Time » Individual CMYK Ink Cartridges

» DVD£R/CD-R » Powerful Publishing Software

PRB4051 1,825.00

CDS, DVDS & BLU-RAY DISCS

24X DVD/CD Duplicator

» Burns Approximately 50 DVDs / Hour
» SATA Internal Interface

» USB 2.0/3.0 Compatible

» Up to 24X Read Speed

» 5 x DVD Writers

» 1 x DVD-ROM Drive

» Intuitive LCD Display

EZDHTDVDLGB 413.32

EPSON PP-100lI Discproducer

» USB 3.0 SuperSpeed Interface

» Leave Production Runs Unat- |
tended » High Accuracy |

» User-Replaceable Drives

» Total Disc Maker Software
Included

EPPPIOON....ooos 2,695.00

24X DVD/CD Duplicator

» Burns Approximately 30 DVDs / Hour
» SATA Internal Interface
» Up to 24X Read Speed
» 3 x DVD Writers

» 1xDVD-ROM Drive

» Intuitive LCD Display

=

EZD3TDVDLGB 310.00

Aleratec 1:10 USB 3.0 Copy Cruiser

Mini Thumb Drive Duplicator
» SuperSpeed USB 3.0

B&H carries a wide assortment of optical recordable media, including CD, DVD, Blu-Ray and M-Disk.

maxell. =2 WVebatim emorer D2

www.BandH.com

aTDK 22 JVC (58 sonvy

technology
» Easy-to-Use Aleratec
Software Suite
ALCCM110 285.00
DISC



COMPUTERS

Computer Cables

CABLES

After countless hours of researching and comparing, you've finally purchased the computer you wanted. Whether it was a laptop or a desktop
computer, you'll want to use the full advantage of all the ports. It can be quite daunting to know which cables to use. For starters, most ports
on your computer will have female connectors. Female connectors are ports that you plug into. Cables will usually have male connectors,

which plug into the female connectors on your computer.

There are also different types of ports. Thunderbolt and USB are used to transfer data while DisplayPort, DVI, and VGA ports are used to output
video to an external display, such as a monitor or an HDTV.

Q

Thunderbolt

Access high-speed peripherals and high-resolution displays via
one simple port and cable that carries both DisplayPort and PCI
Express data. Thunderbolt gives you two channels on the same
connector with 10 Gbps of throughput in both directions. Thun-
derbolt 2.0 pushes that to 20 Gbps by bonding the two channels
together. You also have the bandwidth to daisy-chain multiple
high-speed devices without using a hub or switch. Thunderbolt and
mini DisplayPort share the connector type. Thunderbolt ports are
usually found on Mac computers.

DisplayPort / Mini DisplayPort

DisplayPort and mini DisplayPart are usually found on Mac com-
puters, but can be found on some PC computers as well. Display-
Port is a digital display interface that supports video, audio, and
other forms of data in a single cable. DisplayPort is the older,
bigger version while mini DisplayPort is the smaller version that
shares the same design as Thunderbolt.

¢

PEARSTONE

Authorized
Reseller

UsB

USB stands for Universal Serial Bus and it lives up to its name since
it can be found on practically every modern computer. You'll notice
that USB will usually have a number next to it. This number is the re-
lease name, but can also be associated with the data transfer speed
they support. For example, USB 2.0 supports up to 480 Mbps while
USB 3.0 supports up to b Gbps. USB 3.1 supports up to 10 Ghps.
Most computers use the USB Type-A port while the USB Type-B port
can be found on computer peripherals, such as printers. USB Type-C
is becoming more popular, thanks to its reversible connector.

DVI

DVI stands for Digital Visual Interface. It transmits uncompressed
digital video. The DVI connector is given one of three names, de-
pending on which signal it uses. DVI-I means it integrates both
digital and analog signals into the same connector. DVI-D means
it only supports a digital signal, single or dual link. DVI-A means it
only supports an analog signal.

Comprehensive

A Division of Wl Vcom International Multimedia Corporation

<@ [A  BELKIN

Hosa Technology

o | orloos | Starffechcom

Ethernet

Most laptops have given up the Ethernet jack in favor of Wi-Fi,
but desktop computers and workstations still embrace the wired
Internet connection. Most computers utilize the RJ-45 LAN jack,
which plugs into your computer and your router. The Ethernet jack
usually supports 10/100 Mbps Fast Ethernet or 10/100/1000 Mbps
Gigabit Ethernet. If you have a 10/100 Mbps Fast Ethernet jack, a
Catb cable should be good enough. Catbe is an enhanced version of
Catb and supports 10/100/1000 Mbps. Cat6 further improves upon
Catbe and supports 10 Gigabit Ethernet in certain cases.

VGA

Known as Video Graphics Array, VGA has been around since the 1980s.
While most computers now use more modern technologies, like HOMI
and DisplayPort, certain laptops still sport the analog interface as
an addition, which is useful for backwards compatible with older
projectors and monitors. VGA is usually seen as a 15-pin connector.
On laptops and smaller devices, a mini-VGA connector can be found.

To view a full listing
of all Computer Cables

or visit our website
BandH.com/w15105

800-947-3308 - 212-444-6691




@Diadlze 3D Printing Pen 2.0
With ABS & PLA Filament

» Draw with Plastic Filament
» Draw on Paper or in the Air
» Personalize & Decorate Plastic ltems
» Repair Household Plastics & 3D Prints
» Compatible with ABS & PLA Filament
» “Highlighter” ABS Filament

Pack Included
» “The Essentials” PLA Pack Included
(303D00DV2US)

@ makerBot: Replicator 2
Desktop 3D Printer
» 11.2x6.0 x 6.1" Build Volume
» 100-Micron Layer Resolution
» Uses MakerBot PLA

Plastic Filament
» USB and SD Card Connectivity
» 3-Point Leveling System » Pop-out Acrylic Platform
» STL, 0BJ, THING File Formats » MakerBot Desktop & Mobile App
» Mac, Windows, & Linux Compatible

[MAMPO4948)

1,799.00

@ makerBot: Fifth Generation Repllcator

Desktop 3D Printer T

» 9.9%7.8x5.9" Build Volume

» 100-Micron Layer Resolution

» Uses MakerBot PLA Plastic Filament

» MakerBot Replicator Smart Extruder

» Onboard Camera with 640 x 480
Resolution » USB, Ethernet, Wi-Fi » 3.5” Full-Color LCD Display

» MakerBot Desktop & Mobile Apps

» Mac, Windows, & Linux Compatible

(MAMP05825) e 2,899.00

Desktop 3D Printer
» 10x 9 x 8" Build Volume
» 100-Micron Layer Resolution =
» Uses 1.75mm Filament w
» ABS, PLA, Glass, Wood, Flexible Material  FiiS =S
» Print via USB Cable or SD Card -

s R1+Pls
» Single Extruder

» Heated Build Plate

» Automatic 9-Point Calibration » Hexagon All Metal Hot End
(RORTPLA10002) e 799.99

@yitizgserBot:
Desktop 3D Scanner

» MakerBot MultiScan Technology

» MakerWare for Digitizer Software

» Scan 3D Objects in Multiple Angles

» Scan 30 Prints into Digital
File Formats

» Share Scanned 3D Design Files
Online

» Made in USA

(MAMP03955) S 679.15

www.BandH.com

3D PRINTERS & SCANNERS

CRE 3D Pen

Starter, Black/Silver

» One CreoPop 3D Pen

» 3 Ink Cartridges (Red, Orange, Cyan)

» Uses Light-Sensitive Photopalymer Inks
» Charges via USB

» Operates Cordlessly After Charging

» No Hot Parts; Safe for Children

» Accepts Wide Variety of Inks

(CRSKUOO1)....... 129.99

& FLASHFORGEUSA (reator Pro
3D Printer /

» Build Volume: 8.9 x5.7x5.9”

» 100 Micron Layer Resolution

» Dual Extruders for 2-Color Printing

» Uses ABS, PLA, & Dissolvable Filament
» Print from SD Card or USB

» Integrated LCD Screen

» Sturdy Metal Fram

» Mac, Windows, & Linux Compatible

(FL3DPRNTRCP) . 999.00

- da Vinci 1.0 All-in-One
-~ i
Aﬂp‘ﬁ 3D Printer & Scanner

» Build Volume: 7.9 x 7.9 x 7.5"

» 100-Micron Resolution

» Scan Volume: 5.9 x5.9”

» 250-Micron Scan Resolution

» Uses 1.75mm ABS & PLA Filament
»STL, .3W, .DAS File Formats Supported
» 2.6" Four-Line Display Panel

» Windows & Mac Compatible

(XY3ST0AXUSOC) . 599.99

7 DREMEL 30 3D [dea Builder
D
‘IDEA BUILDER 35 printer

» Build Volume: 9 x5.9 x5.5"

» 100-Micron Resolution

» Only Uses Dremel PLA Filament
» Pre-installed Extruder

» USB Port, SD Card Slot

» Removable Build Plate

» 3.5” Full-Color IPS Touchscreen » Onboard Software

» Active Cooling Fan » Mac, Windows, & Linux Compatible

(DR3D2001)........ 999.00

SCANIFY
FUEI- D Handheld 3D Scanner

» Portable, Full Color 3D Scanner

» Scan Volume: 8 x 12°

» Operating Distance: 14 to 18"

» Maximum Resolution: 350 Microns

» Uses Xenon LED Flash Bulbs, No Lasers

» 0.1 Second Scan, 30 Second Processing

» Fuel3D Studio Software Included » Exports STL, PLY, & 0BJ Files
» Built-In Tripod Mount » Compatible with Windows 7 and Up

(FUHH3DSSYS) ... 1,499.00

COMPUTERS

30
Printing Pen
» Built-In LCD Screen i
» Personalize, Repair, & Modify 3D Prints
» 1.75mm ABS or PLA Filament Supported
» Embellish and personalize crafts

» or use to repair and modify 3D prints & "y
» Suitable for families and crafters '
(CROBADTOOT)..oooo oo 79.99

€ FLASHFORGEUSA Dreamer
3D Printer

» 9.1x5.9x5.5" Build Volume
» 100-Micron Resolution
» Dual Extruders for
2-Color Printing
» Compatible with ABS, PLA,
& PVA Filament
» Print from SD Card, USB, or Wi-Fi » Mutli-Language LCD screen
» Multiple User LED Pixel Strips » Self-Calibrating Build Platform

(FL3DPRINTERD) S 1,[]99.[]0
> da Vinci Junior 1.0
-~ y .
4&2""% 3D Printer

» Build Volume: 5.9 x5.9x 5.9" - -

» 100-Micron Layer Resolution

» Uses 1.75mm PLA Filament

» Print via USB 2.0 Cable & SD Card

» STL, .3W File Formats Supported = g

» Single Extruder » 2.6” Display Panel e
» Auto Calibration, Enclosed Build Chamber

» Windows & Mac Compatible
(XY3F1J0XUS00) e 339.00

AFINITA 31D H800
3D Printer

» Build Volume: 10 x 8 x 8"

» 100-Micron Layer Resolution

» Uses Afinia PLA & ABS Plastic Filament
» HEPA Filtration System

» Smart Support Material Technology

» Heated & Automated Platform » USB Interface
» STL, UP3, & UPP File Formats Supported

» Mac & Windows Compatible

(AFHB00) e 1,899.00

£ sDsvYsTEMS isense
3D Scanner for iPhone 6+

» Snaps On and Turns iPhone into 3D Scanner
» Minimum Scan Volume: 8 x 8 x §”

» Maximum Scan Volume: 9.8 x 9.8 x 9.8

» Operating Distance: 1.7 to 4.2

» (lass 1 Certified Infrared Laser

» Free iSense App with Image Editing Tools

» Creates STL, 0BJ, and PLY Files » Upload Images to Cube 3D Printer
» Compatible with i0S 7 and Later

(3DISIPH6PLKT) [ 399.00




COMPUTERS

EPSON' Perfection V600

Photo Scanner

» Optical Density: 3.4 Dmax

» Color Depth: 48-bit

» Optical Resolution: 6400 dpi
» Max Resolution: 12800 x 12800 dpi
» Scans Prints, 35mm & Medium Format Film
» Maximum Scan Area: 8.5 x 11.7

» DIGITAL ICE Scratch & Dust Removal

(EPPV600)

Call or Log-on

Canon CanoScan 9000F Mark Il

Film & Document Scanner

» Optical Resolution: 9600dpi

» Optical Resolution: 4800dpi

» Scan Medium Format Film

» Scan 35mm Negatives & Slides

» Scan Film, Slides, Documents,
Photos » Color Depth: 48/24-Bit .
Internal/External » Programmable 1-Touch Scanning Buttons

» OCR & PDF Creation Software Included

(CACS900FM2S)

v 169.95

rujitsu fi-7160 r

Document Scanner !

» Optical Resolution: 600 dpi

» Scan Speeds of 60 ppm & 120 ipm

» 80-Sheet Automatic Document
Feeder » Duplex Scanning

» Maximum Document Size: 8.5 x 220"

» Minimum Document Size: 2.0 x 2.1"

» Output Color Depth of 24-bit

» Double Feed Detection Sensor

(FUFI7160DS)

o 858.99

brother ImageCenter ADS-2000E

High-Speed Document Scanner

» Speed: 24ppm S
» Automatic Duplex Scanning

» Multi-Feed Detection

» Batch Scanning Via 50-Sheet ADF

» Scan Business Cards & ID/Credit Cards
» Optical Resolution: 600 x 600 dpi

» Automatic Blank Page Removal

(BRADS2000E]........ 349.99

Fujitsu ScanSnap S1300i

Document Scanner

» Compact Size

» Scan Speed: 12ppm

» Scan Resolution: 600dpi

» Automatic Duplex Scanning
» USB-Pawered For Increased Portability
» Scan Directly To The Cloud

» Scan To Commonly Used Programs

o 249.99

(FUS13001)

SCANNERS

EPSON Perfection V800

Photo Scanner

» Scans Prints, Film, and Slides

» Optical Density: 4.0 Dmax

» Color Depth: 48-bit

» Optical Resolution: 6400 dpi

» Max Resolution: 12800 x 12800 dpi
» Maximum Scan Area: 8.5 x 11.7"

» Set of Four Film Holders

» DIGITAL ICE Scratch & Dust Removal

(EPVBOD) .o

~...Call or Log-on

Canon CanoScan LiDE220
Color Image Scanner

» Optical Resolution: 4800 x 4800 dpi
» Max Resolution: 19200 x 19200 dpi
» Max Document Size: 8.5 x 11.7"

» Five EZ Buttons & Scan to Cloud

» Letter-Size Scan Speed, 300 dpi: 10 sec

» Color Depth: 48-bit Internal/External

» Advanced Z-Lid & Upright Scanning

» ENERGY STAR Certified and RoHS Compliant

(CAL220) .o

78.95

FujiTsu ScanSnap iX500
Wireless Desktop Scanner

» Color Scan Speed: 25 ppm
» Create Searchable PDFs
» Maximum Scan Area: 8.5 x 34"
» Optical Resolution:
600 x 600 dpi
» b0-Sheet Automatic Document Feeder
» Scan to Mobile Devices & Cloud Services
» Double-Feed Detection

(FUTX500DSW)....

410.59

brother ADS-1000w

Wireless Document Scanner

» i ,.4
600 x 600 dpll . %
» 16 ppm > Wi-Fi -:M

» Auto Duplex Scanning

» ADF Capacity 20 Sheets

» Scan to USB Drive, Email, FTP
» Scan to Android, i0S, Windows Mobile

» Scan Documents up to 8.5 x 34

» Business Cards, Embossed Plastic Cards

(BRADS1000W)

Canon imageFORMULA DR-C240

Office Document Scanner

» Optical Resolution: 600 dpi
» Scan Speed: 45 ppm B&W,
30 ppm Color

» Maximum Scan Area: 8.5 x 14"
» Minimum Scan Area: 2.0 x 2.8”
» Color Depth: 24-bit

» Automatic Duplexing at up to 90 ipm
» 60-Sheet Automatic Document Feeder

(CADRC24D) ...........

697.99

EPSON Perfection V850

Pro Scanner

» Scans Prints, Film, and Slides

» Optical Resolution: 6400 dpi

» Optical Density: 4.0 Dmax

» Color Depth: 48-bit

» Maximum Scanning Area: 8.5 x 11.7"
» DIGITAL ICE Scratch & Dust Removal
» SilverFast SE 8 Software Included

» USB 2.0 Connectivity

(EPV850)

!

_.Callor Log-on

Canon CanoScan LiDE120

Color Image Scanner

» Optical Resolution: 2400 x 4800 dpi

» Max Resolution: 19200 x 19200 dpi
» Max Document Size: 8.5 x 11.7"

» Color Depth: 48-bit Internal/External
» Letter-Size Scan Speed, 300 dpi: 16 sec

» Four EZ Buttons & Advanced Z-Lid

» Scan to Cloud Function » Powered via USB Port
» ENERGY STAR Certified and RoHS Compliant

(CAL120)

plustelc SmartOffice PS286 Plus

Document Scanner

» Duplex Scanning in
Color/Grayscale/B&W

» |Scans Paper Documents

#s
and Rigid Cards
» Automatic Document Feeder (50 Pages)

» Create Searchable PDF & MS Office Files

» Scan To Folder/Network/Email/FTP/Printer
» Scan Speed: 25 PPM » Daily Duty Cycle - 1500 pages
[PLMOPS286) . 259.99

Canon imageFORMULA DR-C225

Office Document Scanner

» Scan Documents and Cards

» Optical Resolution: 600 dpi

» Scan Speed: 25 ppm /50 ipm

» Color Depth: 24-bit

» Duplex Scanning

» Maximum Scan Area: 8.5 x 14"
» Long Document Mode: 118.1”

(CAIFDRC225SC) . 399.99

EPSON  WorkForce DS-560

Wireless Color Document Scanner

» Optical Resolution: 600 dpi Fyies

» Scan Speed at 300 dpi: 26 ppm/52 ipm o

» Automatic Document Feeder: 50 Sheets

» Minimum Paper Size: 2.1x 2.9

» Maximum Paper Siz: 8.5 x 16.5"
(Mac); 8.5 x 36" (Windows)

» Wi-Fi Connectivity: 802.11 b/g/n

» Daily Duty Cycle: 3,000 Sheets

(EPDS560) Call or Log-On

800-947-3308 - 212-444-6691




PORTABLE SCANNERS / LABEL MAKERS

DYIMIO CardScan Executive

Executive Scanner

» Color-Capable Business Card
Scanner

» Extract Contact Info From
Business Cards

» Send Data To Contact
Management Program

» Corrects US Addresses & ZIP Codes

(DYEV9) 210.00

\"‘*-.

Canon imageFORMULA P-2151l Scan-tini
Personal Document Scanner
» 600 dpi Optical
Resolution
» Color Scan Speed:
10 ppm /20 ipm
» Color Depth: 24-Bit
» Min Document Size: 2.0 x2.8" » Max Document Size: 8.5 x 39.4”
» 20-Sheet Automatic Document Feeder » Duplex Scanning
» Built-In Card Scanner » Power Over USB » USB 3.0 Connectivity

(CAP21511) 249.00

PORTABLE SCANNERS

COMPUTERS

< ScanSnap iX100
FU"TSU Wireless Mobile Scanner
» 600 dpi Optical

Resolution
» Min Document Size: 1x 1"
» Max Document Size: 8.5 x 34"
» Scan Speed: 5.2 Secands per Page
» Automatic Stitching of Two-Page Spread
» USB Rechargeable Li-lon Battery » Battery Life: 260 Scans
(FUIX100WMS) 199.99

brother DSmobile 720D
Mobile Duplex Document Scanner
» 600 x 00 dpi j
» § ppm Simplex, ?
5 ppm Duplex m
» Scan Documents
upto8.5x32”
» Auto Duplex Scanning up to 8.5x 16” » OCR
» Business Card & Receipt Software
» USB-Powered, No Outlet Necessary

(BRDS720D)

136.99

DYMO LabelWriter 450 Turbo

USB Label Printer

» Thermal Printing Technology

» Prints 71 Labels/Minute

» Windows & Mac
Compatibility

(DYLWA50T) 69.99

brother PT-D210
Portable Label Maker

» Standalone Operation

» Print Resolution: 180 dpi N\ 8%EsRe0s
» Works with TZe Tape Family 7 \ (2508

» Max Tape Size: 0.47" x 26.2 j

» Max Print Speed of 0.8” per Second

» Prints up to 2 Lines & 30 Label Memary

» 1-Line LCD Display & QWERTY Keyboard

» Runs on 6 x AAA Batteries » Optional AC Adapter

LABEL PRINTERS

EPSON WorkForce DS-30

Portable Scanner

» USB-Powered:
No Outlet Required
» Lightweight
Design Ideal For Travel
» Scan Directly To Popular Cloud Services
» Includes OCR Software For Windows/Mac
» Mac & PC Compatible » Includes Travel Case
(EPDS30)

149.99

[ ] Magic Wand

Portable Scanner

» 900 dpi » 8.27" Scan Width

» 98" Maximum Scan Length

» Scan Almost Any Flat Surface

» Battery Operated

» Stores Images on microSD Card

(VUMWPSBS) 42.35

DYIMIO LabelWriter 4XL
Label Printer
» No Ink or Toner Required
» Labels up to 4™ (10.16cm) Wide
» Windows XP, Vista &

Mac Compatible

195.00

(DYLW4XLB)

brother PT-P700
PC-Connectable
Label Printer

» Print Resolution: 180 dpi

» Create Labels up to 1" Wide & 11.8" Long
» Thermal Print Technology

» Automatic Cutter

» Print Speed of 1.2" per Second

» USB Port for PC Connectivity » Runs on AC or Battery Power
» Windows and Mac Compatible

\

DYIVIO Rhino 5200
Industrial Labeler

» Easily Print Labels On The Job

» Print Labels Up To 19" Wide

» Backlit For Low Light Installations

» Save/Recall Frequently Printed Templates

» Pre-Programmed Symbol Library

» Print Bar Codes

» Complies W/ ANSI/TIA/EIA-606-A Standards
(DY1755749) 95.09

brother 0L-710W
High-Speed Label Printer
W/ Wireless Networking
» Print 93 Labels/Minute

» Print Long Banners Up To 3.0°

» Wi-Fi Connectivity

» Print From Apple & Android Devices

» Print Postage Stamps & Barcodes » Label & Banner Templates
» High Resolution Printing (300 x 600 dpi) » Auto Cutter

» No Ink Needed » Create/Print Labels Without Software

(BROL710W)

110.00

(BRPTD210) 33.57 (BRPTP700) 62.99
OPTICAL MEDIA PRINTERS
Bravo 4100 EPSON Discproducer
TECHNOLOGY, INC. CD/DVD Inkjet Printer Autoprinter

» Automatically Prints CDs and DVDs _—

» Print Only, No Drives

» 100 Disc Capacity

» 4800 dpi Inkjet Printing

> Individual CMYK Ink
Cartridges

Bravo 4100 (PRB4100USJ) 1,595.00

www.BandH.com

[

» Windows Compatible

» 100-Disc Capacity

» Print Up to 95 Discs an Hour

» Max Printing Resolution:
1440 x 1440 dpi

» All-In-One Software » USB Interface

» Reliable Media Handling Tech » Compact Rugged Construction

(EPPP100AP) 1,950.00

mcrosoaros  PE-Pro Autoprinter
Optical Disc Printer |
» 100-Disc Capacity
» 4800dpi » USB 2.0
» Mac & Windows Compatibility
» Asingle set of ink cartridges can
produce anywhere between 850 and
1,500 discs

[MIPFP1000) 2,195.00




COMPUTERS

LASER PRINTERS

RICOH SPC250DN

Color Laser Printer

» Print Resolution: 2400 x 600 dpi

» Print Speed: 21 ppm

» Maximum Print Size: 8.5 x 14

» Mabile Device Printing

» Automatic Duplexing; USB Host Part

» 250-Sheet Input Tray & 1-Sheet Bypass
» USB 2.0, Ethernet, & Wi-Fi Connectivity

[RISPC250DN)

Call or Log-on

brother HL-L8350CDW

Wireless Color Laser Printer

» Print Resolution: 2400 x 600 dpi

» Print Speed: 32 ppm

» Paper Capacity: 300 Sheets

» First Print Out Time: < 15 Sec.

» Automatic Duplex Printing

» Maximum Print Size: 8.5 x 14"
» Front-Access USB Direct Printing

» Wi-Fi 802.11b/g/n, USB 2.0, and Ethernet

. 349.99

(BRHLL8350CDW)

brother HL-L23400W

Monochrome Laser Printer

» Max Resolution: 2400 x 600 dpi
» Max Document Size: 8.5 x 14"

» Print Speed: 27 ppm

» Automatic Duplex Printing

» One-Line LCD Display

» One-Sheet Manual Bypass
» Input Capacity: 250 Sheets » USB 2.0 and Wi-Fi Connectivity

(BRHLL2340DW)

v 129.00

7) LaserJet Pro M402n

Monochrome Laser Printer

» Print Resolution: 600 x 600 dpi
» Maximum Print Size: 8.5 x 14

» Minimum Print Size: 3 x 5"

» Print Speed: 40 ppm
» Mabile Printing

» 2-Line Backlit LCD; USB Host Port

S

» 100-Sheet & 250-Sheet Input Trays » Monthly Cycle: 80,000 Pgs.

» USB 2.0 and Ethernet Connectivity

(HEM402N)

v 269.00

Canon imageCLASS MF229dw

All-in-One Monochrome Laser Printer

» Print, Scan, Copy, Fax

» Resolution: 600 x 600 dpi

» Print Speed: 28 ppm
» Color Depth: 24-bit

» Max Document Size: 8.5 x 14"

» Automatic Duplex Print, Scan, Copy, Fax
» 250-Sheet Input Tray / 50-Sheet ADF

» Monthly Cycle: 10,000 Pages » USB 2.0, Ethernet, & Wi-Fi

e 299.99

(CAIMF229DW)

COLOR LASER PRINTERS
LaserJet Pro M252dw
’ Color Laser Printer @
s :
"‘-..-_‘\-_Nl

» Print Resolution: 600 x 600 dpi

» Maximum Print Size: 8.5 x 14"

» Minimum Print Size: 3 x "

» Print Speed: 19 ppm

» Automatic Duplex Printing » Mobile Printing; USB Host Part
» 3.0" Color LCD Touchscreen » Input Capacity: 150 Sheets

» USB 2.0, Ethernet, and Wi-Fi with NFC

(HEM2520W)...... 299.99

brother MFC-9330CDW
Wireless Color Laser Printer P
» Print, Scan, Copy, Fax e
» Print Resolution 600 x 2400 dpi
» 23 ppm» Automatic Duplex Printing
» Wi-Fi. Ethernet, AirPrint, Cloud Print
» Print/Scan with USB Drive,

Mobile Device » Input Capacity

261 Sheets » Scan Resolution 1200 x 2400 dpi
» Monthly Duty Cycle 30,000 Pages » Internal Memory 192 MB

(BRMFC9330CDW) 389.99

MONOCHROME LASER PRINTERS

brother MFC-L2700DW

All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Resolution: 2400 x 600 dpi

» Max Print Size: 8.5 x 14”

» Automatic Duplex Printing

» Flatbed Max Scan Size: 8.5x 11.7°
» 35-Sheet ADF & 250-Sheet Input Tray
» Monthly Cycle: 10,000 Pages » USB 2.0, Ethernet & Wi-Fi
(BRMFCL2700DW)

168.96

) LaserJet Pro P1102w

Wireless Laser Printer

» 600 x 600 dpi » 19 ppm

» Wi-Fi. ePrint, AirPrint,
Wireless Direct

» Input Capacity 160 Pages

» 266 MHz Processor Speed

» USB 2.0 & WiFi 802.11b/g
Connectivity

159.99

(HEPT102WQ).....

Canon imageCLASS MF216n

All-in-One Monochrome Laser Printer

» Print, Scan, Copy, Fax

» Resolution: 600 x 600 dpi

» Print Speed: 24 ppm

» Color Depth: 24-bit

» Max Document Size: 8.5 x 14

» 250-Sheet Input Tray / 35-Sheet ADF
» Monthly Duty Cycle: 8,000 Pages

» USB 2.0 and Ethernet Connectivity

(CAIMF216N)......

166.63

) LaserJetProMASZW 0
Color Laser Printer =—— —

» Print Resolution: 600 x 600 dpi L] ’
» Maximum Print Size: 8.5 x 14 |
» Minimum Print Size: 3 x 5" k 3
» Print Speed: 28 ppm
» 3.0" Color Touchscreen; USB Host Port
» Input Capacity: 300 Sheets » Monthly Duty Cycle: 50,000 Pages
» USB 2.0, Ethernet, and Wi-Fi

(HEMA45ZNW) ..Callor Log-on

brother MFC-L8850CDW

Wireless Color All-in-One Laser Printer

» Print, Copy, Scan, Fax » Print Resolution: 2400 x 600 dpi
» Max Print & Scan Size: 8.5 x 14” -
» Print Speed: 32 ppm =

» Auto Duplex for Al Functions /|

» Optical Scan Res.: 1200 x 2400 dpi |
» 50-Page Auto Document Feeder |
» Supports Mobile Device Printing

» Wi-Fi 802.11b/g/n, USB 2.0, & Ethernet

(BRMFCL8850CD)

. 52819

brother MFC-L27200W

Wireless All-in-One Laser Printer

» Print, Scan, Copy, Fax

» Print Resolution: 2400 x 600 dpi
» Max Print Size: 8.5 x 14"

» Print Speed: 30 ppm

» Automatic Duplex Printing

» Optical Scan Res.: 2400 x 600 dpi

(BRMFCL27200W)

189.99

) M201dw LaserJet Pro
Laser Printer

» Print Resolution: 600 x 600 dpi
» Maximum Print Size: 8.6 x 14
» First Print Out Time: 8 Seconds
» Automatic Duplex Printing
» Two-Line LCD Display
» Input Capacity: 260 Sheets
» Monthly Cycle: 8,000 Pages » USB 2.0, Ethernet, & Wi-Fi

(HEM201DW)

_.Callor Log-on

» Min Document Size: 3 x 5"
» Automatic Duplex Printing

W Xpress M2835DW

Monochrome Laser Printer

» Max Resolution: 4800 x 600 dpi ‘
n—

» Input Capacity: 261 Sheets

» Multi-Purpose/Bypass Paper Feed

» Print Speed: 29 ppm

» Max Document Size: 8.5 x 14"

» Monthly Cycle: 12,000 Pages » USB 2.0, Ethernet, Wi-Fi with NFC
(SAM28350W) e 139.99

800-947-3308 - 212-444-6691




Canon PIXMAMX922
Wireless Color All-in-One Inkjet Office Printer
» Print, Scan, Copy, Fax A
» 9600 x 2400 Color dpi
» 15 ipm Black, 10 ipm Color
» Wi-Fi, Ethernet, AirPrint,
Cloud » Auto Duplex
» 2400 x 4800 dpi
Optical Scan Resolution
» ADF for Multipage Scan, Copy, Fax » Print on CD, DVD, Blu-ray

[CAMX922) o 169,99

—

Sedm=  sanual
-

) Officejet Pro X576dw

All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax

» HP PageWide Technology

» 2400 x1200 dpi Color Print Res
» Max Document Size: 8.5 x 14”

» Print Speed: Up to 42 ppm (IS0)
» Auto Duplex Print, Scan, & Copy
» Print & Scan with USB Drive

» Wi-Fi, USB 2.0 & Ethernet

(HEXS760W) oo Call or Log-0n

EPSON WorkForce WF-3620

Wireless Color All-in-One Inkjet Printer
» Print, Scan, Copy, Fax

» Resolution: 4800 x 2400 dpi

» 8.5x 14" Max Document Size
» Auto Duplex Printing

» Scan Res: 1,200 x 2,400 dpi

» 35-Sheet ADF

» 250-Sheet Tray

» Wi-Fi & Ethernet Connectivity

(EPWF3620) Call or Log-on

EPSON WorkForce WF-7610

Wireless Color All-in-One Inkjet Printer
» Print, Scan, Copy, Fax

» Resolution: 4,800 x 2,400 dpi
» Max Document Size: 13 x 19"
» Automatic Duplex Printing

» Scan Res: 1,200 x 2,400 dpi
» 4.3" Color LCD Touchscreen
» 35-Sheet ADF & One 250-Sheet Tray

» Monthly Cycle: 20,000 Pages » Wi-Fi and Ethernet Connectivity

(EPWF7610) Call or Log-on

brother WorkSmart Series MFC-J460DW

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 6000 x 1200 dpi

» Duplex & Borderless at
upto85x11”

» Scan Res: 2400 x 1200 dpi

» Max Document Size: 8.5 x 14”

» 1.8” Color LCD; USB Host Port » Mobile Printing Support

» 100-Sheet Input Tray & 20-Sheet ADF » USB 2.0 and Wi-Fi

[BRMFCJAB0DW .o 99,99

INKJET PRINTERS [e{ely|-10)§=383

Canon PIXMAMG7720

Wireless All-in-One Inkjet Printer

» Print, Scan, Copy '

» Max Resolution:
9600 x 2400 dpi

» Max Printable Area:
85x 14" g B L

» Print Speed:15 ipm ""J s
Black / 10 ipm Color » Available in Black or White

(CAMG77208) 199.99

7 Officejet Pro 8610
e-All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax
» Print Resolution:

4800 x 1200 dpi
» Printat 19 ppm

Black & 14.5 ppm Color
» Automatic Duplex

Printing

(HEOUPB610) Call or Log-on

EPSON' WorkForce WF-3640

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Resolution: 4,800 x 2,400 dpi
» Max Document Size: 8.5 x 14”
» Auto Duplex Printing

» Scan Res: 1,200 x 2,400 dpi

» 35-Sheet ADF

» Two 250-Sheet Trays

» Wi-Fi & Ethernet Connectivity

(EPWF3640) 199.99

EPSON Expression Home XP-430

Small-in-One Inkjet Printer

» Print, Scan, Copy

» Print Resolution: 5760 x 1440 dpi

» Maximum Print Size: 8.5 x 44"

» Optical Scan Resolution: 1200 dpi

» Maximum Scan Size: 8.5x 11.7

» 2.5” LCD Touchscreen & SD Card Slot
» Four DURABrite Ultra Pigment-Based Inks

» Apple AirPrint & Google Cloud Print » USB 2.0 & Wi-Fi Connectivity

(EPXP430) 99.99

brother Work Smart Series MFC-J880DW
Wireless Color All-in-One Inkjet Printer
» Print, Scan, Copy, Fax
» Print Res: 6000 x 1200 dpi
» USB 2.0, Ethernet,

& Wi-Fi with NFC
» Scan Res: 1200 x 2400 dpi
» Maximum Document Size: 8.5 x 14"
» Duplex & Disc Printing » 2.7" screen Display; USB Port
» 100-Sheet Tray & 20-Sheet ADF » Monthly Cycle: 2,500 Pages

(BRMFCJ880DW) 149.99

e

Canon PIXMAMG3620
Wireless All-in-One Inkjet Printer
» Print, Scan, Copy

» 4800 x 1200 Color dpi

» 9.9 ipm Black, 5.7 ipm Color
» Wi-Fi Printing & Scanning

» AirPrint, Google Cloud Print
» Print & Scan with Mobile Devices

» Automatic Duplex Printing » Scan Resolution 1200 x 2400 dpi
» Scan to Email, Network Folder

[CAMB3620B)......ccccc

e 19.99

7 Officejet Pro 8620

e-All-in-One Wireless Color Inkjet Printer

» Print, Scan, Copy, Fax
» Print Resolution: 4800 x 1200 dpi
» Auto Duplex Printing
» 1200 dpi Optical Scan ResRes
» Max. Document Size: 8.5 x 14"
» 802.11 b/g/n Wi-Fi Connectivity
» 50-Sheet ADF &
One 250-Sheet Input Tray

(HEQJPBOZ0) ..o

i 299.99

EPSON  WorkForce WF-2630

Wireless Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Resolution: 5760 x 1440 dpi
» Max Paper Size: 8.5 x 47.2"

» Borderless Prints up to 8.5 x 11"
» Optical Resolution: 2400 dpi

» 100-Sheet Input Tray &

30-Sheet ADF
» Duty Cycle: 3,000 Pages » Wi-Fi and USB 2.0 Connectivity

(EPWF2630A10P) 99.99

EPSON Expression Premium XP-630
Small-in-One Inkjet Printer

» Print, Scan, Copy

» Max Res: 5760 x 1440 dpi

» Max Print Size: 8.5 x 11"

» Borderless Prints up to 8 x 10"
» Automatic Duplex Printing

» Scan Resolution: 2400 dpi

» Max Scan Size: 8.5 x 14"

» Memory Card Slot and USB Port » USB 2.0 and Wi-Fi Connectivity

(EPXP30) 149.99

brother MFC-J5720DW Business Smart Plus
Color All-in-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Print Res: 6000 x 1200 dpi

» Max Print Size: 11 x 17"

» Borderless Printing to 8.5 x 117

» Auto Duplex Print, Scan, Copy

» Optical Scan Res: 2400 x 2400 dpi
» 3.7" Swipe LCD Touchscreen » Input Capacity: 500 Sheets
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(BRMFCJ57200W) 221.00




COMPUTERS

Canon PIXMAPR0-100

Wireless Professional Inkjet Photo Printer

» 4800 x 2400 dpi

» Print 8 x 10" in 51 Sec.

» §Ink Cartridges
Including 3 Monochrome

» Wi-Fi, Ethernet, AirPrint,
PictBridge » Print Sizes up to 13 x 19"

» CD, DVD, Blu-ray Printing

» Print Studio Pro for Photoshop, DPP

(CAPP100) e 389.99

Canon PIXMAiP8720

Wireless Inkjet Photo Printer

» Print Res.: 9600 x 2400 dpi
» Upto 13 x 19" Print Size
» 14.5 Black ipm &

10.4 Color ipm -
» 6-Color Ink System with Gray o= =N
» Prints Borderless 4 x 6" Photo in 36 sec
» Can Print on CD, DVD, and Blu-ray Discs
» Auto Power On and Off Settings » Wi-Fi 802.11 b/g/n

(CAIP8720) [ 249.99

EPSON' SureColor P400

Wireless Color Inkjet Printer

» Max Res.: 5760 x 1440 dpi

» Max Print Area: 13 x 129"

» Borderless Prints to 13 x 19"
» Roll Media up to 13" Wide

» Epson MicroPiezo AMC Print Head
» AccuPhoto HG Imaging Technology » 8 UltraChrome HG2 Pigment-

Based Inks » Advanced Media Handling & Disc Printing
» USB 2.0, Ethernet, & Wi-Fi Connectivity

(EPSPA40D)

Call or Log-on

EPSON Expression Photo XP-960

Small-In-One Inkjet Printer

» Print, Scan, Copy, Fax

» Max Res.: 5760 x 1440 dpi

» Max Print Size: 8.5 x 14"

» 6-Color Claria Photo HD Ink Set
» Print Speed: 9.5 ppm Black / 9 ppm Color

» Auto Duplex Printing & Copying » Scan Resolution: 4800 dpi
» Max Scan Size: 8.5 x 11.7" » Memory Card Slot & USB Port
» USB 2.0, Ethernet, & Wi-Fi

(EPXP960) e 299.99

PHOTO PRINTERS

Canon PIXMAPRO-10

Wireless Professional Inkjet Photo Printer

» 4800 x 2400 dpi

» Print 8 x 10" in 3 Minutes,
3b Seconds

» Wi-Fi, Ethernet, PictBridge

» Print Sizes up to 13 x 19"

» 10 Ink Cartridges Including 3 Monochrome

» CD, DVD, Blu-ray Printing » Chroma Optimizer Reduces Bronzing

» Print Studio Pro for Photoshop, DPP

(CAPP1D) .....

699.99

Canon PIXMAiP7220

Wireless Color Photo Printer

» 9600 x 2400 Color dpi

» 15 ipm Black, 10 ipm Color

» Borderless Photos
upto8hx11”

» Wi-Fi & AirPrint

» Auto Double-Sided Printing

» CD & DVD Printing

» Full HD Movie Print

(CAIP7220).... 89.99

EPSON' SureColor P600
Inkjet Printer

» Max Resolution: 5760 x 1440 dpi

» Max Printable Area: 13 x 129"

» Borderless Prints up to 13 x 19"

» Fits Roll Media up to 13" Wide

» 9 UltraChrome HD Pigment-Based Inks
» Auto-Switching Black Ink Technology
» Tilting 3.5" Color Touchscreen » USB 2.0, Ethernet, & Wi-Fi
» Advanced Media Handling and Disc Printing

(EPSP0O).....

Call or Log-on

EPSON Artisan 1430
Wireless Color Inkjet Printer
» 5760 x 1440 Optimized dpi
» 2.81S0 ppm Black
and Color » Borderless
Prints up to 13 x 19"
» Print from Mobile Device
» Wi-Fi » PictBridge
» Print Directly on CD & DVD
» Individual Ink Cartridges

(EPAT430) ...

Call or Log-on

Toner for Laser Printers

Ink for InkJet Printers

Canon PIXMAPRO-1

Network Professional Inkjet Photo Printer

» 4800 x 2400 dpi
» Print8x 10" in
7 Minutes, 10 Seconds
» Chroma Optimizer
Enhances Black Density
» 12 Ink Cartridges Including 5 Monachrome
» No Black Ink Swapping Required » Ethernet, PictBridge
» Print Sizes up to 13 x 19" » CD, DVD, Blu-ray Printing

(CAPP1)

Canon PIXMAiP110
Mobile Inkjet Photo Printer

» Max Res: 9600 x 2400 dpi

» Max Print Size: 8.5x 23

» Print Speed: 9 ipm Black /

5.8 ipm Color

» Borderless 4 x 6" Photo 53 Sec.
» Borderless Printing up to 8.5” Wide
» 50-page Auto Document Feeder

» USB 2.0 & Wi-Fi » Wireless PictBridge & Mabile Printing

(CAIPT10) [ 199.75

Canon SELPHY CP1200

Wireless Compact Photo Printer

» Dye Sublimation » Resolution: 300 x 300 dpi
» Borderless 4 x 6" Photo in 47 Sec.

» Connect Wi-Fi & Access Point Mode
» Water-Resistant Archival Prints
» Mabile Device Printing

» 2.7" Tilting LCD Display

» Direct Print Capable

» SD Card Slot and USB Port

Black (CACPT200B) ... 99.90

EPSON' PictureMate PM-400

Personal Photo Lab

» 5760 x 1440 dpi

» Print 4.0 x 6.0 Photo in 36 Seconds
» Print from Memory Cards

» Borderless Prints oy ]
» 2.7" Color LCD Preview Display
» Capacity: 50 Sheets Plain Paper
» Support for SD Cards

» USB 2.0 and Wi-Fi Connectivity

(EPPM400) e 249.99

INK, TONER & CARTRIDGES

Ink for Large Format Printers

800-947-3308 - 212-444-6691

To view a full listing of all
Ink, Toner & Cartridges

or visit our website
BandH.com/w15100




EPSON' SureColor P800

17” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Print Size: 17 x 22"

» Print Speed: 8 x 10" in 113 Sec.

» Borderless Printing up to 17" Wide
» Epson MicroPiezo AMC Print Head
» 9 UltraChrome HD Pigment-Based Inks

» Auto-Switching Black Ink Technology » Advanced B & W Made

» Opt. Adapter for 17 W Roll Media » USB 2.0, Ethernet, & Wi-Fi

(EPSCPO0SE)

EPSON' SureColor 75270
36” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 36

» Speed: 22 x 34" Plot in 5 Seconds
» Handles Media up to 59 mil Thick
» Holds Roll Media with 2" or 3" Cores
» 5-Color UltraChrome Pigment Ink Set '
» Control Panel with Full Color LCD

» Stand with Horizontal Catch Basket » USB 2.0 and Ethernet

(EPSCT5270SR)

") Designjet T120
24” Color Inkjet ePrinter

» Resolution: 1200 x 1200 dpi l

» Print Speed: 40 A1
Prints/Hour

» Ethernet, Wi-Fi,
AirPrint, ePrint

» Print Sizes Up To 22x34” (D)

» Roll Printing Up To 24” Wide

» Compatible With Media Up To 280gsm

(HET12024)

_.Callor Log-on

Canon imagePROGRAF iPF5100
Large Format Printer

17 Wide Prnt Carrage (M

» Roll or Cut Sheet Paper

» LUCIA 12-Color
Pigment Inks

» Dual Print Head System

» Built-in Calibration » High-Capacity Ink Cartridges

» BorderFree Printing (roll paper only)

» Advanced Printer Drivers

(CAIPF5100)

Canon imagePROGRAF iPF8400

44” Large Format Printer

» Resolution: 2400x1200dpi
» Roll & Cut-Sheet Media

» Borderless Printing

» Uses 12 Ink Cartridges

» Print Up To 44.0"x89.0°

» Ethernet Connectivity

» Internal Memory: 384MB

» Hard Disk Capacity: 250GB
(CAIPFB400)

www.BandH.com

LARGE FORMAT PRINTERS

EPSON' SureColor P6000
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 24"

» Print Speed: 16 x 20" from 2:02
» PrecisionCore TFP Print Head —_—
» PrecisionDot Screening Technology
» 9 UltraChrome HD Ink Set

» Auto-Switching Black Ink Technology
» 2.7" Color LCD Screen; Built-In Cutter » USB 2.0 and Ethernet

(EPSCP600OSE]........ 2,495.00

EPSON' SureColor T3270
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi

» Max Printable Width: 24"

» Speed: 22 x 34" Plot in 28 Seconds
» Handles Media up to 59 mil Thick

» Holds Roll Media with 2" or 3" Cores
» b-Color UltraChrome Pigment Ink Set
» Control Panel with Full Color LCD

» Stand with Horizontal Catch Basket » USB 2.0 and Ethernet

(EPSCT3270SR)....... 2,795.00

P Designjet T520
24” Color Inkjet ePrinter

» Print Resolution: 1200dpi
» Print Speed: 275 Sq. Feet;/Hour
» Ethernet & Wi-Fi Connectivity
» Qutput 24.0” Wide Sheets & Rolls
» Roll Feed With Automatic Cutter
» Print On Heavy Media Up
To 280gsm
» Internal Memory: 16B
(HET52024) ...

1,750.00

Canon imagePROGRAF iPF6400
24” Wide Format Inkjet Printer

» Print Resolution: 2400x1200dpi
» Ethernet Connectivity
» Ink: 12-Cartridge Lucia Ex System
» On-The-Fly Ink Replacement
» Plug-Ins For Photoshop

and Microsoft Office
» Supports Heavy Media Up To

59 Mil Thick » Internal Memory: 384 MB

(CAIPF6400)..........

1,799.00

Canon imagePROGRAF iPF780

36” Large Format Printer

» Max Res: 2400 x 1200 dpi

» Max Print Size: 36" x 59’

» Speed: 24 x 36" Draw in 21 sec

» Five-Color Dye/Pigment
Reactive Ink Set

» Sub-Ink Tank System

» Economy Print Mode » Optimized Module for AutoCAD

» PosterArtist Lite Software » USB 2.0 and Ethernet Connectivity

(CAIPF780) oo Calll oF Log-0n

COMPUTERS

EPSON' SureColor P7000 Standard Edition
24” Large Format Inkjet Printer

» Max Resolution: 2880 x 1440 dpi
» Max Printable Width: 24

» Print Speed: 16 x 20" from 2:02
» PrecisionCore TFP Print Head

» PrecisionDot Screening Technology
» 11 UltraChrome HDX Inks with LL Black
» Auto-Switching Black Ink Technology

» 2.7" Color LCD Screen; Built-In Cutter » USB 2.0 and Ethernet

(EPSCP7000SE)

EPSON Stylus Pro 4900

Designer Edition Inkjet Printer

» Includes EFI eXpress RIP 4.5

» Accepts Media up to 17" Wide

» UltraChrome HDR Ink
Technology - 11 Inks

» Automatic Black Ink Cartridge
Switching » High Performance
Print Engine Speeds » Max Resolution - 2880 x 1440 dpi

» Three-Level Black Ink Tech » Accepts Roll and Cut Sheet Media

(EPSP4900DES)

7 Designjet 23200PS
44” Photo Printer

» Optical Resolution: 1200 dpi

» Print Up To 44x66” Sheets
& 44" Rolls

» Print On Heavy Media,
Including Canvas

» 12-Cartridge Ink System With 4 Blacks

» Embedded X-Rite Spectrophotometer » Ethernet Connectivity

» Large 256 MB Built-In Memory » Built-In 80GB Hard Drive

(HEZ3200PSQ) oo Call oF LOg-0R

Canon imagePROGRAF iPF6450
Graphic Arts Printer

» Print Resolution: 2400x1200dpi
» Roll & Sheet Media
Up To 24.0" Wide
» Ethernet Connectivity
» Replace Ink During Printing
» Internal Memory: 384MB
» Embedded 250GB Hard Drive
» Plug-In For Photoshap, Digital Photo Pro and Microsoft Office

(CAIPF6450)

_.Callor Log-on

Canon imagePROGRAF iPF670

24” Large Format Printer

» Max Res: 2400 x 1200 dpi

» Max Printable Width: 24

» Print Speed: 23.4x 33.1"
from 28 sec

» High-Density Print Head Technology

» Five-Color Dye/Pigment Reactive Ink Set

» Sub-Ink Tank System » Economy Print Mode

» MS Office Plug-In & AutoCAD Module » USB 2.0 and Ethernet

(CAIPF670)




COMPUTERS

Photo Paper Plus
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Surface Finishes
Glossy

Instantly recognizable by its reflective, smooth appearance, a glossy
finish is most commonly thought of as the go-to paper for printing
_ photographs. This is due to the paper’s ability
S, todisplay deep blacks with saturated,
2w vibrant colors that make images pop. The
coatings used on these kinds of papers
also provide a water resistant quality that
Py can make sure your prints will last for
a years after your make them. Along with
these benefits, glossy papers generally provide a
sharp, crisp image that will benefit phatographs and graphics with
fine details.

Basic Information & Specifications
Weight & Thickness

When looking for paper, basis weight and thickness are related
specifications that tie into a paper’s overall feel and quality. Weight
refers to the heft of a paper and demonstrates a paper’s feel and
strength over time. A heavier paper is less prone to buckling when
hung for long periods of time. Thickness plays a part in this; though
thickness can vary depending on the paper making process. Itis

important to know as not all printers can accept thick fine art paper.

Other Considerations
Opacity

Important for display purposes, opacity tells users how transparent
a sheet of paper or banner material is. This plays a role in deciding
what types of material are best suited to your specific application.

Introduction to Inkjet Paper

Matte

On the opposite end of the spectrum from glossy, matte papers offer
an appearance that more closely resembles that of traditional art
papers. Many matte papers feature a textured
appearance that can add anather layer of
artistry to your final print. The texture
can be subtle or extremely obvious, as
in the case of mould-made cotton-based
% papers, which allows users to choose
the ideal surface for presenting their

work. Additionally, the matte surface is less
susceptible to showing fingerprints and marks during handling,
making it a somewhat easier paper type to work with.

Materials and Coatings

The material the paper is made of, which could be: wood fiber,
canvas, cotton rag, vinyl, rice, bamboo, or others, plays a large part
in how the printed images will look, due to how it holds the ink and
the physical characteristics of each. In order for these paper types
to be completely compatible with modern inks, a special coating
must be applied to at least one side of the paper. These coatings
can have their own effect on the print as well, giving each combina-
tion a unigue look.

Roll / Sheets

Many papers are found in both sheets and rolls, with each offering

its own benefits. Rolls allow for long panoramas and work wonder-
fully with large format printers for high volume printing. Sheets, on
the other hand, offer convenience for smaller formats.

Luster

Known by names such as satin, semi-matte/gloss, silk, pearl, and
more; luster offers a surface in-between glossy and matte, usually
with a fine tooth and texture, and a slight
, reflective quality. This type of surface gives
the paper an excellent range from white
to black, outstanding color reproduction,
and, depending on the specific paper, the
tooth or texture to further accentuate your
art's content. Luster balances the benefits of
both glossy and matte papers, and as is a very
popular option for many professional printers.

Brightness, Whiteness, & Tone

These specifications indicate the overall appearance of a paper;
each characteristic will have a significant effect on print quality.
The brightest part of your image is limited by the brightness of the
paper itself, while the overall color and tone is determined by the
whiteness, which is usually listed as a warm (natural), neutral,

or cool color. Additionally, the specifications are generally stated
as percentages; which provides an easy way to compare different
varieties of paper in order to get an idea of how your work will look.

Single / Double-Sided

Due to the necessity of coatings on modern papers, most are not
coated on both sides in order to save an casts. If you require double-
sided printing for a book or other application, you will need to make
sure your selected paper is optimized for two-sided printing.

“ 800-947-3308 - 212-444-6691



B&H’s Excellent Selection
Brands

Epson, Canon, Itford, Hahnemuhle, and more can be found at B&H,
with each brand offering their own unique paper styles, materials,
and technologies. Check back often to find the latest manufacturers
and papers, thanks to our ever-expanding paper stock.

PAPER AND INKJET MEDIA

Selection

Canvas, metallic, cotton rag, vinyl, and more are among the papers

types you'll find at B&H. With practically any type of paper for nearly
any situation, and more and more varieties being added all the time,

we have a vast selection of papers to suit your needs.

COMPUTERS

Sizes

Find everything from your standard 4 x 6" photo paper to large 72"
wide rolls for epic panoramas. Available in sheets and rolls, you can
be assured that no matter how large or small your project is you will
be able to get the paper you need at B&H.

Canon EPsoN Kodak wrorp (/)

S

MUSEO MOAB

CRANEELCD.

HARMAN &

Uses
Fine Art

Designed for archival purposes and display,

so-called fine art paper offers classic
materials and coatings that will lend their
own quality to the print. This can include
prints of artwork, photos, or even impor-

tant documents that require the utmost

in quality and preservation. In addition, a

variety of different materials are available to dial
in the exact Lok required for this demanding application.

Office

Found in practically every workspace and
home, office printing paper is optimized
for documents, bath large and small. It
is generally lightweight, bright white,

and has a coating designed to handle

the speedy inkjet printers available today.
Much of this type of paper is available for
dual-sided printing and can handle everything from
black & white documents to full color images.

ICC Profiles

Even with the best paper in the world, digital printing still relies heavily on computing to turn your digital
images and graphics into physical prints. This is where ICC profiles come in handy. Many manufacturers
offer profiles to download alongside their different papers that will help tell the printer how to manipulate
the ink and colors, so that you will have a final print that Looks as close as possible to the screen that you
are viewing it on. These are optimized for specific printer and paper combinations to ensure you get the

best print possible.

@

BreaTHING COLOR’

ADVANCED INKJET MEDIA

Canvas

While not a paper, per se, canvas offers

a well-known aesthetic. It lends a
sense of gravitas to your prints and
the ability to display your artwork in a
more creative fashion. Also, recently
developed coatings, such as metallic,

are breathing new Life into this classic

art surface.

Specialty

Users with very specific purposes and
applications require uncommon styles
and types of printing materials to
accomplish their goals. Luckily, B&H
carries many unigue options such as
clear film, adhesive viny, rice paper, and
more that will assist you in getting your
job done. Experimental printers may also want to

venture into this section in order to realize their latest ideas and
projects, or to find inspiration.

& Hahnemihle

cAnson’

Inkjet Media

Photographic Prints

A staple of modern inkjet printing, photographs

are perhaps the most popular reason people

will print at home, and as such, photo-

| graphic paper is one of the widest paper

f/ selections there is. This includes the vast

array of standard glossy paper most people

are accustomed to, as well as heavyweight
textured papers suitable for gallery exhibitions.

Even people with an affinity for B&W darkroom printing will find

many options that emulate the look and feel of traditional prints.

Proofing

Making sample prints no longer has to cost
anarm and a leg with the availability of
many different proofing papers on the
market today. This lightweight paper
type offers surfaces that are similar to
higher-end papers, in order to provide

a comparably less expensive option for B
performing tests and making changes to see how a

final print will turn out.

N
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Carolina Cover \

To view a full listing of all
Inkjet Media and Paper

or visit our website BandH.com/w15103






